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Whether you have been using the latest OS since its release or if you are only just 
getting around to upgrading, the Advanced Guide to Windows 10 is full of useful 

advice, essential tips and all you need to take your computing knowledge to the next 
level. Our step-by-step guides and tutorials make getting the most from your 

computer easy; and there is something new to learn on every page.

From maintaining and optimising your key hardware, to delving under the hood of 
the operating system with tweaks and mods, there is something here for anyone 
who wants to go beyond being able to send an email and browse the Internet. So 
what are you waiting for? Dig out your best screwdriver, crack those knuckles and 

get ready to push your skills to the next level!

Whether you have been using the latest OS since its release or if you are only just
getting around to upgrading, the Advanced Guide to Windows 10 is full of useful

advice, essential tips and all you need to take your computing knowledge to the next
level. Our step-by-step guides and tutorials make getting the most from your

computer easy, and there is something new to learn on every page.

From maintaining and optimising your key hardware, to delving under the hood of 
the operating system with tweaks and mods, there is something here for anyone
who wants to go beyond being able to send an email and browse the Internet. So 
what are you waiting for? Dig out your best screwdriver, crack those knuckles and 

get ready to push your skills to the next level!
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customise things you may never have thought possible.
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Updating Windows 10
You may see a popup telling you that the Anniversary update is available to download and install but if you need to, you can check 
and install manually. 

One of the most welcome features of Windows 10 is the return to the familiar desktop environment and 
there are many ways to customise it to suit your needs and tastes. This can  include icon size, background 
image and colour scheme..

Complete Guide to 
Personalisation

Step 1 Step 3

Step 2 Step 4 To select your own pictures, click on the Browse 
button and navigate to the folder containing the 

images you want to use. For best results, you might need to crop 
some of your pictures to the same aspect ratio, widescreen etc., as 
your monitor screen.

The Background pop-up menu has three options: a 
stationary picture, a solid colour or a slideshow. The 

solid colour brings up a palette of colours to choose from. You can 
click on any of the blocks to see how it will look in the preview 
window at the top. 

The Personalisation screen has changed somewhat 
from Windows 8.1. Now the first page offers a menu of 

customisation options, starting with the background. You can use 
the default backgrounds, solid colours or choose to display folders 
of your own images.

You get started with personalising the Windows 10 
Desktop in exactly the same way as you did with 

Windows 7. Right-click anywhere on the Desktop screen and select 
Personalise from the pop-up menu, or select Personalisation from 
the Settings menu.
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Personalisation

Step 7 Step 10

Step 6 Step 9

Step 5 Step 8

If you can’t decide on your own personalised 
desktop theme, Windows provides a number of 

built-in choices. Click on Themes in the menu sidebar and then click 
on Theme settings to see the available options.

The lock screen can also show some information from 
installed apps. You can choose one app to provide 

detailed status, such as calendar appointments or Facebook 
notifications, and upto seven apps to provide brief status updates.

You can also choose a picture for the lock screen. 
There is a menu option for a slideshow on the lock 

screen too but unfortunately it doesn’t work too well and always 
seems to stay on the first image that you choose.

As well as the desktop background, you can also 
change the colour of the taskbar and the Start menu. 

Click on the Colours option in the menu sidebar and choose an 
accent colour. You can also let Windows automatically match the 
accent colour to the current desktop image. 

If you choose Slideshow, you will see some additional 
options to choose from. You can set the interval for 

the slide show from the Change picture every menu and decide 
how you’d like the images to fit on the screen by clicking the 
Choose a fit menu.

To set a picture as your Desktop background, simply 
click on it. It will instantly be set as your new Desktop 

background image. The screen shows you the last five images that 
you used or you can click the Browse button to choose a new one 
from your folders.
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Personalisation

The final Customisation menu option lets you customise the Start menu to a certain extent, allowing you to change things like 
whether recent apps are shown and if Windows 10 can show app suggestions. 

You don’t like the default Windows sounds? You want to replace them with all your favourite Star Trek sound effects? 
No problem!

Personalise the Start Menu

Personalise Windows Sounds

You are presented with a list of toggle switches that 
activate certain options. The Use Start full screen 

effectively returns you to the Windows 8.1 Start screen, so you’ll 
probably want to leave it off unless you have a specific need for a 
full screen menu. 

To change the sounds that Windows uses to notify you 
about events and problems, open the Personalisation 

control panel as explained previously and click on Themes in the 
sidebar menu, then click on Advanced sound settings.

Clicking on Choose which folder appear on Start lets 
you choose from a list of preinstalled shortcuts to your 

Library folders. Choose only those you really need to have there, 
otherwise the Start menu can quickly become hopelessly cluttered.

To change a sound, first select it from the list of 
sounds shown in the Sounds control panel, then click 

on the Browse button. Navigate to the folder containing the sounds 
that you want to use and then double-click the new sound. You can 
click on the Test button to hear what it sounds like.

Step 1

Step 1

Step 2

Step 2
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Personalisation

If you use desktop icons such as This PC, your personal folder or Network connections, you can change those icons. This is not 
something everybody would think about doing but is worth it if you want a specific style. 

Change Your Desktop Icons

Open the Personalisation screen of the Settings menu 
and select Themes from the sidebar menu. You now 

need to look for the Related Settings option. In the Related Settings 
section, click on the link to Desktop icon settings. 

If you wish to do so, it is possible to choose different 
icons for these system tools; you can even download 

custom icons online. To change the appearance of the desktop 
icons, click on the icon you want to change and then click the 
Change Icon button.

The window that now opens lets you choose which 
default icons will appear on your desktop. The Recycle 

Bin is pretty much essential but the others, including Computer, 
Users Files, Network and Control Panel icons, are optional.

The icon chooser window that appears will look very 
familiar to veteran Windows users, since it’s essentially 

unchanged from Windows 98. Scroll through the gallery until you 
find an icon you like or use the Browse button to navigate to any 
icon pack you’ve downloaded.

Step 1 Step 3

Step 2 Step 4
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Personalisation

Themes can be added from a variety of sources but the best place to find them initially is the official theme page from Microsoft. You 
can explore other sources as you gain confidence.

Adding New Themes

You can access the theme page in a couple of different 
ways. You can either open the web browser and 

navigate to support.microsoft.com/en-gb/themes or Google 
‘Windows 10 themes’. Alternatively, open Settings > Personalisation 
> Themes > Theme Settings > Get Themes Online.

Each theme is displayed with a thumbnail and the 
number of included images shown. The Microsoft 

theme page doesn’t allow you to view all of the included images 
before you download, you just have to base your choice on the title 
and thumbnail. Click Download on any that you like the look of. 

Both actions should bring you to the same themes 
page. Themes are listed in a variety of categories 

down the side of the page, including Featured themes, Animals, 
Natural wonders, Cars, Panoramic (for dual monitors) and With 
custom sounds. 

Different themes will contain different amounts of 
content. Some might only have a colour profile and a 

few desktop wallpapers, others might contain icons, colours, 
wallpapers or sounds. However, even the simplest of themes is still 
more than changing the desktop wallpaper. 

Step 1 Step 3

Step 2 Step 4
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Personalisation

Once themes are downloaded you can view and select them from a single folder in Windows. In this folder view, you can also 
customise the theme in a few different ways.

Applying and Modifying Themes

Once a theme is downloaded, you will need to open it 
to activate it. You can do this directly from the 

download interface that appears at the bottom of the browser 
window, showing download progress, or you can go to your 
Downloads folder, right-click on the file and click Open. 

The theme will then be applied and the first desktop 
wallpaper in the sequence will appear on your screen. 

Any colour profile changes will also be applied. If you want to 
manage the theme settings, head to Settings >  Personalisation > 
Themes > Theme Settings.

You will see your newly applied theme in the My 
Themes box. Until you apply a theme, it will not 

appear here, it will just be a theme file in Downloads. Once several 
themes are shown, you can quickly switch between them simply by 
clicking on the thumbnails. 

You can change the way the background image 
changes, slideshow, single picture etc. and how often 

the image changes, by clicking Desktop Background at the bottom 
of the window. You can change elements of the colour profile that 
was applied by clicking the Colour option. 

Changes you make to a theme package changes it 
into a custom theme. If you go back into the theme 

chooser window and click on the theme again, the standard 
(unedited) theme will be loaded again. If you want to apply the 
changes to the theme, you need to click Save Theme. 

Depending on the number of theme images, each of 
the files can be quite large (6-10MB). If you download 

themes and then decide you don’t like them, you can delete them 
quite easily by right-clicking on them and selecting Delete but don’t 
forget to delete the file in Downloads too.

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
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Personalisation

There are lots of customisation options built into the operating system but if you want to take your customisation of the desktop to 
the next level of functionality, you can begin to add desktop tools such as Rainmeter. 

Add Tools to the Desktop

Start by downloading the Rainmeter installer from 
Rainmeter.net. To install the software, run the 

installer program that you downloaded and follow the 
instructions. You will have the choice to choose from the 32 or 64 
bit versions during the process. 

To move a skin, just click and drag it to a new location. 
The easiest way to interact with Rainmeter skins is 

through the context menu (right-click on the skin). A skin may have 
any number of tabs, buttons, menus or other bells and whistles in 
its design. 

The first time you run Rainmeter, your desktop will 
look something like the image here. Each small 

window on the right side of your screen (System, Disk, etc.) is a skin. 
This is the illustro skin set. The app remembers each skin’s location 
and settings independently. 

You can use the context menu to load skins from your 
library. Right-click on any of the skins and select 

illustro > Google > Google.ini. The Google skin will appear in the top 
left corner of your desktop. You can now drag it into place alongside 
your other skins. 

Step 1 Step 3

Step 2 Step 4
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Personalisation

IMPROVING VISIBILITY
CUSTOMISING THE 
DESKTOP VIEW

Windows 10 incorporates a number of features designed to 
improve accessibility for people with impaired sight, including a 
range of high contrast Desktop themes. You can activate these 
from the Personalisation control panel. Activate the panel by 
right-clicking on the Desktop and selecting Personalisation and 
then click on one of the high contrast themes presented. You can 
exit the theme by clicking back on the previous theme.

You can make other changes to the Desktop appearance apart 
from the Personalisation options. You can also change the size of 
the Desktop icons and the way they are laid out on the screen. 
Right-click anywhere on the Desktop and in the pop-up menu that 
appears move your mouse over View. A fly out menu appears with 
further options, including icon size, the option to align icons to a 
grid and also auto arrange icons in alphabetical order.

You can also unload (remove) a skin with the context 
menu. Right-click the new Google skin and select 

Unload skin. You will see the skin fade away and disappear; useful 
for getting rid of the welcome skin. When a skin is unloaded, its 
location and settings are still saved.

Skins can have different variations. To see an example 
of a skin with variants, right-click the Disk skin and 

select Variants in the context menu. Variants share the same 
location and settings, and only one of a skin’s variants may be 
loaded at one time. 

Step 5 Step 6
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When you install Windows 10 you will possibly activate several features that you won’t use or need. Some of 
these are no real problem but some can mean a reduction in computing speed and a reduction in security, 
especially if you’re not really aware of what is going on in the background. 

10 Things to Disable in 
Windows 10

Windows 10 features an improved 
way to receive updates. More 

specifically, it allows you to get updates from sources other than 
Microsoft in a sort of file-sharing network. The catch is that your 
computer is also sharing files. Turn this off in Settings > Update & 
Security > Advanced options > Choose how updates are delivered. 

Notifications are generally, 
but not always, a good 

thing. Windows 10 does a good job of letting you know what is 
going on with your PC but sometimes you can get notification 
overload. You can turn some of the less useful ones off in Settings 
> System > Notifications & actions. Turn off things like: Show me 
tips about Windows.

File Sharing Updates

Unwanted Notifications

Part of Microsoft’s business model 
for Windows 10 seems to be selling 

its apps through the OS. Suggestions for apps you might like will 
appear in the Start menu and although you can just ignore them, 
you can also turn them off. Settings > Personalisation > Start > 
Occasionally show suggestions in Start. 

Every Microsoft account now has an 
advertiser ID tied to it, allowing 

Microsoft and third-party partners to deliver targeted adverts. You 
can turn this information sharing off by going to Settings > Privacy > 
General > Let my apps use my advertising ID for experiences across 
apps (turning this off will reset your ID). 

Start Menu Adverts

Targeted Adverts
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Disable Features

To better answer your queries, 
Cortana is constantly learning 

about you in a process called Getting to Know You. This includes 
typing history and speech patterns. If you find this invasion of 
privacy a little creepy, you can turn it off in Settings > Privacy > 
Speech, inking & typing, and clicking Stop getting to know me. 

In Windows 10 many apps will run in 
the background. These apps can 

receive information, send notifications, download and install 
updates and otherwise eat up your bandwidth and your battery life. 
You can, however, disable this feature in Settings > Privacy > 
Background apps. You can turn off each app individually. 

Windows 10, upon the default 
install, does a lot of syncing with 

your other Windows devices. If you use several different Microsoft 
devices and don’t want everything shared between them, you can 
disable syncing in Settings > Accounts > Sync your settings.  You can 
selectively turn off specific sync settings. 

Getting to Know You

Background Apps

Windows 10 Syncing

The lock screen in Windows 10 can be a 
useful feature but it can also just slow 

you down. You can disable the Lock Screen but only by delving into 
the Windows Registry. You can read more about disabling the lock 
screen in our Lock Screen Tips and Tricks guide. To access the 
registry, press the Windows key + R and enter ‘regedit’.

The visual effects in Windows 10 go 
a long way towards making the OS 

look modern and smooth. However, every pretty visual element has 
an effect on the running of your computer. Right-click the Start 
button and go in to System > Advanced system settings. Under the 
Advanced tab, go to Performance and click Settings.

Windows 10 will download and install 
updates automatically and you can’t 

really turn them off; but you can choose to stop the updates 
happening whilst you are using your computer. Head into Settings > 
Update & Security and click on Change Active Hours. You can then 
set a time frame in which updates won’t happen. 

The Lock Screen

The Visual Interface

Automatic Updates
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The lock screen is more than just a pretty holding screen to display until you log in. It can feature custom 
backgrounds with Spotlight Images, display app statuses and can even give you direct access to Cortana. 
Here’s how you can make the most of the Windows 10 lock screen.

Lock Screen 
Tips and Tricks

Display App Statuses
You can choose to display information on the lock screen from a number of different Microsoft and third-party apps. As the feature 
matures, more and more app developers will take advantage of it in their software.

Step 1 Step 3

Step 2 Step 4 You can check how the detailed and quick statuses are 
displayed on your lock screen by letting your PC sleep 

or by clicking the Windows key and choosing Sleep. Be aware, 
however that statuses may not show up straight away for things like 
Messages and Email. 

You can add as many apps as you wish here, up to the 
maximum of eight. To choose which apps have 

statuses displayed, click on one of the spaces and choose from the 
pop-up menu that appears. The menu for the detailed information 
space will be slightly shorter than for quick statuses.

You will see that there are two separate sections for 
adding apps here. The section with the single app icon 

is the one which will display more detailed information and the 
section with seven icons/spaces for adding apps which will show 
quick statuses. 

Open the settings app by tapping the Windows key or 
clicking the Windows icon on screen and then clicking 

the settings icon. Head into the Personalisation > Lock Screen 
section and you will see a set of boxes which may either be blank or 
displaying various app icons. 
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Lock Screen

The lock screen doesn’t have to be just that nice image you see for a few seconds before you log in to your Windows 10 account. Let’s 
take a look at a few more lock screen tricks.

There is no setting to disable the lock screen completely but it is still possible to do by delving into the Registry. The Registry can be 
a daunting place to visit but as long as you are careful, it is safe enough.

More Lock Screen Tricks

Disable the Lock Screen

There are three background 
display options for the lock 

screen: Spotlight, Picture and Slideshow. If you choose Spotlight, 
Microsoft will automatically choose an image to use as the 
background. You can vote on each image to improve or reduce the 
chance of similar images being displayed. 

If you have updated to the Anniversary 
version of Window 10, and you have a 

microphone attached, you can access Cortana from the lock screen. 
You need to enable the feature in the Cortana settings and then 
simply say “Hey Cortana” whilst on the lock screen. 

If you prefer to have your own 
selection of images displayed 

on the lock screen, you can select Slideshow instead of Picture or 
Windows Spotlight. Once you have selected Slideshow, a new set of 
options appears, allowing you to choose the folder where your 
images are stored. 

Vote on Spotlight Images

Access Cortana

Lock Screen Slideshow

DOWNLOADING 
SPOTLIGHT IMAGES
There is no way, within 
Windows itself, to download the 
images that Spotlight displays 
on the lock screen but if you 
want to save any of the images 
you have seen, you can with a 
simple, free app. Download 
SpotBright from the Microsoft 
Store and then scan for and 
download those amazing pics. 

To access the Registry, press the Windows key + R, enter 
“regedit” and then click OK. With the Registry open, 

navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\
Windows\. Right-click the final  Windows folder and click New > Key.

Name this new key Personalisation and then navigate 
inside it. Right-click inside the right-hand pane and 

select New > DWORD (32-bit) Value. Name it “NoLockScreen”. Then 
double click this new value and change the Value data to 1. Then 
click OK and exit the Registry Editor. 

Step 1 Step 2
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Modern browsers allow you to create web apps, give them their own place on your taskbar and even run 
offline and in the background. Chrome is one such browser, letting users create web apps that can replace 
desktop apps for everything from email to playing videos. 

Creating Web 
Apps with Chrome

Chrome Web Apps
Chrome isn’t the only browser that lets you create Web Apps for use in Windows 10 but it is the one that offers the best results in 
most cases. It is worth remembering that not all sites make for good apps. 

Step 1 Step 3

Step 2 Step 4 Previously, you could add the site directly to the 
taskbar but Chrome now makes you add it to the 

Desktop first. You can rename your Web App link here, although 
sticking to the original name is usually less confusing. Some 
websites won’t auto fill the name field, so be sure to check. 

Once you have the website that you wish to turn into 
an app open in your Chrome browser, click on the fly 

out menu in the top right hand corner of the browser; that’s the 
three horizontal lines icon. From the drop-down menu, choose 
More Tools > Add to Desktop.

Websites that work well as a Web App include but are 
not limited to: Gmail, Facebook, Google Hangouts, 

YouTube, Twitter and Google News. For this guide, we will use both 
Gmail and Facebook but feel free to experiment with your most 
used sites. 

Your first steps should be to install Chrome (if not 
already done) and make sure that it is fully updated. 

Check your copy of Windows 10 is also up to date. You then need to 
choose a website to turn into a Web App. You can choose any 
website but some work better as an app than others. 
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Web Apps

Step 6

Step 5

Step 7

Step 9

Step 8

Step 10 Finally, go to the location of the apps in Windows 
Explorer and right-click on the one you want to 

change. Choose Properties right at the very bottom, and choose the 
Shortcut tab. The Change Icon button is here, as well as the option 
to add a shortcut key to open the Web App instantly. 

If you lose track of your Web Apps, you can view them 
in the following location in Windows Explorer: C:\

Users\[Your User Name]\AppData\Roaming\Microsoft\Windows\
Startmenu\Programs\Chrome Apps; or right-click on a web app in 
your Start menu and ‘Open file location’. 

You can then easily right-click the app in the Recently 
Added menu and add it as a tile to the main Start 

menu panel. You might want to do this after creating each Web App, 
as Windows 10 only allows you to have one app in the Recent menu 
at one time. 

The app will also now appear in your main app list in 
the Start menu; but for it to do so, you need to enable 

Recently added in the Start menu. This can be done in your 
Windows settings > Personalisation > Start > Show recently added 
apps > On. 

The shortcut to the Web App will now be on your 
desktop. To add it to your taskbar, do so in the normal 

way. If your memory needs jogging, you do this by right-clicking and 
selecting ‘Pin to taskbar’ from the contextual menu. You can then 
delete the desktop icon. 

The most important part of this process is to check the 
box below the icon and title labelled as ‘Open as 

window’. If you don’t do this, you will simply create a browser 
shortcut to the site, rather than a proper Web App. With the 
checkbox filled, click Add to finish this step. 
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Windows 10 comes with its own default set of associations that open specific file types. A file association 
controls which apps or programs are set to open which types of files. If you’re not happy with the default 
associations and want to choose your own, it’s easy to do.

Changing File Associations 
and Protocols

Default Programs and Protocols
The ability to change the default apps and programs that Windows 10 uses goes a long way to helping you take full control of your 
PC and the system software. 

Step 1 Step 3

Step 2 Step 4 Next, click on the ‘Choose default apps by file type’ 
option to see a list of all the file types that can be 

associated with your currently installed apps. These are the types of 
files which will automatically open in that app when clicked. 
Anywhere a + is shown, is without a default app. 

Below the description, you will see two options: Set 
this program as default and Choose defaults for this 

program. The amount of default file associations is also shown. 
Click ‘Set this program as default’ first. 

A list of apps already associated with various functions 
will appear. Click on any of these to see alternative 

options. The options shown will vary depending on the apps you 
have installed at this time. If a function has no apps associated with 
it, you can click ‘Look for app in the Store’. 

Click on the search bar on the left of the taskbar and 
type “default programs”. You can also navigate to this 

settings tool by opening the All Apps list, scrolling down to W and 
clicking Windows System > Default Programs. Either way, open the 
tool on screen. 
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Files

Being able to check which Windows Services are running at any particular time is also a useful option, as it can help to diagnose 
performance or stability issues

Running Services

If you run into problems after changing protocols and 
defaults, you can easily reset to the Microsoft 

recommended defaults with a click of the button on the Default 
Programs screen. This may mean that you have to go back through 
your list and change some settings but it can be a useful fix. 

Step 6 Step 8

Step 1

You can also choose default apps based on protocols. 
This generally means that typing or accessing  a 

certain URL will trigger the app to open, rather than a webpage. For 
example, if MAILTO is detected by the browser, our default email 
client (Thunderbird) will launch to handle the request. 

Finally, you have the ability to set defaults by app, 
rather than choosing apps to go with certain files or 

actions. Click ‘Set defaults by app’ at the bottom of the screen. A new 
window will open, displaying a list of apps on the left. Click on any 
app you want to change the defaults for. 

The easiest way to get to the Services panel is by going 
through the Power User menu. Right-click on the Start 

menu button on the far left of the taskbar and select ‘Computer 
Management’ from the menu that pops up; this is the Power User or 
Win-X menu. 

Step 5 You now have two options: Setting the app as default 
for any and all files or protocols it can open, or 

choosing individual defaults the app will use. Clicking the first 
results in an instant change, clicking the second will show you a list 
of current defaults for that app, allowing you to choose. 

Click the ‘Services and Applications’ option in the 
left-hand panel of the window that opens. Then click 

‘Services’ to show the full list. The list will be large but not all 
services will be running at any one time. Click on any to see more 
details, including management option, for that service. 

Step 7

Step 2
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Windows 10 has a lot of built-in advertising. This is part of the business model and is to be expected in some 
respects. That doesn’t stop them being really annoying at times. Thankfully, if you know what you are doing, 
you can disable most of the advertising that Windows tries to slip in front of you. 

Disable Adverts 
and Annoyances

Disabling Annoyances 
Windows 10 is pretty good at putting adverts in front of you and certainly, some of the adverts may not even seem like adverts until 
you start to take notice of them. 

Lock Screen Ads Get Rid of Fun Facts

Suggested Apps Calm Cortana Down Following on from the previous tip, 
you can also stop Cortana from 

doing that annoying thing when it bounces around in the taskbar to 
get your attention. If you don’t want Cortana nagging you, click the 
Cortana search bar, click Settings, scroll down and disable the 
‘taskbar Tidbits’ option. 

Although Cortana will occasionally 
provide you with an interesting fact 

when you click the search bar; often they are interspersed with 
adverts too. You can disable ‘Get fun facts, tips, and more from 
Windows and Cortana on your lock screen’ in Settings > 
Personalisation > Lock Screen. 

Windows 10 will occasionally show 
suggested apps in your Start menu. 

Sometimes these are free apps but often they are paid apps and 
games. Essentially, these are adverts. Head to Settings > 
Personalisation > Start and set the ‘Occasionally show suggestions 
in Start’ setting to Off. 

Shortly after you enable Windows 
Spotlight for the lock screen, you will soon 

start to see the occasional advert for games like Tomb Raider appear 
among the pretty images. To disable the adverts, simply switch to 
the Picture or Slideshow options in the Personalisation settings.
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Disable Adverts

Rather than turning live tiles 
off, you can simply unpin 

the tile from the Start menu. Right-click a tile and select ‘Unpin from 
Start’ to get rid of the tile entirely. If you prefer a less cluttered Start 
menu, you can even choose to unpin all the tiles and only use the 
All Apps list to launch apps. 

Get Office Notifications Unpinning Windows Apps

Okay, so this might be classed as borderline 
as far as it being advertising but if you are 

fed up of being advised to ‘Use Edge to save battery life’, head to 
Settings > System > Notifications & Actions and disable the ‘Get tips, 
tricks and suggestions as you use Windows’ option.

Windows 10 includes a ‘Get 
Office’ app that sits there, 

suggesting you download the software for a free trial period. Head to 
Settings > System > Notifications & Actions, scroll down and turn it 
off. You could also find the Get Office app in your Start menu, 
right-click it, and select ‘Uninstall’.

Microsoft Tips While you can remove the apps that are 
installed as part of the Microsoft 

Consumer Experience program, Windows 10 also includes a few 
apps you can’t uninstall but will use the Live Tiles to advertise. To 
disable live tiles that annoy you, right-click a tile and select More > 
Turn live tile off. 

Disable Live Tiles

AD BLOCKING SOFTWARE

The tips above will allow you to block many of the adverts Microsoft 
has added to the Windows 10 interface but what about the adverts 
you see on your favourite websites. Unfortunately, there isn’t a 
Windows 10 setting to turn these off, but there is bit of software that 
can help. 

AdBlock, The No.1 ad blocker with over 200 million downloads, 
blocks YouTube, Facebook ads and others in most places on the 
web. AdBlock works automatically but lets you choose to continue 
seeing unobtrusive ads, white-list your favourite sites or block all 
ads by default. 
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Step 1

Step 2

Step 3

Step 4 Once you uncheck this box, previously greyed out new 
options become available, so check the new boxes. 

These include advanced text selection features and the ability to 
customise fonts and colours.

In the Options tab of the Properties window, at the 
bottom of the window you’ll see a check box labelled 

“Use legacy console (requires relaunch)”. Uncheck this box by 
clicking on it.

The console interface window will open. By default it’s 
a black screen with grey text. Right-click on the title 

bar of the window and select Properties.

To get started, first you’ll need to open the Command 
Console. Right-click on the Start button and select 

“Run”, then type “cmd” and click OK.

By default the Command Console interface is unchanged from earlier versions, so to use the new features, first you’ll have to activate 
them; this only takes a few minutes.

Enabling the New Console Features

The Command Console is an advanced interface that lets you access the operating system 
directly via command line instructions. It predates Windows and has remained virtually 
unchanged for decades; with Windows 10 it finally gets some useful new features.

Customise the Command 
Console Screen
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Command Console

Step 1 Step 3

Step 2 Step 4

The Command Console customisation options are 
easily accessible and equally easy to use. Open the 

Command Console options by right-clicking on the console window 
title bar, select Properties and click on the Font tab.

If you’re tired of the ugly system font, you’ll be happy 
to learn that there are two True Type fonts available, 

Consolas and Lucidia Console. To select one of these, click on it in 
the Font list. You can select bold type by clicking the check box 
below the list panel.

The Command Console font hasn’t changed in years, 
until now. To simply change the font size of the 

standard raster font from the default 8x12, select a different size 
from the list at the top of the window. You’ll see a preview of its 
appearance in the panel below.

Whatever changes you make to the appearance of the 
font and background colours, you’ll see a preview of 

the size and colour of the selected font described in text next to the 
preview panel at the bottom of the window.

You can now edit, copy and paste text in the Command Prompt window, using text editing features and keyboard shortcuts  just like those of a word 
processor. Use the mouse or cursor control arrow keys to move the cursor, and the Shift and Ctrl keys along with the cursor control arrows and other 
keys to make and expand your text selection. If you use the console regularly you’ll find that these new features will be a boon.

If you want to, you can change the font size and style in the console window, including using a couple of True Type fonts.

Font Options

Shift + Left Arrow: Move the cursor to the left one character, extending 
the selection.
Shift + Right Arrow: Move the cursor to the right one character, extending 
the selection.
Shift + Up Arrow: Selects text line by line up from the insertion point.
Shift + Down Arrow: Selects text line by line down from the insertion point.
Shift + End: Extends the selection from the cursor position to the last 
character in the input line. Use it a second time to extend the selection to 
the right margin.
Shift + Home: Extends the selection to the character immediately after 
the command prompt. Use it a second time to extend the selection to the 

right margin.
Shift + Page Down: Extends the selection down one screen.
Shift + Page Up: Extends the selection up one screen.
Ctrl + Shift + Right Arrow: Extends the selection one word to the right.
Ctrl + Shift + Home: Extends the selection one word to the left.
Ctrl + Shift + End: Extends the selection to the beginning of the 
screen buffer.
Ctrl + A: Selects all text after the prompt.
Ctrl + C: Copies selected text to the clipboard.
Ctrl + V: Pastes the contents of the clipboard at the current cursor position.

By default the Windows 10 Console uses the same 8x12-pixel raster font that it’s always used, with white text on a black background. While this is fine for 
everyday use, the font can be hard to read on large monitors or projectors. For these situations it can be helpful to change to a larger, sharper font.

Enabling the new Edit Options and Text Selection lets you select and edit text in the console window, just as you do in a word 
processor. This makes using the Command Console much easier. 

Edit Options and Text Selection Features
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Command Console

To alter the screen buffer size, type your new sizes into 
the width and height boxes, or use the scroll arrows to 

increase the size one character at a time. The default size is 80 
characters wide and 300 lines high.

As before, open the Command Console, right-click on 
the title bar of the window and select Properties. Click 

on the Layout tab.

By default the system opens the Command Console 
window near the upper left corner of the screen, 52 

pixels down and right. You can drag it to another position of course, 
but you can also change the default by entering a new position.

To alter the default window size of 80 characters by 25 
lines, again either type in your new sizes or use the up 

and down arrows. You can also extend the window size vertically 
using the mouse.

Step 2

Step 1

Step 4

Step 3

The size and layout of the Command Console window is a hangover from the days of monochrome text only monitors. 
In Windows 10 you can change that.

Layout Options

While the appearance of the Windows desktop environment has seen 
many changes and improvements over the years as graphics and    
display technologies have improved, the Command Console has 
remained unchanged, like a fossil embedded in the core of the Windows 
operating system.

The Command Console is the last remnant of the pre-Windows Microsoft 
operating system MS-DOS, which was used on IBM compatible home and 
office computers from the early 1980s until the mid 1990s. MS-DOS used 
typed lines of commands to access drives, list directories, run software 
and perform other operations. It was very complicated, relying on the user 
knowing and remembering a long list of commands to do anything at all. 
It wasn’t until Windows replaced it with the now familiar graphical mouse 

based interface that home computers became accessible to those 
without advanced degrees in computer science.

The Command Console’s tiny default size reflects the size of monitor 
screens from the late 1980s, when its 80 x 25 character format would have 
filled most of the screen and its ugly raster font is a hangover from the 
days of green monochrome CRT monitors. While some people may like 
the retro 1980s look of the Command Console, its limited size and tiny text 
buffer can make extended use during debugging or advanced driver 
installation very awkward. Now you can increase not only the on-screen 
size of the window, you can also increase the size of the text buffer, so you 
can more clearly see what you’ve done in previous lines.
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Command Console

Here you can change the colour of the screen 
background and screen text, as well as the less 

frequently seen popup colours. There is a wide range of colours to 
choose from, so pick something you’ll like.

As in previous operations, open the Command 
Console, right-click on the window title bar and select 

Properties. This time click on the Colours tab.

You can also change the transparency of the 
console window using the slider at the bottom of 

the page. Don’t worry, it won’t vanish completely, the minimum 
opacity is 30 percent!

The popup colours are seen when you press F7 in the 
console to display your command line history. By 

default it displays in magenta on white to differentiate it from the 
standard console window.

Step 2

Step 1

Step 4

Step 3

If you’re bored with the standard, and very traditional, grey on black look of the Windows 10 Command Console, you can now 
change the appearance of this tool to almost anything you like.

Changing the Screen and Text Colours

Like many other user interfaces in Windows 10, the command console 
can now also be tweaked and made more personal.

If you’ve used the Command Console at all, you’ve probably noticed, 
assuming that you’re old enough to remember, that it looks a lot like the 
interface of an office computer from the late 1980s. Its plain monochrome 
grey text on black appearance and chunky typeface looks completely out 
of place surrounded by the glittering graphical interface of a modern 
Windows PC.

The default colour scheme of the Command Console is grey text on a 
black background, which harks back to the console’s origins in the 

pre-Windows days of MS-DOS, when all you had to control your computer 
were typed instructions input in a command line interface. That the 
Command Console has survived at all is a testament to how useful it is to 
be able to still control your computer this way but there’s really no reason 
why it should still look like a relic from the 1980s.

Thankfully one of the many new features added to Windows 10 is the 
ability to fully customise the appearance of the Command Console 
including, finally changing the colours of the on-screen text and the 
background. While it’s not quite as versatile as the customisation features 
of the rest of the desktop environment, it is possible to make the console 
at least look like it belongs in the 21st century.
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Set Up Windows Tweaker
The Ultimate Windows Tweaker software is not available as an app, so you will need to download the 
file from http://www.thewindowsclub.com/ultimate-windows-tweaker-4-windows-10.

Once you have downloaded the zip file, extract its 
contents and move the program folder to your desired 

location. Pin its executable file to your Start menu for easy access. 
Do not separate out the contents of the download as it is important 
that the contents stay in the same folder.

As when making any large system changes to your 
computer, you should create a system restore point 

first. You can use the Create Restore Point button that UWT offers. 
The software prompts you to create one, before using the tweaks, 
so that you can revert back should you feel the need to.

These tweaks are not really meant for beginners. It is 
recommended that you do not over tweak your 

system in one go. We suggest you apply tweaks for only 1 category 
every day, see how your system performs, before moving on to 
apply more tweaks if you don’t see problems. 

To apply a particular tweak, check or uncheck the 
boxes or use the sliders provided. Once you have 

selected one or more tweaks, click on the Apply button. Some 
tweaks may apply instantaneously. If a system restart is required, 
you will be reminded to restart your computer when you exit.

Step 1

Step 2

Step 3

Step 4

There are plenty of ways to customise Windows 10 built right in to the operating system. However, if you 
really want to tweak and modify the system, you will need to resort to external software. Ultimate 
Windows Tweaker 4.1 allows you to modify the appearance, security and performance of Windows 10.

Tweak and Modify 
Windows 10
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Tweak/Modify

Each of the menus in UWT4 contains lots of different settings and options, from simple appearance tweaks to more complicated 
performance mods. 

Tweak and Mod Menus

Customisation Menu

User Accounts Menu

Under this category you will be 
able to tweaks settings of your 

taskbar, Thumbnails, File Explorer and the Modern UI. You can opt 
to use Light or dark theme for OS or apps, disable Start animations, 
use default or change Battery Date & Time flyouts or change the 
Volume Control. 

Under the User Accounts tab, you 
will be able to change your User 

Account settings, Logon information and sign in options. You can 
also change the User Account Control settings here. 

Under this category, you will 
see some additional system 

and Network tweaks. You can also set UWT to behave the way you 
want it too. By default, when you apply a tweak and click Apply, 
UWT4 will automatically restart explorer.exe to apply the tweak. 
Change its behaviour if you wish. 

Add Windows Store apps, features and 
useful functions to the right-click context 

menu and Scan with Windows Defender, Clear Clipboard, all built-in 
default Windows Store apps and more to the context menu. 

Additional Tweaks Menu

Context Menu

If you want to restrict access 
to some Control Panel applets 

like Windows Updates you can do so easily. You can disable 
Telemetry, Biometrics, Advertising ID, Cortana, Windows Update 
sharing, Feedback requests, password Reveal button, Steps 
Recorder, disable Wi-Fi Sense and Application Telemetry. 

Security & Privacy Menu

The Performance tab offers tweaks 
to optimize Windows 10 to best suit 

your requirements. While most of these settings are best left at their 
default values, this panel gives you quick access to change them, 
should you wish to. Tweak these settings VERY carefully at first.

Performance Menu
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Step 1

Step 2

Step 3

Step 4 If you choose daily, weekly, etc. you will need to set 
further time options when you click Next. If you select 

the final trigger option, when a specific event is logged, you will see 
a set of drop down menus. Here you can choose the event log 
source and give the event an ID. 

The Basic Task wizard will now open. Give your task a 
name and description (optional) and click Next. You 

now need to choose the trigger. This can be set to happen daily, 
weekly or monthly, to happen just once. You can choose starting or 
logging on to your PC as a trigger also. 

You have three main options for adding new tasks to 
the schedule: Create Basic Task, Create Task and 

Import Task. For now we will stick to creating a Basic Task. You can 
start the process by clicking in the Action panel or using the Action 
menu in the menu bar of the window. 

Search for “Task Scheduler” in the Cortana search 
pane or navigate to it in Start menu > All Apps > 

Windows Administrative Tools > Task Scheduler. The simple 
scheduler window will now open. This is split into three sections: 
Scheduler Library, Scheduler Summary and Actions. 

Let’s take a quick look at exactly how to use the Windows 10 Task Scheduler in normal day-to-day PC operation. And then how to use 
it to schedule tasks you want or need on a regular basis. 

Scheduling New Tasks

The Task Scheduler in Windows 10 is, in many ways, very similar to that found in older versions of the OS. 
However, in Windows 10, Battery Saver Mode can impact on how it operates (if using a laptop). This guide looks 
at how the new scheduler works and how we can modify and use it to control almost any app automatically. 

Using the
Task Scheduler
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Task Scheduler

Step 6

Step 5

Step 7

Step 9

Step 8

Step 10 You can now review the completed task creation by 
clicking Finish once. If you are happy with all of the 

settings, etc. click Finish again. If you want to change anything, use 
the Back button to navigate to the relevant section. You can also 
choose to open the Properties after finishing. 

Get creative. Task Scheduler doesn’t just need to be 
used to run CCleaner or Defrag. If you use a specific 

program on a regular basis, you can use the Task Scheduler wizard 
to create a task that opens the program for you automatically 
according to the schedule you choose. 

You can also add optional arguments, which some 
programs support. For example you can specify the /

AUTO argument with CCleaner to automatically run CCleaner on a 
schedule. The exact arguments supported will differ between 
programs and if you’re not sure, it is best to check. 

For this guide, we will look at starting a program. You 
can now type the name of the program or script in the 

Program/Script field. If you prefer you can click Browse and search 
through available programs to find the one you want to start. You 
are looking for .exe (executable) files here.

The main action is Start a Program or app but you can 
also choose to send an email or display a message. If 

you choose to send an email, you will then need to complete things 
like recipient address and the message itself. If you choose to 
display a message, you will need to write it. 

For now let’s stick to a timed trigger. Choose Weekly 
and click Next. Use the various boxes to choose when 

the task starts and how it should recur from then on. Click Next to 
continue. You now need to choose the Action being triggered by 
your choices in the previous steps. 
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Task Scheduler

If you are looking to modify or disable any scheduled 
task, open the Task Scheduler. You can just type “Task 

Scheduler” into Windows Search and it should show up in the 
results. If you are creating or modifying a lot of tasks, it might be 
worth pinning the Task Manager to the Start menu.

Looking at the left-hand panel in the Task Scheduler 
will allow you to see all of the existing scheduled tasks 

(Task Scheduler Library). Click on the folder and the tasks will be 
displayed in the middle panel. You can dig down further into the 
folder structure using the arrow toggles. 

Step 1 Step 2

TASK SCHEDULER IN WINDOWS 10

Although the method of creating and managing tasks manually is 
the same in Windows 10 as it was in 7 and XP, if you are using a 
portable device, the way the OS prioritises tasks has changed. This 
change is due to the new Battery Saver mode, which is able to 
postpone certain tasks if they meet certain criteria. 

If Windows 10 detects that the user isn’t using their computer, it 
considers the system idle. This means that some scheduled 
processes won’t execute. For example, disk optimisation runs at set 
intervals when the computer idles. However, when operating on 
battery power, running disk optimisation on a spin-up Hard Disk 
Drive (HDD) could negatively affect your system’s uptime. 

You may want to modify existing Windows 10 tasks or even delete them altogether. This should always be done with care and 
research beforehand.

Modifying or Deleting Tasks
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Task Scheduler

Although there is no simple switch to turn off individual tasks or to turn off the Task Scheduler as a whole, you can disable it in 
another way. 

Turn Off Task Scheduler

You should see the Task Scheduler in this list. 
Right-click on the entry and choose Disable from the 

contextual menu. To re-enable it, simply right-click and choose 
Enable from the contextual menu. Remember to turn this service 
back on after leaving Battery Saver Mode. 

Step 1 Step 3

Step 2

For example, click on the left facing arrow for 
Microsoft. Then click on the left facing arrow for 

Windows. From the list of entries that appear, find the Defrag option 
and click on it. In the centre panel, double-click on ScheduleDefrag. 
This will open a new properties pane. 

To turn off or disable the Task Scheduler temporarily 
whilst in Battery Saver Mode, as turning it off all the 

time could adversely affect performance, you need to open the Task 
Manager. You can search for this using the Cortana search field or by 
looking in Start menu > All Apps. 

You can also open the Task Manager by pressing the 
key combination CTRL + SHIFT + ESC. Next locate the 

entry for Service Host: Local System (followed by a number) on the 
processes tab and click on the left facing arrow to show the full list 
of processes inside.

Step 3 The properties pane shows the triggers and conditions 
that control the Defrag utility’s behaviour. If you want 

the process to run regardless of Battery Saver, you’ll need to make 
sure that none of the triggers are idle state, or are part of auto 
maintenance. They must run though when logged out. 

The Task Scheduler offers much more than optimized 
battery performance. It can automate boring 

processes, including suspend and sleep. For anyone looking to 
shave a few precious minutes off their work routine, the Task 
Scheduler is a must have tool. 

Step 4

Step 4
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Step 1

Step 2

Step 3

Step 4 Each time you want to add a new card, click the + 
button at the bottom of the previous card. You can 

also group two or more cards together into one. Click and drag a 
card on top of another and a new menu will appear that lets you 
choose how the combined cards are displayed. 

To add basic content to your Sway, such as text and 
images, click or tap the + icon in the bottom left corner 

of any existing card and then choose the type of content you want 
to add. To see all options, click Cards on the top menu bar. You can 
also drag and drop content right onto your Storyline. 

So let’s get started building a story/presentation. Click 
the ‘Title your Sway’ placeholder text shown in the first 

card on the Storyline and then type a short description of what your 
Sway is about. When you share your finished Sway later, this title 
will be the first thing that others will see. 

The Storyline is where you type, insert, edit and format 
the content that tells your story. Content is arranged in 

sequential order by adding cards, each of which holds the type of 
content you want, including text, images, videos and even Office 
documents. Cards can be reordered at any time. 

You can create a Sway presentation or storyline from the new Windows 10 app or you can visit www.sway.com and use the same 
tools in a browser. 

Sway Presentations

Sway is a new app from Microsoft Office that makes it easy to create and share interactive reports, personal 
stories and presentations. Its built-in design engine takes care of making your creation look its best. If the initial 
design doesn’t quite match your taste or mood, you can easily apply another. 

Create Presentations 
with Sway
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Sway

Step 6

Step 5

Step 7

Step 9

Step 8

Step 10 Ready to share your Sway with the world or perhaps 
just with selected people? Click the ‘Share’ button 

on the top menu bar and then select how you want to share your 
Sway. Your choices on this menu depend on the type of account 
that you used to sign in to Sway. 

If you want to control how others will view and navigate 
your Sway once you’ve shared it, click the ‘Layout’ 

button on the top menu bar and then select whether your content 
should scroll vertically, horizontally or appear like a presentation. 

You can also adjust a specific part of the currently 
applied theme, such as colour, font choices and the 

emphasis of animation by clicking the ‘Customise’ button in the 
Design pane. This gives you complete control over how the finished 
presentation looks, without making things too tricky. 

To choose a design for your Sway, click ‘Design’ on the 
top menu bar and then select the theme you want. To 

choose a random look and mood for your Sway at any time, click 
the ‘Remix!’ button on the top menu bar until you find a design that 
suits your taste. 

Sometimes it is difficult to know how a Sway will look 
during its creation, so the app includes a handy 

preview panel. Click the left-facing arrow in the top right corner of 
the Sway workspace. Click once for a mini preview and twice for a 
full preview. Click the right-facing arrow to close it.

You can easily search for and add additional content 
to your Sway, such as an image that is stored on your 

computer. You can also search the Web for relevant content. On the 
top menu bar, click Insert, select your preferred content source and 
then enter any search keyword into the Search box. 
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Update Your 
Motherboard BIOS

Keeping your BIOS up to 
date can really help to 

keep your PC in  
top shape.
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Remove Windows 
10 Bloatware

Windows 10 is more 
packed with bloatware 
than other OS’s. Learn 

how to remove it.
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From installing or upgrading key hardware components, to making the 
most of the hardware you already have, these guides will help you to 
make sure that your computer is ready and capable of taking 
advantage of the great new Windows 10 features. If you want to give 
your computer more power or upgrade to the latest graphics card, 
read on for everything you need to know. 

Upgrade Your 
Graphics Card

If you want to play the 
latest games, you may 
need to get rid of that 

old GFX card. 72

Hardware and 
Software 
Optimisation
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Updating Windows 10

Windows 10 Anniversary Features

You may see a popup telling you that the Anniversary update is available to download and install but if you need to, you can check 
and install manually. 

Let’s take a look at what the update will add to Windows 10 and your computer when it is all downloaded and installed correctly. 

Open the main Windows 10 settings, either by searching 
in Cortana or by clicking the Start menu > Settings. 

Click on the Updates and Security option. You will 
now need to tell the PC to check for updates by 

clicking the button. 

Step 1 Step 2

ADDITIONAL SECURITY 

IMPROVED WINDOWS DEFENDER

Security has never been more critical with more than 250 million 
threats online in any given day and the Anniversary update adds 
even more protection. 

Improvements to Windows Defender, the free Microsoft anti-malware 
service, includes the option to automatically schedule periodic quick 
scans of your PC; also it will provide new notifications and easy-to-
understand summaries when scans are complete and threats are found.

New Windows Hello 
features make it easy for 

you to use the same easy, yet strong, security of Windows Hello with 
Windows apps and Microsoft Edge. The Anniversary Update also 
enables companion devices to use Windows Hello to unlock your 
PC, giving you more choices for quick, secured sign-ins.

Windows Hello for Websites

The first major update to Windows 10 is here, bringing with it lots of user requested features, security 
updates and usability tweaks. With more than 350 million devices already running Windows 10, these 
new features are only going to improve the experience. So what can you expect from this update?

Get the Windows 10 
Anniversary Update
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Anniversary

Building on strong power 
efficiency already available in 

Microsoft Edge, the Anniversary Update includes even more power 
saving improvements: using fewer CPU cycles, consuming less 
memory and minimising the impact of background activity and 

peripheral content. Microsoft 
Edge lasts three hours longer 
than Google Chrome; long 
enough to finish the final movie 
in your favourite trilogy.

Microsoft Edge Extensions, such 
as Pinterest’s “Pin It Button,” 

Amazon Assistant, AdBlock, Adblock Plus and LastPass will be 
available in the Windows Store with the Anniversary Update to add 
features to your browser and personalise your experience.

A new accessibility architecture for Microsoft Edge supports modern 
web standards, including HTML5, CSS3, and ARIA. With the Anniversary 
Update, page structure and content are now exposed more clearly with 
assistive technology. Visual presentation of web pages in high contrast 
mode is greatly improved to provide additional visual context, while 
preserving text contrast. Form entry when using keyboard navigation 
and screen readers improve in this update too, making the browsing 
experience for people of all abilities better.

Windows Ink, available for the first time in the 
Anniversary Update, brings the writing you do 

every day into your digital world. 
Now, using a Windows 10 
device, graphic designers can be 
more creative, musicians can 
write digital music, lawyers can 
edit documents with the power 
of the pen and students can do 
mathematical equations and 
learn by writing. All with 
Windows Ink.

Quickly and easily take a note, 
sketch on a screenshot or draw 
an idea. Smart Sticky Notes help 
you remember common tasks 
like reminding you of flight times 
or offering directions using 
Maps. Key apps have new 
ink-specific features, like using 
handwriting in Office, ink 
annotations in Microsoft Edge or 
drawing custom routes in Maps.

With the Xbox Play Anywhere 
program, you can buy a game once 

and play on your Windows 10 PC and Xbox One with shared 
progress, shared game saves and shared achievements. Every new 
title published from Microsoft Studios that was shown onstage at E3 
this year will support Xbox Play Anywhere and will be easily 
accessible in the Windows Store.

Xbox Play Anywhere games will be offered within the new unified 
Windows Store on both Windows 10 and Xbox One. You’ll be able to 
find the content you want faster and purchase game and app 
bundles, pre-orders, pre-downloads and subscriptions such as Xbox 
Live Gold.

With Xbox One gamers will be able to use Cortana commands to 
find great new games, see what their friends are up to, start a party, 
accomplish common tasks and turn on the Xbox One by saying, 
“Hey Cortana, Xbox On”.

Cortana is now available above your 
lock screen so you can do things like 

ask questions, play music from your PC or set a reminder without 
unlocking your device.

Cortana can save and recall key information, like your frequent flier 
number or where you parked at the airport. You can also add 
photos to make your reminders visual, like a photo of a bottle of 
wine you enjoyed at a restaurant.

Cortana can give you notifications across all the devices you have 
with Cortana; like sharing directions across devices or from text or 
messaging services on your phone.

Microsoft Edge Updates

Windows Ink

Connected Gaming
Cortana Updates

CHASEABLE LIVE TILES

TASKBAR NOTIFICATIONS

Live Tiles now include a new feature, which Microsoft describes as 
“Chaseable Live Tiles”, that allows you to click a story, picture or 
content in the preview and open the app on that content, instead of 
just opening the app. The new addition isn’t a significant change but 
it will help to deliver a more consistent user experience.

There have been some changes to the taskbar in the Anniversary 
Update. Microsoft has added notification badges to the taskbar, 
which will be available on the Universal Windows Platform (UWP) 
apps. This will make it easier for users to see at a glance the 
notifications available for a particular app through a badge with a 
counter. However, it will be up to developers to add the functionality 
into their apps.
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The BIOS (Basic Input/Output System) is an often overlooked but 
absolutely vital part of your computer system. You see it every 
time you switch your computer on – it’s responsible for those 
lines of text that flash up on the screen before Windows 
launches, listing things like installed RAM and other hardware 
details. It’s the core software of your system; it boots up the 
computer, launches Windows and in some cases allows Windows 
and other apps to access things like hard drives, the keyboard, 
USB connections and other hardware components. The BIOS is 
built in to your system and is stored on a type of flash memory 
chip on your computer’s motherboard. For this reason it is often 
referred to as “firmware”, since it is both software and hardware. 
The BIOS is particular to each type of motherboard and is 
provided by the motherboard manufacturer.

To get the best performance and system stability under Windows 
10, it’s important to make sure that your computer is running the 
latest version of its BIOS, so in this tutorial we’ll show you how 
to: check the current version, download an update and then 
install it.

It’s important to note that the BIOS is a vital part of your 
computer and messing up the update process can cause 
irreparable damage to your system, possibly rendering it 
useless. For this reason we recommend that you only undertake 

this process if you are confident that you know what you’re 
doing. If you have any doubt ask a computer savvy friend to help 
you or take your PC to your local computer store, who will be 
happy to perform the update for you, usually for a small fee. It’s 
also a good idea to perform a full backup of any important data 
on your system to an external storage device before you begin, 
just in case!

DISCLAIMER
Updating the BIOS carries the risk of damaging your PC and you may 
also void the warranty on your equipment. If you are not completely 
confident that you can carry out this operation safely DO NOT 
ATTEMPT IT. You do so entirely at your own risk; Black Dog Media 
cannot accept any responsibility for any damage to your property as 
a result of following this tutorial.

To check the current BIOS version you’ll have to open the BIOS interface. The exact method varies depending on your 
motherboard manufacturer.

Checking Your Current BIOS Version

Step 1 Step 2Close all open apps, then click on the Start button and 
select Power, then Restart. This will shut down your PC 

and reboot it.

As your PC reboots, watch for the BIOS messages that 
flash up on the screen. You’re looking for a message 

that says something like “Press F2 to enter BIOS”. The message 
varies; on some systems it’s the Delete key, on some it’s Esc or one 
of the F keys.

•	 The manual or specification sheet that came with your PC
•	 A used but empty USB flash drive

Things you’ll need:

The Basic Input/Output System (BIOS) is the built-in software that operates the hardware of your computer. 
It is an essential part of the software your computer needs but is often forgotten about or ignored after 
initial set up. To run Windows 10 at optimum performance you may need to update it. 

Update Your 
Motherboard BIOS
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Your BIOS

Since some computer manufacturer’s websites hide 
vital update information, by far the easiest way to 

locate a BIOS update is to type your computer or motherboard 
model number into Google, along with “BIOS update”.

Restart your PC but this time as it reboots, press the 
indicated keyboard key. If Windows launches restart 

and try again. If you don’t know which key it should be, try Delete, 
Esc, F1, F2, F8, F10 or F12. You should see the BIOS version number 
displayed, usually at the top of the screen. Make a note of it.

Once you’ve located the right page, click on the link 
for BIOS version information. In most cases you should 

see a list of available BIOS versions. Check to see if any are more 
recent than the one you have.

You may see that there are updates that mention 
Windows 10 specifically. If there is a more recent BIOS 

version available than the one you have, click on the link to 
download it. 

When you’ve found and noted the BIOS version 
number, press Esc or navigate to the Exit menu and 

quit out of BIOS without saving, since you haven’t made any 
changes to anything. You’re now ready to locate a BIOS update for 
your system.

Once the new BIOS version has finished downloading, 
insert a USB flash drive into any USB port that is 

attached directly to your computer (not an external USB hub) and 
copy the downloaded BIOS update onto it. Leave the flash drive 
plugged in for now.

Step 1

Step 3

Step 2

Step 3

Step 4

Step 4

Once you’ve found out your BIOS version number, you’ll need to check to see if an update is available. You’ll have to do this whether 
or not your PC has a built-in BIOS update utility.

Download a BIOS Update



If you’re attempting to update the BIOS on a laptop, it’s very important that you have it plugged in to the mains adapter, rather than running on the 
battery. If the battery runs out part way through the update process you could render your PC inoperable and end up with an expensive doorstop 
instead of a computer!

44 BDM’s: Advanced Guide to Windows 10

Your BIOS

Look at the main menu or the tabs across the top of 
the BIOS screen. If you see “Tools” navigate to it and 

you should find the BIOS update utility. 

With the USB flash drive from the previous section still 
plugged in, restart your PC and enter the BIOS 

interface by pressing the key that you discovered in the first part of 
this tutorial.

Using the arrow keys, move the cursor to highlight the 
BIOS flash utility and press enter. You’ll see a 

confirmation message appear. Highlight OK and press Enter.

The BIOS update process will now proceed 
automatically. Once it’s complete you will see that the 

BIOS version number has changed.

The update utility should recognise the USB flash drive 
that you have plugged in and it should find the BIOS 

update that you copied onto it. Highlight the update and press Enter.

Press Exc or navigate to Exit, save changes and Exit the 
BIOS screen. Your PC will restart and Windows should 

now launch normally.

Step 2

Step 1

Step 3

Step 5

Step 4

Step 6

Now for the scary part – installing the new BIOS update. Make sure you’ve fully backed up your 
system before attempting this operation.

Flashing Your BIOS Using a Built-in Utility



45BDM’s: Advanced Guide to Windows 10

Your BIOS

Before you download, make sure that it’s the correct 
BIOS for your exact model. Most manufacturers’ sites 

have a series of menus to ensure that you’re on the correct page. If 
you’re sure you’ve found the right one, click to download.

Using Google, type in your computer make and model 
name followed by “BIOS update”. You should find the 

page on the manufacturer’s website with BIOS update information 
and links to download an updated BIOS.

Once the download is complete, extract the files into a 
temporary folder on your desktop. Close any open 

apps and make sure you’ve fully backed up your system. Open the 
temporary folder and look for an executable file ending with the .
exe suffix. Double-click on this file.

The update process will now proceed automatically. 
You’ll see a window with the progress of the process 

shown. Once the update process is complete your PC should 
restart automatically. Let it do so and check that Windows 
launches normally.

WinFlash (or WinPhlash) will now open, showing you 
the name of the BIOS file, usually BIOS.BAK, and the 

new BIOS file name. Check that the option “Backup BIOS and flash 
BIOS with new settings” is selected, then click the button labelled 
“Flash BIOS”.

Once Windows launches, check the system date and 
time. If it’s not updated automatically, you may need 

to restart your PC again and go into the BIOS interface once more to 
reset the system time.

Step 2

Step 1

Step 3

Step 5

Step 4

Step 6

For some systems you will need to update the BIOS from within Windows using a special utility 
called WinFlash (sometimes WinPhlash).

Updating the BIOS Using WinFlash
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Step 1

Step 2

Step 3

Step 4 If you’re installing a driver for a device that has to be 
plugged in and switched on in order to work, such as a 

printer, make sure that the device is connected and powered up 
before proceeding.

Once you’ve entered the model name and told the site 
that you’re looking for Windows 10 drivers, you should 

be offered a link to download the latest driver. Click on the link and 
download the driver file to your desktop.

Some websites (such as Epson’s) can automatically 
detect the operating system you’re using and 

immediately offer you the latest recommended driver. In other 
cases you will have to tell the site that you’re using Windows 10.

Go to the website of your peripheral manufacturer. In 
this case we’re looking at the website for Epson 

printers, to install an update for an R2400 photo printer. Click on the 
link for product support and enter the model name and/or number.

Keeping your device drivers up to date ensures that your computer delivers optimum performance under 
Windows 10 and makes your whole system more stable and reliable. It therefore makes sense to 
periodically check that everything is up to date and using the optimum drivers available. 

Update Your 
Device Drivers

Windows 10 comes with default generic drivers that will let it talk to most common peripherals but for optimum performance it’s a 
good idea to download and install the latest custom made drivers for your hardware.

Finding Device Drivers
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Device Drivers

Step 6

Step 5

Step 7

Step 9

Step 8

Step 10 Once you’ve finished updating your drivers, it’s a 
good idea to restart your machine, since this should 

clear out any temporary files created during the installation process, 
as well as finalising the deletion of any old drivers.

Repeat this process for any other peripherals that are 
connected to your system. You don’t need to restart 

between installations for different types of devices.

The driver installation should only take a few seconds. 
When it’s complete you’ll receive a notification telling 

you that the installation was successful.

From here on the process is mostly just clicking OK on 
a series of windows. Do check that the device driver 

you’re installing matches the device connected to your PC.

You’ll see a message from Windows asking if you 
want to proceed with software installation. Click 

OK to proceed.

Once the driver download is complete, go to your 
desktop and locate the newly downloaded file. 

Double-click on it to begin installation.
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To get started, right-click on the Start button and 
select Task Manager from the power menu. This 

shows you a list of your currently running apps. To see more, click 
on the “More details” button at the bottom of the screen.

The More details view shows you not just running 
apps but all the other services and routines that 

Windows is currently running, and there are a lot of them! 
However what we’re interested in is found on the Start-up tab, so 
click on that.

Step 1 Step 2

If you first installed Windows 10 on a clean hard drive you 
probably notice that it launched much more quickly than 
Windows 8.1 ever did. However over time, as you’ve installed 
more programs, you may have noticed that the once sprightly 
boot-up time now takes noticeably longer. The reason for this    
is that many programs add files to the Windows startup   
process, which are run as Windows launches, slowing down the 
launch process.

Some of these files are genuinely useful, doing things like 
updating your anti-virus software or launching and 
synchronising Dropbox, OneDrive and Google Drive; others 
are simply checking for software updates or initialising 
drivers for seldom used hardware. Some software 
manufacturers, notoriously Apple and Adobe, often install 
several startup files at once and even if you disable them as 
we’re about to show you, any subsequent software updates will 
re-activate the startup files. This is particularly annoying, since 
the more of these startup items there are, the slower Windows 
will launch.

You may have looked at these startup items before and 
wondered whether or not it’s safe to remove them. The simple 
answer is yes, it’s perfectly safe; none of the startup files are vital 
to the running of your PC and all of them can safely be disabled. 
Disabling a startup file will not uninstall the software that it 
launches; all the apps that they affect can be started manually 
when needed and Windows will start up completely safely 
without them. The only one you really need to leave in place is 
the one that starts up your anti-virus software, unless you’re 
relying on Windows Defender, since you do need your PC to be 
protected from the moment it starts. In some cases the anti-
virus software launcher will not even appear in the list to prevent 
you from accidentally disabling it.

If you regularly use a cloud storage service such as Dropbox, 
OneDrive or Google Drive you might also want to leave the 
startup files for these active, since they ensure that your files will 
be synchronised automatically as soon as your PC boots up and 
you won’t miss any important updates the day before an 
important deadline!

Windows 10 launches pretty quickly when it’s newly installed but as you install more apps it may slow down 
over time. This is how to keep that initial fast launch speed by disabling some of the unwanted or unrequired 
software that automatically runs when you start your PC. 

Disable Unneeded 
Start-up Items

Fortunately there’s a very simple way to check and if necessary disable these startup items, restoring your Windows launch speed to 
its former brisk pace. This is what you need to do.

Manage Startup
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Start-up Items

Next you need to look through the list and decide 
which programs you really need to have starting up at 

launch, paying particular attention to any high impact apps. Things 
like iTunes Helper and cloud storage apps are prime examples.

The Start-up tab shows you a list of the apps that run 
every time you launch Windows. On the left column is 

the name of the app, followed by the manufacturer’s name, then 
the status: enabled or disabled. The right column shows the impact 
on start-up speed.

To disable an app, select it and click on the Disable 
button at the bottom of the window. If you’re 

wondering which apps it’s safe to disable, the answer is all of them; 
Windows will still run, however it’s best to leave your security app as 
an enabled start-up item.

Once you’ve been through the list and disabled any 
apps that don’t need to start on launch, close the Task 

Manager and try resstarting your PC. You should find that it now 
boots up more quickly.

Note that disabling an app in the start-up menu 
doesn’t uninstall the app from your system, and you 

can always start any app you need manually. All disabling an app in 
the start-up list does is to prevent it from starting on launch.

Whenever you install a new app it’s a good idea to 
check the start-up list again to make sure that it hasn’t 

added itself to your launch process; if it has, simply disable it to 
maintain your fast boot-up time.

Step 4

Step 3

Step 5

Step 7

Step 6

Step 8
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Right-click on the Start button and select Control 
Panel. When it opens, select one of the two icon views 

from the upper right drop-down menu.

Click on the System icon and in the window that 
opens click on the Advanced System Settings link on 

the left side bar.

Step 1 Step 2

A lot of your PC’s resources are used up presenting you with the 
high resolution display interface that makes a modern computer 
so easy and pleasant to use. Old computers from the 1970s and 
early 1980s used minimal text based interfaces that you needed 
a degree in computer science to understand, but which used 
virtually no resources to run, leaving all the system’s limited 
resources for running software and processing data. When 
Windows and other graphical user interface (GUI) operating 
systems such as Apple’s Mac OS came along in the mid 1980s 
they made computing a lot more accessible for the domestic 
user by presenting an easy-to-understand operating 
environment but required a lot more of the system’s power to 
run them. 

While earlier versions of Windows had quite a stark and 
utilitarian appearance, mostly due to the limited graphical 
capabilities of older PCs, successive versions have added more 
and fancier graphics. Windows 7 was a prime example, 
introducing a number of clever visual effects to the interface to 
take advantage of the increased performance of modern 
computers. The bells and whistles it added included such things 
as partial transparency of window borders and the task bar, 
smooth animations to open and close windows and drop 

shadow effects around windows and under the mouse pointer. 
While these certainly looked very pretty and gave Windows a 
pleasing high-tech look, users quickly realised that these effects 
were having a significant impact on their system performance 
and so many users disabled them, preferring a Windows 
environment that looked more like Windows 98 but had all the 
performance advantages of the latest version. When Windows 8 
came along things got even worse. The infamous Start screen 
with its partial transparency and flashy backgrounds was a 
notorious resource hog but unfortunately it was very difficult to 
do anything about it, which was one of the many reasons why 
Windows 8 was so unpopular.

Windows 10 has definitely cut back on the pretty but excessive 
graphical effects, opting for a simpler, cleaner looking interface 
that looks more like Windows 7 than 8. However there are still a 
lot of visual effects that are being used, it’s just that they’re a lot 
more subtle. The drop shadow effect is still there around the 
active window and there are lots of little animations, such as the 
smooth way that windows open. Fortunately Windows 10 is a lot 
more accessible than 8 and provides options to customise which 
visual effects it uses.

Windows 10 has fewer visual effects in its default set up than either Windows 7 or 8 did but it still has a 
number of subtle effects that take up processor power. If you are using a powerful PC, this shouldn’t be a 
problem but if you feel your hardware is struggling, you can do something about it. 

Turn Off Unnecessary 
Visual Effects

You will need to delve into the advanced settings for this guide, making obvious the strange split between interface and system 
settings that was introduced in Windows 8 and continued in Windows 10. 

Advanced System Settings
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Visual Effects

You’ll see the Performance Options window appear, 
which you’ve probably never seen before. In the Visual 

Effects tab it lists all the advanced appearance settings and effects.

In the System Properties window that opens, click on 
the Advanced tab, then click on the Settings button in 

the Performance section at the top of the window.

Above the list you’ll see four buttons, labelled “Let 
Windows choose what’s best for my computer”, 

“Adjust for best appearance”, “Adjust for best performance” and 
“Custom”. By default the first one is activated.

If you have a powerful system and want all the bling 
that Windows 10 can provide, click on “Adjust for best 

appearance”. This turns on all available visual effects.

If your PC is close to the minimum spec to run 
Windows 10, you can get the most out of it by clicking 

the button labelled “Adjust for best performance”. This deactivates 
all the visual effects in the list, reducing the strain on your processor.

If you want to decide for yourself, click in the 
check-boxes down the left of the list to manually 

activate or deactivate the effects that you want. The most 
demanding are the drop shadow effects and thumbnails, so you 
can turn these off.

Step 4

Step 3

Step 5

Step 7

Step 6

Step 8
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Step 1

Step 2

Step 3

Step 4 You can now double-click the 10Apps Manager .exe file 
to open the software on your computer. The extremely 

simple main interface will now open. Each of the tiles represents a 
piece of preinstalled software that you can uninstall if you have no 
use for it. 

As when making any large system changes to your 
computer, you should create a system restore point 

first. You can do this via Start menu > Control Panel > System 
Properties > System Protection. Configure the restore settings and 
click “Create”.

Extract the contents of the downloaded 10Apps 
Manager zip file and place the folder in your Program 

Folder and pin the shortcut of its .exe file to your Start menu. Do not 
separate out the contents of the Program folder. You don’t need to 
install the software.

You can download the 10Apps Manager software from 
a variety of file download sites or you can get it directly 

from the creators at The Windows Club (www.thewindowsclub.
com). It should be free wherever you download it from, so don’t be 
fooled into paying for this software.

Adding software to remove other software may seem counterintuitive but often this is a safer and faster way to clean up bloatware 
than trying to remove it manually, especially if you are not used to doing it. 

Working with 10Apps Manager

Enabling free upgrades to Windows 10 for existing Windows users has resulted in an increase in 
bloatware, similar to that seen on Android. Whilst none of the bloatware included with Windows 10 is 
harmful, it can have an effect on performance. Thankfully there are ways to remove most of it. 

Remove Windows 10 
Bloatware
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Bloatware

There are several other features that, although not technically bloatware, might not be doing your computer 
performance any favours. Let’s take a look at some of the worse offenders. 

Disabling Other Features

Step 5

Targeted Ads

Click on any of the tiles and then confirm that you want 
to uninstall the app. You may need to wait a few 

seconds for the process to complete. You can delete as many 
preinstalled apps as you wish but if an app does not appear as a tile 
on the screen, you won’t be able to add it. 

Windows 10 assigns every user a unique 
advertising ID to make it easier to provide 

you with targeted adverts. While this cannot be removed, it can be 
disabled. Head to the “General” tab in Windows 10’s Privacy menu. 
Disable the topmost toggle switch labelled “Let apps use my 
advertising ID ...” 

This last option seems simple but it 
can make a big impact in terms of 

battery life and performance. From the Privacy menu, scroll down to 
the bottom of the menu, then select the “Background apps” option. 
From here, simply use the toggle switches to prevent these apps 
from running on start up.

Windows 10 third-party apps can 
access your location, webcam, 

microphone and more by default. Not all apps require these 
permissions. Go to Start menu > Settings > Privacy > Location and 
remove those permissions that seem unnecessary. Repeat for 
things like camera and microphone.

Background Apps

App Location Access

You can reinstall any of the apps you uninstall through 
10Apps Manager. The only slight annoyance is that the 

software doesn’t remove or alter the tile once the app is uninstalled, 
so it is a good idea to make a note of which apps you remove from 
your system. 

Step 6

Meant to streamline the new 
Windows 10 user experience, the 

Getting to Know You feature records logs of your typing history, 
saves recordings of your voice, collects information from your 
contacts etc. Go to Start menu > Settings > Privacy > Speech, linking 
& typing > Stop Getting to Know Me.

Getting to Know You
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Log on to your PC as Administrator. You’ll need to be 
using an Administrator account in order to perform 

the disk defragmentation process.

Click on the Start button and open File Explorer. 
Expand the This PC file tree so that you can see the list 

of drives on your system.

Step 1 Step 2

While hard disk drives provide cheap, fast and reliable bulk 
storage for digital data, they do suffer from one major problem. 
Using protocols that date back to the days when computer data 
was stored on big reels of magnetic tape, data is written onto the 
hard drive sequentially, so that it’s faster to read off again. This is 
fine at first since the data is stored in neat blocks or sectors that 
it’s easy for the system to find. A brand new hard drive will use 
its storage space efficiently for optimum performance, saving 
files in a neat orderly sequence. However over time you’ll 
inevitably delete some files, or replace others with larger ones, 
and the hard drive tries to cope with these changes by splitting 
data files up to fit into available empty space on the drive. This 
can mean that your files are broken up into pieces scattered all 
over the drive, which can radically slow down access times both 
when saving data and when you come to read the data from the 
drive. The system doesn’t lose the data but a hard drive is a 
mechanical device with moving parts, and the physical process 
of moving the read-write head to and fro over the drive platter 
from one sector to another takes a finite amount of time, and 
the more the head has to move the slower the access time will 
be. After a few years of heavy use a hard disk drive can become 
so fragmented that it slows to a near crawl as the system 

struggles to access the scattered chunks of data. This is one of 
the reasons why solid state drives (SSDs) are becoming more 
popular. Since they don’t have any moving parts their data 
retrieval speeds should remain consistently high regardless of 
how much data is stored or how often it is changed. See the 
previous sections of this publication if you’d like to upgrade your 
system to use an SSD.

Fortunately Windows includes an option to “defragment” your 
drive. This is an automatic process that reorganises the data on 
your HDD back into easily accessible contiguous sectors, making 
the most of the available space and greatly speeding up access 
times. In earlier versions of Windows this was a manually 
selected process that you had to remember to perform on a 
regular basis, but Windows 10 includes an option to 
automatically perform an optimisation and defragmentation 
procedure on all attached drives on a regular basis. If your 
system uses a hard disk, as most do, it’s worth performing at 
least the first five steps of this guide, just to see if your system 
would benefit from defragmentation. If you’re using an SSD it 
won’t need to be defragmented, since SSDs store data in a 
different way to HDDs but it can still benefit from optimisation.

Over time the data stored on your hard drive may get fragmented and become slower for your system to 
access. Periodically you should do something about this fragmentation or it will just continue to get worse. 
Using the built-in Windows utility to tidy it up can improve performance.

Defragment Your  
Hard Drive

Disk defragmentation is best done on a regular basis, as the longer you leave it, the longer the defrag will take. By doing it regularly, 
you’ll avoid the build up of fragments and the process will be quicker each time. 

Using the Defragger
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Defragment

In the Properties window, click on the Tools tab. You’ll 
see that there are two options available. Click on the 

button for the second one, “Optimise”.

Right-click on any drive in the list and select 
Properties. You’ll see in a moment that it doesn’t 

matter which drive you select at this stage.

This will open the Optimise Drives window. Here you’ll 
see another list of all the drives attached to your 

system, when the optimisation routine was last performed on each 
one, and how fragmented it currently is. If your system is operating 
at peak efficiency they should all be at 0%.

In the lower part of the Optimise Drives window you’ll 
see Scheduled Optimisation. This should be set to On 

by default but if it isn’t click on the Change settings button.

If any of your hard disk drives are fragmented, click on it 
and then click on the Optimise button. If it’s a large 

drive and very fragmented the process could take a long time, so only 
do it if you’re not going to be using your PC for a couple of hours.

You can set your drives to be automatically 
optimised by ticking the Run on a schedule check 

box and select the interval; for systems used every day a weekly 
check is recommended.

Step 4

Step 3

Step 5

Step 7

Step 6

Step 8
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The Processes tab is the default tab 
when the Task Manager is opened. 
You can open the task manager by 
simply searching for it in the main 
search panel. Just as with any other 
app or piece of software in 
Windows 10, you can pin a shortcut 
to the Task Manager, to the taskbar 
or as a desktop icon. 

With the Processes tab selected, a 
list of all processes is shown. 
Processes are bits of software that 
run in the background, either 
running or waiting to run when a 
corresponding action is taken. As 
you can see from the list here, 
things like Cortana and AVG are 
shown; these you would obviously 
want to leave. 

Processes Tab

Process List

The Task Manager is a very useful tool but even if you have been using Windows for some time, you might 
never have looked at it before. The Task Manager contains information on PC performance, the number 
of running apps, how many processes are pulling power from the processor and much more. 

Using the 
Task Manager
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Task Manager

The Start-up tab contains a list of all the apps, 
programs and processes that are enabled every 
time you start your computer. If your computer is 
brand new, this list should be fairly small and 
filled with essential items. But as you install new 
apps and software, this start-up list can become 
bloated and slow down boot up. You can disable 
auto start-up here. 

Start-up Tab VIEW OPTIONS
The View options at the top of the Task Manager window allows 
you to do several things. You can manually refresh the current 
tab and also change the automatic update speed. For example 
you can change how the processes are displayed. Either by 
grouping them by type, expanding or collapsing the list, or 
showing status values. 

Another useful tab in the Task Manager 
is Performance. This gives you a real 
time performance overview, allowing 
you to pinpoint exactly how well your 
hardware is coping with whatever you 
are doing at the time. If Task Manager 
is the only app open, the performance 
chart should be very stable but if you 
are running several apps, it will show 
any power spikes. 

You can view a limited version of the 
Task Manager by clicking on the “Fewer 
Details” button at the bottom of the 
window. This makes the window small 
enough that it can be left open, in the 
corner of your desktop for example, but 
still show relevant information. You can 
get more information at any time by 
clicking “More Details”.

If you find your PC becoming slow and 
sluggish during normal use, you may 
have too many processes running. By 
looking at the resource usage chart, 
you can see exactly which apps are 
taking up the most processing power, 
physical memory, disk space and 
even network bandwidth. If 
something is particularly resource 
hungry, you can right-click and stop it. 

Performance Tab

Fewer Details

Resource Usage
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If an app crashes, then you need to select it and click 
End Task as before. You should always try and give it 

time to recover (especially if you will lose work). Now we’ve clicked 
the Performance tab at the top of the window and we can see the 
usage of important elements of our PC.

You can see what system resources each app is using 
in each column. Here Excel is using around 74MB of 

memory, for example. Memory use is almost at its maximum, as you 
can see at the top of the column. Maxed out resources are no bad 
thing – after all your PC is there to be used – but when apps crash, 
they are usually using resources and not relinquishing them. 

This window is a little more complex, but the ‘Apps’ 
part of the window is essentially what we were looking 

at in Step 1. Now the apps have been joined by background 
processes. Your PC will most likely be running tens of these unless 
it’s box-fresh. Here we’ve got 41. These are things such as Cortana, 
which runs in the background, and our trackpad software. 

Task Manager starts life as this fairly unassuming little 
window. If you have an app that is unresponsive, 

select it and click End Task. Beware that if you do this to an app 
with unsaved work in it, you will lose your work. Clicking the More 
Details button will expand the Task Manager window. 

Step 4

Step 3

Step 2

Step 1

Task Manager is a lot more complex than it used to be and it’s now a useful insight into your PC system and app performance. If you 
want to take the first step into maintaining your PC, check out our step-by-step guide.

Manage Your PC

If you have a program that isn’t working, want to control what starts up when your PC does or you want 
to see what’s running on your PC, then Task Manager is the place to go. Access it via the Power Menu 
(right-click on Start) or by pressing Ctrl+Alt+Delete and selecting it from the Security Options menu.

Manage Your 
Background Tasks
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Task Manager

Services are programs that run in the background. 
The chances are your PC is running lots of them. For 

example Windows Defender, the built-in security software, runs in 
the background as a service.  As well as viewing the active services 
in Task Manager, you can click the Open Services link to manage 
services on your PC. 

The Details tab is really for pro users only and has full 
information on each running process and which user 

is responsible for it. You can also see how much resource the 
process is taking up as well as what is called a Process ID, or PID, 
that identifies the process on your machine. 

Although it’s of limited general use, the Users tab 
details what apps and processes are running on a 

per-user basis. This might be useful if your PC is running slowly and 
you want to see what resources someone else who is logged into 
the PC is hogging. They might have something wasteful running in 
the background, for example. 

The Startup tab is one of the most important in Task 
Manager. While you can configure an app such as 

Skype to start up when Windows does and disable the same within 
the app, some applications are sneaky and enable themselves to 
start when Windows does. Here you can select the app and either 
enable or stop this from happening. 

Wi-Fi usage (you can also see wired network usage if 
you use that to connect) is more sporadic as the 

network connection tends to be used intermittently – unless you’re 
copying files or similar. Here we’re streaming music, which appears 
to download in chunks. Notice there’s no data being received or 
sent right at this moment.

Here’s our disk usage – as you can see it’s pretty active! 
You will also have this if you have several big apps 

open (we’ve got Edge, Spotify, Word and Excel open in this 
example). In the previous step you could see our processor usage, 
and as you may have noticed, we’ve only been using around 40 per 
cent of its capability during the last minute. 

Step 10

Step 9

Step 8

Step 7

Step 6

Step 5
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Right-click on the Start button and select System. A 
screen will appear that tells you information about 

your computer. Half way down the page you’ll see “Installed 
memory (RAM)” followed by a figure in gigabytes. This is the amount 
of RAM you currently have.

Check the specifications in the manual or booklet that 
came with your PC, or on the manufacturer’s website, 

to find out what type of memory it uses. Most modern PCs and 
laptops use a type called DDR3 with a speed of 1600MHz. 

Step 1 Step 2

The more memory you have and the faster it is, the faster Windows will perform. Adding RAM is one of the 
best ways to improve the speed of an older PC system. Fortunately adding more RAM to your desktop 
system is usually a fairly easy upgrade, one that most people can complete. 

Upgrading Your 
RAM Modules

It may not be possible, or within your budget, but it is always better to run a matched set of memory modules in your PC. When 
buying RAM, for example 8GB on two 4GB sticks, look for the words ‘Matched Pair’. 

Matching RAM

If your PC is close to the minimum specification to run Windows 
10, one of the simplest things you can do to improve its 
performance is to install more or faster RAM (random access 
memory). RAM is the memory that your system uses when it’s 
working, to perform calculations, store temporary data and run 
the operating system. It’s relatively cheap to buy and you can 
find it for sale at any good computer store or from many places 
online. Installing extra RAM does mean opening up the case of 

your PC and tinkering with the insides, but it’s a very quick and 
easy operation, requires no specialist knowledge and can 
usually be done without special tools. If you’re not confident 
that you can do it, most computer retailers will be happy to do 
the work for you for a small fee. Most computers will have spare 
memory module slots to add extra RAM, but it’s generally a good 
idea to replace old RAM with new rather than adding more to the 
existing modules.

• The manual or specification sheet that came with
your computer

• A small cross-head screwdriver
• A nearby water pipe, radiator or other earthed 

metal fitting
• New RAM memory modules

Things you’ll need: DISCLAIMER
Opening up your PC and making alterations to its internal 
components carries the risk of damaging your PC, as well as the 
personal risk of injury or electrocution if you do not take the 
necessary precautions. You may also void the warranty on your 
equipment. If you are not completely confident that you can carry 
out this operation safely DO NOT ATTEMPT IT. You do so entirely at 
your own risk; Black Dog Media cannot accept any responsibility for 
any damage or injury to yourself or your property as a result of 
following this tutorial.
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RAM Upgrade

Before touching any internal components, earth 
yourself by briefly touching a radiator water pipe to 

dissipate any static charge. Using the tip of your finger push the 
retaining clips open one at a time. You’ll see that they partially lever 
the modules out of their slots.

You’ll see the RAM modules located in a row of slots 
on the motherboard. Most PCs have four slots, two of 

which will be occupied by your current RAM modules. You’ll see that 
they’re held in place by plastic clips at each end.

For a desktop PC, lay the computer on its side, and 
open the side of the case so that you can access 

the motherboard. You may need a small screwdriver to remove a 
few case screws, but many cases open without tools. Don’t lose 
the screws!

Shut down your PC and unplug it from the mains, 
disconnect the mouse, keyboard, monitor and any 

other attached devices, then leave it for half an hour to ensure that 
residual voltage in any capacitors has dissipated and any hot 
components have cooled down.

Visit your local computer retailer or shop online and 
buy either two 4GB or one 8GB module of 1600MHz 

DDR3 RAM. Note that desktop PCs and laptops use different sized 
modules, so make sure you buy the right one!

Most popular mid-range desktop PCs will come with 
4GB of RAM, usually on two 2GB modules, while most 

laptops will have a single 4GB module. You can upgrade these to 
increase the amount of memory that your system has to work with. 
Ideally you want at least 8GB.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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RAM Upgrade

Before touching any internal components, earth 
yourself by briefly touching a radiator water pipe to 

dissipate any static charge in your body.

For a laptop, close the screen, turn the machine over 
and locate the memory cover panel. It will usually be 

near the centre of the case; if in doubt check your manual. You’ll 
need a small screwdriver to carefully remove the panel. Don’t lose 
the screws!

Repeat this for the second new module if you 
bought one. Then you can close up the case, 

reconnect your mouse, keyboard, monitor and any other devices, 
plug it back in to the mains and switch it on.

Gently push the new module down into the slot. 
You’ll see that the plastic retaining clips partially 

close as you do so. When the module is all the way in, close the 
retaining clips to lock it in place.

Taking care not to touch the metal contacts, carefully 
position your new RAM modules in the slot, making 

sure to line up the slot in the contact tab with the gap in the 
modules slot, the same as the module you removed.

Holding the modules by the ends, carefully lift them 
out of their slots. You may need to pull them gently to 

free them. Note the position of slot in the tab with the gold contacts, 
and the corresponding gap in the module slot.

Step 14

Step 13

Step 12

Step 11

Step 10

Step 9
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RAM Upgrade

When you turn your computer on it will 
automatically detect the new memory modules and 

start using them. If you now repeat step 1 you should see that the 
amount of installed memory has increased and the performance of 
your computer has dramatically improved.

Replace the hatch cover and tighten the screws. 
Turn the laptop back over and turn it on as normal.

Once the module is seated in the slot, push it back 
down flat until the sprung clips snap into place. 

Repeat this process with the second module if you bought two.

Taking care not to touch the metal contacts, 
carefully position your new RAM module in the slot, 

making sure to line up the slot in the contact tab with the gap in the 
module slot, the same as the module you removed. Gently push it 
into the slot.

Carefully and gently pull out the old memory 
modules, noting the orientation and the position of 

the gap in the contacts tab. If it won’t move, check that you’ve fully 
released the clips. Don’t force it!

You’ll see that the laptop RAM modules are held in 
place by small metal or plastic clips. Use the tip of 

the screwdriver to push these clips aside, and the module will 
spring up so that it can be removed.

Step 20

Step 18

Step 19

Step 17

Step 16

Step 15
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Hard disk drives have been the most popular form of data 
storage for computers since the 1960s. While early hard disks 
were enormous devices the size of washing machines and were 
prone to failure, modern drives are small, fast and extremely 
reliable; a good quality HDD, properly maintained and looked 
after, can last for decades, and some manufacturers even claim 
that their drive may last a century. With multi-terabyte (1 
terabyte = 1,000 gigabytes) HDDs costing less than £200 ($300) 
hard disk drives are still the most cost efficient solution for bulk 
data storage.

However there is a new type of storage drive that is becoming 
more popular, especially for portable devices such as laptops 
and tablet PCs; the flash based Solid State Drive.  Solid State 
Drives (SSDs) have several advantages over Hard Disk Drives. 
They are based on solid state Flash memory, similar to the SD 
card in your mobile phone or digital camera. They have much 
faster read and write times than disk drives, which means that 
Windows will launch and run faster and your apps will load and 
access data much more quickly. Since they have no moving parts 
they are much more durable and less prone to damage than the 
spinning magnetic disk of a HDD, so you’re a lot less likely to lose 
precious data. They are also unaffected by magnetic fields. SSDs 
used to be expensive but prices have dropped dramatically    
over the past couple of years and capacities are increasing all 
the time. While a terabyte SSD is still around £500 ($700), a 
smaller 256GB drive capable of replacing your system storage 
will cost you less than £100 ($150).  Fitting an SSD to your 

computer is a fairly simple procedure, requiring only 
basic tools and should take less than half an hour. 

As with the RAM upgrade, if you’re not 
confident that you can carry out this 

procedure safely, your local 
computer store will be happy to 
do the work for you for a fee.

Note that older PCs may not be 
able to accept an SSD. Check the 

manual or specification sheet to see if 
your computer has Serial ATA (SATA) 

connection support. You’ll find it listed 
under “Drives” or “Internal I/O Connectors”. 

Also check that your PC’s power supply has 
spare connectors to power SATA devices. If it does 

then you’re good to go.

DISCLAIMER
Opening up your PC and making alterations to its internal 
components carries the risk of damaging your PC, as well as the 
personal risk of injury or electrocution if you do not take the 
necessary precautions. You may also void the warranty on your 
equipment. If you are not completely confident that you can carry 
out this operation safely DO NOT ATTEMPT IT. You do so entirely at 
your own risk; Black Dog Media cannot accept any responsibility for 
any damage or injury to yourself or your property as a result of 
following this tutorial.

•	 The manual or specification sheet that came with your 
computer

•	 A small cross-head screwdriver
•	 An SSD drive large enough to replace your HD
•	 A SATA data cable (probably comes with the SSD)
•	 A small torch is also helpful

Things you’ll need:

Solid State Drives are a newer, faster and more robust type of data storage device that can easily replace 
that clunky old Hard Disk Drive in your computer. You can even have a SSD running alongside a traditional 
hard drive, giving you improved speed without losing storage space. 

Upgrade to a          
Solid State Drive (SSD)
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SSD Upgrade

Once you’ve decided on a good position for the SSD 
within the drive bay, carefully slot the drive on its 

mounting plate into the drive bay. Position it so that the screw holes 
on the PC chassis line up with the holes on the mounting plate.

Note that one end of the SSD has the connectors on it. 
You’ll need to position the device so that your power 

and SATA data cables can reach these connectors.

Your new SSD should come with an adapter plate to 
fit it into a 5.25-inch drive bay, as well as the 

required fitting screws. The first action is to attach the SSD to this 
plate. Don’t over-tighten the screws or you may damage the drive.

AN SSD can fit into either a 3.5-inch (floppy disk drive) 
bay or a 5.25-inch (HDD/optical drive) bay. Since many 

recent PC cases no longer have 3.5-inch bays we’ll show how to fit 
your SSD into the larger 5.25-inch bay.

For a desktop PC open the side of the case so that you 
can access the area where the HDD is located. You 

may need a small screwdriver to remove a few case screws, but 
many cases open without tools. Don’t lose the screws!

Shut down your PC and unplug it from the mains, 
disconnect the mouse, keyboard, monitor and any 

other attached devices, then leave it for half an hour to ensure that 
residual voltage in any capacitors has dissipated and any hot 
components have cooled down.

Step 6

Step 5

Step 4

Step 3

Step 2

Step 1



66 BDM’s: Advanced Guide to Windows 10

SSD Upgrade

Now you can close up the case, reconnect your 
mouse, keyboard, monitor and any other devices, 

plug the PC back in to the mains and switch it on.

Plug the other end of the SATA data cable into the 
socket on the SSD. Push it in all the way until it 

clicks. It can only go in one way, so you can’t connect it the wrong 
way round. Push firmly but don’t force it.

Plug one end of your SATA data cable into the 
socket on the motherboard. It should click into 

place. It can only go in one way and the two ends are identical, so 
you can’t connect it the wrong way round.

Locate a SATA data connector on your PC’s 
motherboard. Easy to spot, they’re shaped like the 

letter L. Most recent motherboards will probably have several 
SATA connectors.

Connect the SATA power connector from your PC’s 
power supply to the power socket on your SSD. It can 

only connect in one way, so you can’t get it the wrong way round.

Using the supplied mounting screws, fix the mounting 
plate holding the SSD in position. If you can’t easily 

access all four screw holes don’t worry; as long as the drive doesn’t 
move just using two screws will be fine.

Step 12

Step 11

Step 10

Step 9

Step 8

Step 7
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SSD Upgrade

Close the Disk Management window and open File 
Explorer. You should now see the new drive listed. If 

you previously had only one drive, labelled C, the new drive should 
be labelled D. You can now start using the drive to store data or 
install apps.

Right-click on the new drive and from the pop-up 
menu select New Simple Volume. This prepares the 

SSD to accept new data using the Windows NTFS file system. 
There’s no need to format the drive first.

In the Disk Management screen, you should see the 
new drive listed below your existing drives and 

described as “Unallocated”, with the drive size shown in gigabytes.

Once Windows has launched you’ll need to initialise 
your new drive before you can start using it. 

Right-click on the Start button and select Disk Management.

Step 15

Step 16Step 14

Step 13

Note: If you want to migrate your Windows installation onto your new SSD or to replace the HD of a laptop with an SSD that’s a little 
more complicated. To do this you will need to first learn how to create a drive image.

SSD RAID ARRAYS
Since SSDs are currently generally of smaller capacity than HDDs, 
one solution to increase your storage capacity while still enjoying 
the speed and durability benefits of solid state technology is to use a 
RAID array. RAID stands for “redundant array of independent disks” 
(sometimes “inexpensive” disks), and is a way of making Windows 
tie several SSDs together and treat them as one single drive. This has 
many advantages; not least because the read and write times of a 
RAID array are frequently faster than for a single drive. Setting up a 
RAID array is not too difficult, and is something we will be covering 
in subsequent editions of this guide. For now, if you’d like to know 
more visit https://support.microsoft.com/en-us/kb/100110
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Click on the Start button and then on Settings. On the 
Settings screen, click on Update & Security.

Connect your external backup drive to a USB socket 
on your PC. The blue USB 3.0 sockets (if you have 

them) provide much faster data transfer and will speed up the 
process considerably.

Step 2Step 1

Moving your operating system onto a new Solid State Drive will let Windows and your installed apps 
launch much more quickly and will speed up your whole system. This process may sound like a daunting 
task but as long as you follow these simple steps, it should go smoothly. 

Migrating Windows 10          
to a New SSD

Here we will look at a method for transferring your Windows 10 installation onto this drive, without having to reinstall Windows from 
scratch, using the Windows 10 built-in backup system.

Transfer the OS

Before you start please note that if you want to transfer your 
entire system to an SSD, including any stored data, you’ll need 
an SSD at least as large as your existing hard disk drive. The 
best solution in most cases is to transfer just the C: partition 
containing your Windows installation and system files to the 
faster SSD and then carry on using your slower but larger 
capacity HDD as a D: drive to store your bulk data such as 
documents, photos and videos.

We’ll create something called a “system image”, which is a 
backup copy of your system that can be used to re-install on a 

new drive; it’s also a great way to keep a backup of your 
system, something that you really should do. In order to do this 
you’ll need an external storage drive large enough to hold 
everything on your hard drive. You can buy high capacity 
external hard drives at any good computer store or online 
retailer. If your system supports USB 3.0 you should get a drive 
that supports it too, since it greatly speeds up the transfer 
process. An external drive like this should be on your 	
shopping list anyway, since it’s the best way to keep a backup 
of your important data.

DISCLAIMER
Opening up your PC and making alterations to its internal 
components carries the risk of damaging your PC, as well as the 
personal risk of injury or electrocution if you do not take the 
necessary precautions. You may also void the warranty on your 
equipment. If you are not completely confident that you can carry 
out this operation safely DO NOT ATTEMPT IT. You do so entirely at 
your own risk; Black Dog Media cannot accept any responsibility for 
any damage or injury to yourself or your property as a result of 
following this tutorial.

•	 A newly installed SSD
•	 An external backup drive of sufficient size
•	 A recordable DVD
•	 A Windows 7/8 installation disc or system repair disc

Things you’ll need:
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Migrating to SSD

Click on the button labelled “On a hard disk” and then 
click in the window to bring up the drop-down menu. 

Select the drive that you want to use from the list, then click Next.

The next screen presents you with several options 
about creating your system image backup. The DVD 

option is redundant, since it would take dozens of disks. If you have 
a large network drive available you could use that but we’ll use the 
external HDD.

If you’ve used Windows 7 before, the screen that 
appears should look very familiar. On the left of the 

screen you’ll see “Create a system image”; click on this link.

In the index column on the left of the screen, click on 
Backup and then on that screen, click on the link and 

the bottom of the screen “Go to Backup and Restore (Windows 7)”.

Step 6

Step 5

Step 4

Step 3

On the next screen you can choose which drives you 
want to include in the image. If you have more than 

one, you’ll see that the system drive (C:) is pre-selected. To migrate 
your Windows installation this is all you need.

Step 7

Click Next and you’ll be taken to a final confirmation 
screen where your choices are listed. If you’re happy 

with the settings you’ve chosen, click Start backup.

Step 8
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Migrating to SSD

If you’ve already installed your SSD, open up the PC 
case again and disconnect the old hard drive. If you 

don’t plan on using the HHD again you can remove it. You’ll need a 
small cross-head screwdriver to undo the screws holding the drive 
into the bay.

At this point, if you haven’t already installed your 
new SSD, you should do so. Follow the process laid 

out in the preceding section of this book. While you’ve got the case 
open, disconnect, but don’t remove, the old HDD that had your 
Windows system on it.

Once the backup and disc recording is complete, 
switch off and disconnect your backup drive and 

then shut down your PC. Unplug it from the mains and 
disconnect all attached devices, such as the monitor, mouse, 
keyboard and printer.

Once the disc is complete, take it out and label it 
“Repair disc - Windows 10”. Keep this disc handy 

because you’re going to need it later.

At the end of the backup process you’ll be given the 
option to create a system repair disc. If your PC has 

a DVD-R drive, put a recordable DVD in and click “Create disc”. The 
process will take a few minutes. 

Next you’ll have to wait while the backup process 
proceeds, which will take anywhere from about 15 

minutes to a couple of hours depending on the size of your 
installation and the speed of your backup drive.

Step 14

Step 13

Step 12

Step 11

Step 10

Step 9
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Migrating to SSD

On the second screen of the Windows installation 
process, click on the “Repair your computer” link at 

the bottom of the screen.

Open the DVD drive and insert your old Windows 7/8 
installation disc. Restart your PC and now it will boot 

up from the disc. 

Step 16

Step 17

Close up the case, reconnect your devices including 
the backup drive, plug the mains lead in and switch 

on the PC. It won’t boot up, because the drive containing Windows 
is now disconnected.

Windows should automatically detect the system 
image on the connected backup drive. Check that 

the settings are correct and click Next.

After a final confirmation that you want to proceed, 
Windows will set about restoring your system onto 

your new SSD. The process will take a while, but when it’s done 
Windows should re-start normally.

Step 15

Step 19

Step 20

On the next three screens, click on Troubleshoot, 
then Advanced Options, and then on System Image 

Recovery. This is where you can restore your Windows system from 
the disk image you recorded earlier.

Step 18
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If you use your PC for gaming you’ll no doubt already be aware 
that upgrading to a more powerful graphics card will make a big 
difference to how well your games run. However there are many 
other apps that can benefit from an upgraded graphics card. 
Video or image processing apps such as Adobe Photoshop or 
Premier can use your graphics processor unit (GPU) to speed up 
image processing and some apps that perform a lot of 
calculations can also use the GPU to boost their performance. If 
you’re using some of the graphical bells and whistles that make 
Windows look nice an improved GPU may also speed up your 
desktop performance.

Note that it’s usually impossible to upgrade the GPU in a 
laptop, since it’s often an integrated component and cannot 
be removed. For those laptops that do have a separate 
graphics card, you’ll usually have to buy a dedicated card from 
the manufacturer.

Fitting a new graphics card to a desktop PC is another fairly easy 
upgrade that can be performed without specialist knowledge or 
special tools. There is a huge range of cards available, ranging in 
price from around £25 (€33/$36) for very basic models, to several 
hundred for the latest top end gaming cards. There are two 
major brands that dominate the market, Nvidia and AMD; both 
have advantages and disadvantages but are generally equal in 
terms of performance and value for money. If you want to 
upgrade, set yourself a realistic budget and buy the best card 
that you can afford. However if you’re planning on playing the 
latest games you’ll want to choose a high performance model. 
There are new ones launched regularly but at the time of writing 
the best options are either an Nvidia Geforce GTX 960/ 970/980 
or an AMD Radeon 390/390X.

Before you buy a new card, make sure that your 
motherboard has the correct slots to accommodate it. 

All modern graphics cards use the PCI Express 
(PCIE) slot and most recent motherboards will 
have at least one and frequently several of 
these; if in doubt check in the manual that 

came with your PC or on the manufacturer’s 
website. You’ll also need to check that the new 

card has connectors that are compatible with 
your monitor. Most modern monitors use a Digital 

Visual Interface (DVI) connector but older monitors 
many have a VGA connector, in which case you may 

need to buy an adapter. Also check that your PC’s power 
supply has enough wattage to cope with the new card and 

that it has the right connectors available to plug into it. 
Generally anything over 450-500 watts should be fine, but some 
cards require particular power connections. If you have any 
doubts consult your local computer dealer, who will be happy to 
carry out the upgrade for you for a fee.

DISCLAIMER
Opening up your PC and making alterations to its internal 
components carries the risk of damaging your PC, as well as the 
personal risk of injury or electrocution if you do not take the 
necessary precautions. You may also void the warranty on your 
equipment. If you are not completely confident that you can carry 
out this operation safely DO NOT ATTEMPT IT. You do so entirely at 
your own risk; Black Dog Media cannot accept any responsibility for 
any damage or injury to yourself or your property as a result of 
following this tutorial.

•	 The manual or specification sheet that came with 		
your computer

•	 A small cross-head screwdriver
•	 Your new graphics card
•	 Power connectors for your new card
•	 The driver disk that came with the card, or an Internet 

connection to download drivers.

Things you’ll need:

Although they are often sold as a gamers best friend, your computer’s graphics card isn’t just used for 
making the latest games look pretty. Many everyday apps can make good use of the power of your GPU to 
boost their look and performance. Luckily, upgrading your GPU is quick and easy.

Upgrade Your           
Graphics Card



73BDM’s: Advanced Guide to Windows 10

Graphics Card

Unplug the power connector(s) from the existing card. 
Note that there may be a catch that you have to 

release before the plug will come out. Don’t force it or you may 
damage your motherboard.

Lay the computer on its side, and open the side of the 
case so that you can access the motherboard. You 

may need a small screwdriver to remove a few case screws, but 
many cases open without tools. Don’t lose the screws!

Locate the graphics card. It will be fairly obvious as it 
sits in a slot on the motherboard and is attached to 

the back of the PC case, where it has monitor connection ports 
that are accessible from the rear of the case.

Once the uninstallation process is complete, shut 
down your computer, unplug the mains lead, 

disconnect the mouse, keyboard, monitor and any other attached 
devices, then leave it for half an hour to ensure that residual voltage 
in any capacitors has dissipated and any hot components have 
cooled down.

Click on the arrow next to Display Adapters, and 
right-click on the entry for your current graphics card. 

Select Uninstall, check the box to delete the driver software and 
click OK. Your display will change during the uninstallation; don’t 
panic, this is normal.

Before you install a new graphics card, you need to 
uninstall your old one. Right-click on the Start button 

and select Device Manager from the pop-up menu.

Step 6

Step 5

Step 4

Step 3

Step 2

Step 1
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Graphics Card

Connect the lead from your power supply to the 
power connector on the graphics card. Note that 

some cards require more than one power connection. The plugs 
are designed so that they can’t be connected the wrong way round.

Refit the screw or clip that secures the card to the 
back of the PC case, where the monitor cable goes. 

This is important, since the monitor cable can be quite heavy and 
may get moved about if you move your PC or monitor. 

Carefully push the card down into the slot. If it won’t 
go all the way in, check for obstructions such as 

stray cables. Don’t force it or you may damage both the card and 
your motherboard. You should hear the click of the retaining catch 
when it’s all the way in.

Take your new card, holding it so that you don’t 
damage any of the components or touch the 

contacts tab and position in over the same PCIE slot from which 
you just removed your old card.

Carefully ease the card out of the motherboard slot. 
Note that there may be a hard to spot plastic clip 

holding it in place. Release this clip if present but don’t force the 
card or you may damage your motherboard. 

Using a small crosshead screwdriver, remove the 
screw that holds the card on to the rear of the chassis, 

near to where it protrudes through the back of the case. On some 
cases there may be a clip instead of a screw. Don’t lose the screw!

Step 12

Step 11

Step 10

Step 9

Step 8

Step 7
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Graphics Card

Once the drivers are installed the upgrade process is 
complete. Windows should automatically set the 

optimum screen resolution for your monitor but it doesn’t hurt to 
check the display settings.

If there was no driver disc supplied, or if your PC 
doesn’t have a DVD drive, go to the card 

manufacturer’s website and download the latest drivers. Nvidia’s 
website should automatically detect which card you’re using but if 
in doubt enter the details manually.

Windows will automatically detect your new 
graphics card and will use default drivers; to get the 

best performance you should install the latest dedicated drivers 
from the manufacturer. If your card came with a disc you should 
run it.

Once everything is in place and connected, close up 
the PC case and reconnect the mouse, keyboard, 

monitor and any other attached devices. Turn the machine on and 
wait for Windows to launch.

Step 15

Step 16Step 14

Step 13

USING TWO GRAPHICS CARDS TOGETHER
If you’re planning on building the ultimate high performance gaming 
PC you’ll naturally want the most powerful graphics processing 
available, and for that you need to run two, or even more graphics 
cards together. Most high end graphics cards from the main 
manufacturers have special connectors that allow two or more cards 
to be bridged together to share the load of running the latest games, 
so if you can afford it and you want the best possible performance it’s 
definitely the way to go. Both Nvidia and AMD have their own 
proprietary systems for this; Nvidia’s is called SLI, while AMD has 
Crossfire. They work in essentially the same way; mount two high 
end graphics cards in adjacent PCIE slots and then attach a small 
jumper cable to the sockets on the cards. The supplied drivers will 
recognise the dual installation and set them up accordingly. Of 
course you’ll need a motherboard that has multiple PCIE slots as well 
as a power supply with the wattage to cope with running two 
powerful cards at the same time.
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Windows 10 
Touchpad Gestures

If you are using a laptop, 
these touchpad gestures 

can make Windows 10 
much easier. 

118

Run Ubuntu on a 
Windows 10 PC

Learn how to easily  
run a completely 

different OS on top of 
Windows 10.

90

Set Up Python 
in Windows 10

If you want to take your 
computer science 

knowledge further, 
Python is a good start. 

78
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Master all of the main elements of Windows 10, including the taskbar, 
Action Centre, Registry and Cortana. Learn how to speed up everything 
you do with gestures and hotkeys or simply learn more about hidden 
features like GodMode. This section will guide you through making 
Windows 10 behave exactly how you want it to. 

Windows 10 
Advanced 
User Guides
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If you want to start learning more about coding, Python is just about the best place to start. Setting up 
Python is a pretty straightforward process if you are running a Windows 10 system. It may not be the OS of 
choice for seasoned Python developers but Windows is a safe system to work in.

Using Python in 
Windows 10

Installing Python
Microsoft Windows 10 doesn’t generally come with Python installed, so you’ll normally need to install it separately, although you 
may find it preinstalled on some devices. 

Step 1

Step 2

Step 3

Step 4 Scroll down the Customise Python 2.7.12 options to 
find the Add Python.exe to path options (with a red ‘X’ 

next to it). Click on the ‘X’ and choose ‘Will be installed on local hard 
drive’ from the drop-down menu; this enables you to run Python in 
Powershell using the command “python.” Click Next.

The default install location is C:\Python27\ and you 
are strongly advised not to change it. It is possible to 

install multiple versions of Python on one machine, in different 
folders and we’ll be referencing this folder version later. So don’t 
change it. Click Next.

Open File Explorer and double-click Downloads. You 
will see the Python 2.7.12 file. The Python 2.7.12 Set 

Up window appears. Choose ‘Install for all users’ and click Next. The 
Select Destination Directory Window is now displayed. 

Open your web browser in Windows and enter python.
org/downloads into the URL field. Now click 

Download Python 2.7.12. Don’t select Download Python 3.5.2 
because the older version is better for learning and training.
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Using Python

Click on Search and enter ‘environment’. Choose ‘Edit 
The System Environment Variables’ not ‘Edit 

Environment Variables for your Account’. The System Properties 
window appears, click ‘Environment Variables’.

The Python 2.7.12 script will install all the required 
components. Click Yes in the User Account Control 

window to enable it to do its thing. At one point a black terminal 
window will appear. This will quickly install Pip, a package manager 
for Python. Click Finish to exit the installer.

Now click New. Enter “Pythonpath” in the Variable 
field and “C:\Python27;C:\Python27\Scripts;” in the 

Variable value field. Click OK and OK in the other two windows to 
close them. You are now ready to start using Python on your 
Windows computer.

Click on Search or Cortana and enter powershell and 
click on Windows Powershell. For reference we’re 

using Windows PowerShell and not Command Prompt throughout 
this book.

You now have Python installed on your computer, 
along with an app called IDLE (Integrated 

DeveLopment Environment). Click on Search in Windows and enter 
“python” and you’ll see two options, Python (Command Line) and 
IDLE (Python GUI). You can also run Python from the PowerShell.

Open Enter python and press return. You will see the 
Python prompt “>>>”. If you get an error message, 

restart your Windows computer and check the PATH settings. Enter 
exit() to return to PowerShell.

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

It’s possible to install different versions of Python, so you need to add it to the PATH environment manually. This enables you to have 
control over which version runs Python programs.

Setting the PATH
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Python is the greatest computer programming language ever created. It enables you to fully harness the 
power of a computer, in a language that’s clean and easy to understand. The first step of any new Python 
coder should be to better understand the language and how it compares to others. 

Getting to 
Know Python

What is Programming?
It helps to understand, in a more general sense, exactly what a programming language is before you begin to learn more about 
coding with Python. A good foundation of knowledge makes later learning easier. 

Step 1

Step 2

Step 3

Step 4 You might not understand some of the Python 
commands, like bowl.append and cake.cook(bowl). 

The first is a list, the second an object; we’ll look at both in this 
book. The main thing to know is that it’s easy to read commands in 
Python. Once you learn what the commands do, it’s easy to figure 
out how a program works.

Just like a recipe, a program consists of instructions 
that you follow in order. A program that describes a 

cake might run like this:
 bowl = []	
 flour = 100	
 butter = 50	
 milk = 100	
 bowl.append([flour,butter,milk]) 
 cake.cook(bowl)

Programs are like recipes for computers. A recipe to 
bake a cake could go like this:
Put 100 grams of self-raising flour in a bowl.
Add 100 grams of butter to the bowl.
Add 100 millilitres of milk.
Bake for half an hour.

A programming language is a list of instructions that a 
computer follows. These instructions can be as simple 

as displaying your name or playing a music file, or as complex as 
building a whole virtual world. Python is a programming language 
conceived in the late 1980s by Guido van Rossum at Centrum 
Wiskunde & Informatica (CWI) in the Netherlands as a successor to 
the ABC language.
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Python

When you head to the Python.org download page 
you’ll be confronted by two options: currently Python 

2.7.12 and Python 3.5.2. Why on earth does Python offer an older 
version and which one should you use? Basically, download the 
Python 2.7.12 and ignore the newer edition for now, but be aware 
that a more modern edition exists.

Computer languages that are easy to read are known 
as “high-level”. This is because they fly high above the 

hardware (also referred to as “the metal”). Languages that “fly close 
to the metal,” like Assembly, are known as “low-level”. Low-level 
languages commands read a bit like this: msg db ,0xa len 
equ $ - msg.

Python 2 was released way back on 16 October 2000, 
while Python 3 was released in 2008. Most people 

would opt for the newer version instinctively but the older version of 
Python is around for a reason. There are a lot of differences 
between Python 2 and Python 3 and you can’t run Python 2 
programs in Python 3 without making a lot of changes.

You can usually tell the difference between the two 
languages by looking at a print statement:

print “Hello, world” # Python 2.x
print ( “Hello, world” ) # Python 3.x

There are lots of other differences too. The official stance, found at 
python.org/moin/Python2orPython3 is that you should learn 
Python 3 first. 

Python lets you access all the power of a computer in 
a language that humans can understand. Behind all 

this is an ethos called “The Zen of Python.” This is a collection of 20 
software principles that influences the design of the language. 
Principles include “Beautiful is better than ugly” and “Simple is 
better than complex.” Type import this into Python and it will 
display all the principles.

However, almost every course for beginners uses 
Python 2.7. Popular sites like Codecademy and Lynda.

com all use Python 2.7. Even advanced courses offered by 
universities like MIT use Python 2.7. On top of that almost all the 
help on sites like StackExchange is for Python 2 coders. This makes 
starting with Python 3 much more difficult. So we are going to teach 
you Python 2.7.

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

Complicating matters slightly is the presence of two main versions of the Python language: Python 2 and Python 3. If you are 
completely new to Python, it is probably a good idea to start with Python 3. 

Python 2 vs Python 3
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You’ll need a good text editor to create your Python programs and a regular word processor won’t 
make the grade. In this tutorial we’ll show you how to install and set up our favourite text editor, 
Sublime Text.

Choose and Install 
a Text Editor

Why Sublime?
Sublime is a personal favourite of your humble writer and one of the most respected text editing documents around. It also works 
across Windows, Apple and Linux platforms, so you can use it across all of your computers. It’s also fast and nice to look at. 

Step 1

Step 2

Step 3

Step 4 Choose Preferences  > Colour Scheme > IDLE. This 
changes the colour of the screen to white and the text 

to plain black. You’re also going to use Preferences > Font > Larger 
(Control + =) to make the text larger.

Open the Sublime Text app. It will launch with a dark 
screen and a black document. Enter the words 

print “Hello, world”. Notice that it’s in plain white text on a 
black background. There’s nothing wrong with this but you’re going 
to change the colour scheme so that it’s easier to read the text in 
the magazine.

Open the Downloads folder and double-click the 
Sublime Text Build Setup file.  Click Yes in Window’s 

User Account Control window and follow the Sublime Text 3 Setup 
Window. If you’re on a Mac, click the Sublime.dmg file and drag the 
application to the Applications folder. In Linux, double-click the deb 
file and click Install in Ubuntu Software .

Open your web browser and navigate to sublimetext.
com. Click Download and select OS X, Windows or 

Ubuntu 64 Bit (Ubuntu 32 Bit if you’re running a 32-bit system; you 
can check in System Settings > Details). The installation file will be 
saved to your Downloads folder. 
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Text Editor

Delete the text in your Sublime Text document and 
write a single line that says if True. Don’t worry about 

what this means, you’re just going to use the next line to indicate 
something. Now press the Return key and press the Space bar four 
times and enter print “Do something”. It should look like this:

if True:
    print “Do something”

Before you save the file, take a look in the 
bottom-right of the Sublime interface. You will see the 

words “Plain Text.” When you save the file this will change to Python 
and the colour of the text will change. Choose File > Save As and 
save the file as “helloworld.py”. The “py” extension tells Sublime 
that you’re working with Python code.

That second line is called an “indentation”. Don’t 
worry about what the code means for now. You just 

need to know that you can indent code by pressing four spaces or 
pressing the Tab key a single time; you must never mix and match 
though. Highlight the gap and you’ll see four grey dots, to indicate 
spaces. If you see a solid dash you have a tab.

We really don’t want you to use tabs. So we’re going to 
adjust the preferences in Sublime Text to change tabs 

to four spaces automatically. Choose Preferences > Settings - Default. 
Scroll down to find this text:

    // The number of spaces a tab is considered equal to
    “tab_size”: 4,

    // Set to true to insert spaces when tab is pressed
    “translate_tabs_to_spaces”: false,

Highlight it and choose Edit > Copy (Control-C).

The colour of the text will now have changed with 
print in orange and “Hello, world” in green. The text 

colour takes place automatically and indicates different type of 
code; you never change the colour manually. Notice that the 
description in the bottom right has changed from Plain Text to 
Python. Click this and you will see other languages available.

Now choose Preferences > Settings - User. Place the 
cursor after the “16” at the end of the line with “font 

size” 16. Insert a comma (‘,’) and press return twice. Now choose Edit 
> Paste and Indent. The pasted text should line up with the text in 
the document (as shown in the image). Finally change “false” to 
“true”. Choose File > Save. Now when you press Tab, you’ll actually 
insert four spaces. You’re ready to code.

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

You’re about to get into one of the most long-standing programming heated debates, tabs or spaces? Don’t worry, 
we’ll help you out.

Tabs vs Spaces
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We’re ready to start programming in Python. Get ready to start learning what commands and sequences 
are, the bedrock of computer programming. In this tutorial we’ll enter our first commands and explain 
what the anatomy of a computer program looks like. 

Hello, World: Commands 
and Sequences

Hello, World
You’ll see the phrase “Hello, world” a lot when starting out as a programmer. It’s a computer tradition, which we’re going to honour, 
where the first command you issue in any new programming language is to print the words “Hello, world” on the screen.

Step 1

Step 2

Step 3

Step 4 The “Hello, world” bit in print “Hello, world” is 
known as an “argument”. The statement is the same 

but the argument can change. You can enter print “Welcome to 
Python” or print “We are the knights that say Ni”. 
The argument can change but the statement remains the same.

The command print “Hello, world” is pretty 
easy to understand, even if you know nothing about 

programming but let’s stop and look a bit closer. It’s actually two 
things: the word “print” and the words “Hello, world” inside 
quotation marks. The word print is officially known as a 
“Statement”. Statements are simple commands that tell Python to 
do something.

Now press Return. As soon as you press Return the 
command is inputted into the Python interpreter 

and the words “Hello, world” come right back at you in blue on 
the line beneath. This is known as “Input” and “Output”. Entering 
commands directly into the Shell, like this, is known as “Interactive 
Mode”. In Interactive Mode you see the output as soon as you input 
each command.

Open IDLE on your computer. It will open displaying an 
empty Shell with three chevrons: “>>>”. This is known as 

the “Primary Prompt” and is where you enter Python commands. 
Commands is a line of text that tells a computer to do something. 
Enter the following command: print “Hello, world”
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Hello, World

Let’s create a simple program. It’s going to ask a 
person for their name and then say “hello” to them, 

instead of the world, and then let them know how many letters 
are in their name. In IDLE choose File > New File to create a blank 
text document for our program. Close the Shell so you can focus 
on the program.

As well as statements there are other commands 
known as “functions”. A function is similar to a 

statement but is immediately followed by two brackets “( )” and the 
argument goes inside the brackets. There are lots of functions in 
Python and each does something different. Let’s find out how many 
letters are in “Hello, world”: len(“Hello, world”)

You must save your program before you can run it. 
Choose File > Save As and enter the name “hello_

name.py.” It is important to end the filename in “.py” so your 
computer knows this is a Python program. It’s also a good idea to 
use “_” for spaces and stick to lowercase letters but we’ll cover 
filenames later. Click Save.

We’re now going to write our first program. Do not 
worry too much about understanding the commands 

here. You’ll learn as you go. You do need to type out everything 
exactly as you see it here though, including all spaces brackets and 
using double quote marks (“):

name = raw_input(“Please enter your name: “)
print “Hello “ + name
print “Your name is “ + str(len(name)) + “ 
letters long.”

The function returns 12 on the line below. Count the 
letters and this may confuse you, as there are 

seemingly 11. The extra letter is the space between the “,” and “w”. 
Here’s an important lesson. Computers are extremely literal and 
while you skip over blanks, they do not. Everything has a purpose.

It’s time to run your program. Choose Run > Run 
Module or press F5 on your keyboard. If you’re using 

an Apple keyboard press Fn + F5. The program says, “Please enter 
your name”. Enter your name and press return. It then says, “hello” 
to you and tells you how many letters are in your name. Notice the 
sequence. Our program has three lines and does three things, one 
after another.

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

Few programs are as simple as our print and len commands. These are just a single line but most programs are a sequence of commands; 
one taking place directly after another. This sequence is what you commonly call a “program.” In IDLE these are created in Editor mode.

Sequences
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Computers are literal things and they need you to be very precise. All too often you’ll have errors in your 
program. These are known as “bugs” and getting rid of errors is known as “debugging”. This is an essential 
skill for any programmer or coder, so learning how to do it now will pay dividends. 

Python Bugs 
and Debugging

Bugs are Normal
Before we dive into proper programming, we need to talk about bugs and accuracy. Here’s the thing to remember, it is normal to 
have bugs. Just because your code doesn’t work first time or even the first few times, that doesn’t mean you’re a bad coder.

Step 1

Step 2

Step 3

Step 4 The second type of error is more fiddly. It’s known as a 
“semantic error” or a “logic error”. This is code that the 

computer understands just fine but it doesn’t do whatever you 
wanted it to do. Say you wanted to drive the Google car to school 
but wrote these instructions:

drive(forward)
turn(right)
drive(forward) 

The program runs just fine but the car drives off the map and 
disappears. In this case you need to stop and think about what 
you’re trying to do and why the code isn’t doing it.

The first type of error you’ll make, and the one you’ll 
make most at first, is called a “syntax error.” This is where 

you’ve typed something wrong. In our car program, you might write 
dirve(forward) instead of drive. You can try this out in the Shell. 
Enter pirnt “hello” and it’ll return “SyntaxError: invalid syntax” in 
bright red text. Whenever you see the words “Syntax Error” that’s your 
cue to check carefully for typing errors.

When you make a mistake, your program may not 
work or may seem to work but be doing the wrong 

thing. Imagine you were creating a program that drove a Google car 
around a map to a school. Say this is how the program works:

drive(forward)
turn(left)
drive(forward)
turn(right)
drive(forward)

Programs are written in the language we call “code”. 
There are lots of different languages and Python is easier 

than most but like all code it has to be right to work. Unfortunately 
people aren’t as perfect as computers and everybody makes mistakes. 
These mistakes are called “bugs”.
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Debugging

Spotting and getting rid of syntax errors is pretty 
easy. Just read through and look for bad spelling. 

Keep an eye out also for too many spaces or not enough spaces 
and missing brackets. For every “(“ there should be a “)” after it. 

As you will learn to code from this book it’s important to 
do things the right way. Be sure to type out all the code, 

including any comments, exactly as you see it. If you’re reading this on 
a digital version of the book, do not copy and paste the code. You 
won’t learn anything and you might introduce errors. Type it by hand.

Fixing 
semantic 

errors is trickier and they 
happen more frequently 
as you write bigger and 
better programs. The first 
thing to do is sit down and 
think about what the 
program is supposed to 
do. Sketch it out, giving 
each step arrows in 
between. This is called a 
‘flowchart’. You don’t need 
to write one before 
programming, that’s a bit 
old school, but they do 
still come in handy.

To fix semantic errors you should work through your 
program one step at a time and check each step 

against your flowchart. Instead of looking at the whole program, just 
check each step one bit at a time. Debugging semantic errors is a 
pain but you’ll feel great when you find the error and fix it.

Type slowly. Programming isn’t like other forms of 
writing; you can and should take your time. Be sure to 

try and understand each line as you go. When you get to the end of 
the program read it line-by-line backwards, from the last line to the 
first, before running it. 

You might be wondering why it’s called ‘bug’ and 
‘debug’. In the old days, computers used to be huge; 

big enough for real bugs to crawl around inside. In 1945 US Navy 
Rear Admiral Grace Hopper was working on the giant Harvard Mark 
II machine. She found a bug in the computer and entered it in the 
logbook with “first actual case of bug being found”.

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

Getting rid of errors in your code is known as “debugging” them. It’s pretty common and most programmers say: “you don’t write 
programs; you get rid of all the bugs”.

Debugging
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Programs don’t just run from start to finish. They twist and turn on the way, taking different branches and 
reacting to different things. They also do the same things over and over again. This is what makes them 
smarter than the average calculator.

Learning If and 
Else in Python

If and Else
Conditions form the bedrock of computer programming. Once you understand how conditions work, you’ll be on your way to being 
a programmer. Fortunately Python is written in plain language and it’s pretty easy to understand terms like “if” and “else”.

Step 1

Step 2

Step 3

Step 4 The ‘if’ statement typically forms an optional part of a 
sequence. You might start the day by having breakfast 

and brushing your teeth. Then you hit the ‘if’ statement. If it’s sunny, 
you’ll do the intended stuff: call your friends, walk to the park and 
buy an ice cream. After that, whether it was sunny or not, you’ll go 
back to the unindented stuff and watch television.

Here’s how this works. You write the ‘if’ statement 
followed by the condition. Then on the next line you 

press space four times to create an indentation. This tells Python that 
if this condition is True then run all these lines of indented code. If the 
condition is False, skip past all the indented code and carry on.

Imagine tomorrow is a Saturday and you’re trying to 
plan out what to do with the day. If it’s nice and sunny 

you want to meet up with your friends in the park and buy an ice 
cream. This is how your plan might look:
if today is sunny:

    Call friends
    Walk to park
    Buy ice cream

The word ‘if’ is pretty powerful in Python. With the word 
‘if’ your program decides if it’s going to do something or 

not. This is when a computer does one thing, if the condition is right (or 
“True” in logic-speak). The “condition” is the bit that follows directly 
after ‘if’.
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If and Else

Start up IDLE in interactive mode and enter if True: 
and press return (don’t forget the colon “:”). Notice that 

the cursor goes to the next line, already indented. Enter print “I 
run because it’s True!” Press return twice to run the code.

‘If’ has a partner statement called “else”. As the name 
suggests, this is an alternative indented block of text. So 

if it’s sunny, you might go to the park. Else you might sit around 
playing video games; both have text indented with four spaces. This is 
known as conditional branching. It runs one of the indented blocks of 
text or the other. 

Now let’s try something false. Enter if 2 + 2 == 
5:, press return and print “Math works!” Press 

return twice and nothing happens. The double equals sign (“==”) is 
Python’s way of saying “equals”; we’ll look at this in more detail later. 
Now try again. Enter:
if 2 + 2 == 4:
    print “Math works!”

Let’s create a program to show this off in more depth.  
Open IDLE and choose File > New. Enter this code and 

press F5:
word = raw_input(“Please enter a four-letter word: “)
if len(word) == 4: 
   print word + “ is a four-letter word. Careful now!”
else:
   print “That’s not a four-letter word. Try harder.”
Remember you indent with four spaces. Never, ever press the tab key.

It’s not uncommon to find ‘if’ statements nested inside 
other ‘if’ statements. In this case you have an 

indentation inside an indentation. This plan might be to go to the 
park if it’s sunny and buy an ice cream, if the ice cream van is 
present. If it’s not sunny then play video games. It’s okay, if a bit 
confusing, but you shouldn’t have three ‘if’ statements nested. 
That’s considered too confusing.

Save the program and press F5. It will print “Please 
enter a four-letter word.” Enter a four-letter word of 

your choosing and press Return. It will say, “four is a four-letter 
word. Careful now!” Press F5 to run the program again. This time 
enter a word that hasn’t got four letters. It will say, “That’s not a 
four-letter word. Try harder.”

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

Our sunny trip to the park was what’s known as dummy code. This explains how stuff works but it’s not actual code that Python can 
understand. We’re going to put ‘if’ and ‘else’ into action. 

Four-letter Word
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It is possible to run a full Linux distribution, like Ubuntu, on a Windows PC without installing it. This is useful 
for a number of reasons but initially it is a great way to try out Linux itself, or even a new distribution, before 
you commit to installing and using it on your computer. 

Run Ubuntu on a 
Windows 10 PC

Creating a Bootable USB Drive
You can try Ubuntu and other distributions from a bootable DVD but it is usually easier and more convenient to use a USB flash drive, 
and that is what we will create here. 

Step 1

Step 2

Step 3

Step 4 Once downloaded and installed on your PC, click the 
icon to open Rufus and select your USB stick in the 

Device dropdown. Click the CD Rom icon next to the FreeDOS 
dropdown, then find your downloaded Ubuntu ISO and click Open 
and then Start. 

You now need to get Ubuntu onto the USB stick. This 
can’t be done by simply dragging and dropping the file 

onto the drive, as if you were copying a photo over. You’ll need to 
make the stick a Bootable Drive. One of the best tools for doing this is 
called Rufus 2.11: https://rufus.akeo.ie/.

To create a bootable USB from within Windows, the 
next thing you need to do is download the Linux 

distribution you want to use. We are using Ubuntu 16.04.1 LTS 
(Long-Term Support), that can be downloaded from the Ubuntu 
download page: www.ubuntu.com/download/desktop.

To run Ubuntu from a USB stick, you will need one which 
has at least 2GB capacity and preferably more than that 

(4 to 8GB is recommended). You can buy a 4GB USB stick very cheaply 
and as it can be used again for different purposes, it is a useful thing to 
have if you don’t already. 
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Ubuntu

Turn off your Windows computer and insert the USB 
drive with the Ubuntu ISO file on it. You now need to 

tell your computer to boot from that USB stick and not from the 
hard drive, and therefore Windows, as it normally would. Some 
newer computers can start up automatically from USB.

Click ‘Yes’ when you’re asked to download Syslinux 
software and then ‘OK’ to write in ISO Image mode. 

Confirm that your USB stick is selected and then ‘OK’ to continue. The 
process may take a few minutes, so be patient and wait for the 
message to tell you it is completed. 

If your computer does not automatically do this, you 
will need to change the device from which the 

computer starts up to the USB. You can usually do this by watching 
for a ‘Enter Setup’ message appearing before Windows starts and 
pressing the key shown (this varies between devices). 

Once into the Set up/BIOS screen, look for the option to 
change the ‘Boot Device’. This may be on the main 

screen, or within the System tab/section. Depending on your 
computer and how your USB key was formatted, you should see an 
entry for ‘removable drive’ or ‘USB media’. 

If you are wondering, Syslinux is a boot loader for the 
Linux operating system that runs on an MS-DOS/

Windows FAT filesystem. It is intended to simplify first-time 
installation of Linux and for creation of rescue and other special 
purpose boot disks. 

Move this to the top of the list to force the computer to 
start from USB rather than the hard disk; save your 

changes and continue. Choose your preferred language and click 
on Try Ubuntu. Your live desktop should appear. If you then want to, 
double-click on ’Install Ubuntu 16.04 LTS’.  

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

Now you have the Linux ISO file (in our case, Ubuntu) copied onto your bootable flash drive, you are ready to boot into the OS. Here 
is the exact process you will need to follow to change the boot order. 

Booting from a USB Drive
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Bash is the default shell included within Ubuntu and other Linux distributions. Users type commands into a 
shell to execute scripts and or run commands and tools to accomplish many tasks. It can now be enabled in 
Windows 10. This is a real native Bash Linux binary running on Windows itself. 

Enable Bash in 
Windows 10

Bash in Windows 
The Bash shell isn’t available to use by default, it needs to be activated, and can only be activated after the Anniversary update has 
been applied. 

Step 1

Step 2

Step 3

Step 4 If you prefer to enable the feature through the GUI, 
click Start and search for “Turn Windows features on 

or off”; just type ‘turn’ to see this option. Scroll down almost to the 
bottom of this panel and select the check box next to ‘Windows 
Subsystem for Linux (Beta)’ and then click OK. 

You now need to enable Windows Subsystem for Linux. 
WSL is a new Windows 10 feature that enables you to 

run native Linux command-line tools directly on Windows, alongside 
your normal Windows desktop and modern Microsoft store apps. You 
have two options for doing this. 

Now you have checked the platform is ready, you need 
to make a few changes so that Bash can be activated. 

Head into Settings again and then Update and Security. At the top of 
this page you will see the Developer Features section. Click the 
‘Developer Mode’ radio button, wait and then restart. 

The first thing you need to do is check that the PC is 
running the required 64-bit version of Windows. 

Specifically, the PC needs to be updated to Windows 10 Anniversary 
build 14393 or later. If you are not sure, you can check in Settings > 
System > About and look for OS Build and System Type. 
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To begin running Bash on the Windows 10 PC, you 
need to first open a Command Prompt. Once open, 

simply type “bash” and tap Enter. You will then need to type “Y” to 
accept the license agreement. A progress counter will be shown in 
the command prompt window.

You can also enable WSL using a command-line. Open a 
PowerShell prompt as the administrator by searching for 

‘Windows Powershell’, right-click and choose ‘Run as administrator’ 
and type: Enable-WindowsOptionalFeature -Online 
-FeatureName Microsoft-Windows-Subsystem-Linux 

The first time you install Bash on Windows, you will be 
prompted to create a UNIX username and password; 

this can be different from, and has no relationship to, your Windows 
username and password. 

To launch Bash on Windows, either run bash at a cmd/
PowerShell command-prompt or use the Start menu 

shortcut. After installation your Linux file system components will be 
located at: C:\Users\<Windows user name>\AppData\Local\lxss\. 

You will now need to restart the Windows PC before 
you go any further. It is important that you do restart 

when prompted as some of the infrastructure that Bash on 
Windows requires can only be loaded during Windows’ boot-up 
sequence. Once the PC has restarted, you are ready to use Bash. 

This directory is marked as a system file that is hidden 
by default. Accessing this location directly is not advised 

due to caching between the Linux and Windows file systems. 

Step 1

Step 5

Step 2

Step 3

Step 6

Step 4

With everything set up, you can now run the Bash shell on your Windows 10 computer. Once activated, it will always be available 
to use. 

Run Bash on Windows 10
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Step 1

Step 2

Step 3

Step 4 You can do this each time you need to use a shutdown 
timer, which is not really a problem if you only rarely 

use it, or you can create a shutdown timer shortcut that can be 
placed on the desktop. The only real problem with a shortcut is that 
the shutdown time is fixed. 

Press Enter to complete the command and set the 
timer going; you won’t see anything on screen just yet, 

that part comes in a moment. If you input the wrong time or 
entered the command by mistake, you can cancel the timer by 
typing shutdown -a in Command Prompt. 

In the Command Prompt, type the command 
shutdown -s -t XXXX. The “XXXX” should be the 

time in seconds you want to elapse before the computer shuts 
down. For instance if you want the computer to shut down in one 
hour, the command should look like shutdown -s -t 3600. 

The first thing you need to do to create a shutdown 
timer manually, is open the Command Prompt. You 

can do this easily by pressing Windows + X and then selecting 
“Command Prompt” or “Command Prompt (Admin)” from the 
menu that appears. 

Before you can add a shutdown timer to the desktop, you need to understand how to create one using the Command Prompt tool. 
The initial set up might seem slightly complicated but is much easier after the first time. 

Adding the Timer

A shutdown timer allows you to delay the shutdown of your computer in the event that you need to leave it 
on whilst it completes a particular function, software updates for example, but can’t stay around to shut it 
down manually. The process is fairly straightforward and the timer is unobtrusive.

Add a Shutdown 
Timer to the Desktop
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Shutdown Timer

Step 5 Step 6 Place the shortcut out of the way on your desktop. 
Every time you double-click the shutdown timer 

shortcut, the timer will start. To cancel the timer, you can create a 
second shortcut using shutdown.exe -a or enter the 
shutdown -a command in Command Prompt. 

Right-click on the desktop, hover over New and select 
Shortcut in the side menu. In the path field type 

shutdown.exe -s -t XXXX (where “XXXX” is the time in 
seconds) and click Next. Enter a name for the shortcut, for example 
“Shutdown 1 Hour”, and click Finish.

F1:	 Pastes the last executed command (character by character)
F2:	 Pastes the last executed command (up to the entered character)
F3: 	 Pastes the last executed command
F4: 	 Deletes current prompt text up to the entered character
F5: 	 Pastes recently executed commands (does not cycle)
F6: 	 Pastes ^Z to the prompt
F7: 	 Displays a selectable list of previously executed commands
F8: 	 Pastes recently executed commands (cycles)
F9: 	 Asks for the number of the command from the F7 list to paste 

Using the Command Prompt to start a shutdown timer is just one of hundreds of ways this admin tool can be used. Let’s take a look 
at a few other ways.

1. Command Prompt Function Keys

2. Command Prompt Help

If you are finding yourself using the Command Prompt tool a lot, 
these F Key shortcuts can come in very handy. 

The help command (type 
“help [command]”) does 

not provide help for every Command Prompt command. 
However, any command can be suffixed with the /? option, 
usually called the help switch, to display detailed information 
about the command’s syntax and even some examples. 

Just about any command can be 
stopped in its tracks with the 

abort command: Ctrl-C. If you haven’t actually executed a 
command, you can just erase what you’ve typed but if you’ve 
already executed it then you can use Ctrl-C to stop it. Remember 
that even Ctrl-C can’t undo things that aren’t undoable.

3. Abort a Command

COMMAND PROMPT TRICKS



96 BDM’s: Advanced Guide to Windows 10

Backing Up Your Registry
Before you edit any part of your system registry, it is always a good idea to make a backup of all keys that you intend to edit. Here we 
will look at the simple and quick method of backing up Windows Registry keys.

You can back up any of the keys in the registry by 
right-clicking on any of them in the editor and then 

selecting Export. This will save into a .reg file that can be run to 
reapply the old value of that key at a later date. This is the minimum 
backup step you should take before editing. 

An easier backup method is to make a System Restore 
point that includes a snapshot of the registry. Go to 

Start, type restore, select Create a restore point, select a drive and 
click Configure…; then pick Turn on system protection, set the Max 
Usage space and click OK. 

Step 1 Step 2

The Windows Registry is a hierarchical database that stores 
low-level settings for the Microsoft Windows operating 
system and for applications that opt to use the Registry. The 
kernel, device drivers, services, Security Accounts Manager 
(SAM) and user interface can all use the Registry. The Registry 
also allows access to counters for profiling system 

performance. Prior to the Windows Registry .INI files stored each 
program’s settings as a text file, often located in a shared 
location that did not provide user specific settings in a multi-
user scenario. By contrast the Windows Registry stores all 
application settings in one logical repository, a number of 
discrete files, and in a standardised form. 

WHAT IS THE REGISTRY?

The Windows Registry can be a scary place to visit if you don’t understand how things work. It is true that 
there are often simpler ways to action some of the changes shown below but understanding the inner 
workings of your Windows 10 PC is key to understanding how to accomplish more with your screen time.

Windows 10 
Registry Tweaks
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Registry

So let’s get down to tweaking some registry keys. Registry keys always start with HKEY, followed by the location in 
the file system. Once you find and select the HKEY you want, you will see that further options are available. 

Registry Tweaks

1. Access the Editor

2. Increase Taskbar Transparency

To open the registry editor, all you 
have to do is open the Run prompt 

with Windows Key + R, then type in regedit and hit Enter. If you 
know a certain value you want to change, you can navigate through 
the registry to find it by clicking the + sign next to each registry key. 

In Registry Editor, 
go to following 

key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
Windows\CurrentVersion\Explorer\Advanced

In the right side pane, create new DWORD 
UseOLEDTaskbarTransparency and set its value to 1. 

In Registry Editor, go to 
following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\ 
CurrentVersion\Explorer\
FolderDescriptions\<FOLDER-GUID>\PropertyBag. 

Substitute the <FOLDER-GUID> above with one of these:
Desktop: {B4BFCC3A-DB2C-424C-B029-7FE99A87C641}
Documents: {f42ee2d3-909f-4907-8871-4c22fc0bf756}
Downloads: {7d83ee9b-2244-4e70-b1f5-5393042af1e4}
Music: {a0c69a99-21c8-4671-8703-7934162fcf1d}
Pictures: {0ddd015d-b06c-45d5-8c4c-f59713854639}
Videos: {35286a68-3c57-41a1-bbb1-0eae73d76c95}

If ThisPCPolicy is set to Show, then the folder is visible. If you 
change it to Hide, then the folder will be invisible. 

5. Hide Folders from This PC

In Registry Editor, go to following key: 
HKEY_CURRENT_USER\Software\Microsoft\Windows\
CurrentVersion\Explorer\Advanced 

Create a new DWORD value, name it EnableBalloonTips and 
set its value to 0.disable Wi-Fi Sense and Application Telemetry. 

4. Disable System Tray Notification Balloon Pop-ups 

In Registry Editor, 
go to following 
key:

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\
Windows\WindowsUpdate\AUkey

Right-click in the right pane and create a new 32-bit DWORD value 
named: NoAutoRebootWithLoggedOnUsers. Set its value to 1.

3. Prevent Windows Update from 
Automatically Restarting 
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WordPress is one of the easiest and most popular website publishing tools available. It can also be a good 
introduction to working with HTML and CSS files in a design environment. If you are hosting WordPress 
yourself, you may need to learn a few new skills to get up and running. 

Installing WordPress 
on Windows 10

Uploading the Files
The first thing to do is get the core WordPress files onto your web server, generally the server provided by your hosting company, and 
be ready to install the WP software. 

Step 1

Step 2

Step 3

Step 4 This file controls which database the WordPress install 
will use when it installs, and when the software is 

used, but will need to be configured with the correct information, 
including database name, username and password. See the boxout 
below for more information on wp-config.

Before you upload the wordpress files, open the folder 
on your desktop and look for a file called wp-config.php 

(it may be shown as simply wp-config). It will be in the main folder, 
rather than in the wp-admin, wp-content or wp-includes folders. 

You will need to upload the WordPress files to your 
hosting server. The easiest way to manage the 

upload is to use an FTP client (assuming you have a FTP account) 
such as CuteFTP. Alternatively, your web host will include a file 
management tool. 

You first need to download the latest version of the 
WordPress files from the WordPress.org website (https://

wordpress.org/download/). The files will be downloaded as a zipped 
folder. Extract the files to somewhere safe on your computer. 
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With the config file completed correctly and saved back 
into the WordPress folder, you can upload the whole 

thing to your hosting server. If WordPress is going to be powering your 
main site, upload to the root directory. If it will be a blog section on a 
main site, upload to a folder in root. 

If you are having problems uploading the files through 
the file manager that your server host provides, try 

downloading CuteFTP. You will need to get your FTP (File Transfer 
Protocol) from your web host and then follow the user instructions 
to set up CuteFTP. 

Step 5 Step 6

One of the only bits of file editing you will need to do to get 
WordPress set up is the changes to the wp-config.php file 
mentioned above. You will need to have a MySQL database set 
up on your web host and have all of its information to hand. 
Open wp-config with a text editing program and edit the 
following information: 

1.	 Replace ‘database_name_here’, with the name of  
your database 

2.	 Replace ‘username_here’, with the username displayed  
for your database 

3.	 Replace ‘password_here’, with the your database password 
4.	 Replace ‘localhost’, with the name of your database host (if 

unsure, try leaving as ‘localhost’)

Be careful to preserve the quotation marks. There are several 
other parameters you can alter in this document but unless you 
really know what you are doing, it is best left as is once you have 
updated the database information. Save the document back 
into the unzipped WordPress folder ready to be uploaded to 
your web server. 

EDITING WP-CONFIG.PHP
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WordPress

The page will open and the automatic installation and 
set up will begin. If there were any errors in the 

wp-config file, this automatic installation will fail and an error 
message will be shown. If the install and set up is a success, you will 
be told in a message on screen. 

When all of the WordPress files have been uploaded to 
the correct location on your hosting server, including 

the all-important wp-config.php file, open the Internet browser on 
your computer. Type the URL of your WordPress install (e.g. www.
mysite.com or www.mysite.com/blog). 

Your Dashboard will almost certainly show that 
updates are available (either to themes, preinstalled 

plugins or perhaps even the WordPress version), so it is a good 
idea to go through all of these and make sure everything it up to 
date before starting to add content. 

You can now log in to your WordPress dashboard 
using the username and password you chose during 

the set up process. If you want your login details to be automatically 
filled whenever you try to log in, check the ‘Remember Me’ box. 

Step 2

Step 1

Step 5

Step 4

With the WordPress system files uploaded, you can begin the set up process. WordPress prides itself on providing a simple 
installation process, even for first time users. 

Installation Process 

ROOT AND SUB DIRECTORIES
Where you upload your WordPress files on your hosting server is 
important. Uploading to a sub directory when you really want 
the files in the root directory will mean your URL will be 
incorrect and may cause other problems.
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Once you enter Fantastico, there is a Blogs category 
on the left hand side under which you will find 

WordPress. Click on it. Click on the New Installation link in the 
WordPress Overview.

Log in to your cPanel account and click on the 
Fantastico (or Fantastico Deluxe) option. If your web 

host does not use cPanel, it is unlikely that they will offer Fantastico 
as an option. 

To complete installation, you will need to fill in the 
various details requested, including the correct 

domain (if you have multiple domains) and login details. Once 
complete, click Submit.

Step 2

Step 1

Step 3

Although, in our opinion, it is a good idea to get used to 
managing files manually, if you plan to run a WordPress-based 
website or blog, many web hosts offer automated tools for 
completing WordPress installation. Here is a guide to using one 
of the most popular, Fantastico. 

Automated Installers 

IN A SUBDIRECTORY

IN THE ROOT DIRECTORY

If you want to keep your files in a subdirectory, rather than the 
root, rename the WordPress directory to your desired name, then 
use an FTP client to upload the whole directory to the root 
directory of your web server.

If your files are already on your web server, and you are using 
shell access to install WordPress, move the WordPress directory 
to your preferred location within the root directory of your 
website and rename the directory to the name you want.

If you need to upload your files to your web server, use an FTP 
client to upload all the contents of the WordPress directory, but 
not the directory itself, into the root directory of your website.

If your files are already on your web server, and you are using shell 
access to install WordPress, move all of the contents of the 
WordPress directory, but not the directory itself, into the root 
directory of your website.

LOCAL WORDPRESS 
INSTALLATION 

It isn’t always advisable to experiment with a live WordPress site, 
installed at your domain, as it can confuse or alienate any visitors 
who find the site and see it constantly changing. In this case, you 
can use a Local Installation tool, such as Instant WordPress. 

Instant WordPress is a complete standalone, portable WordPress 
development environment. It turns any Windows machine into a 
WordPress development server. It will even run from a USB key. 
Instant WordPress comes complete with it’s own built in Apache 
web server, PHP and MySQL installations that are started and 
stopped automatically; and includes a set of dummy WordPress 
posts and pages so that you do not have to create any data or 
posts to test themes and plugins. 
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Check Calendar Events: “How’s my schedule 
looking?” or  “What appointments do I have next 
week?” or “What day is my doctors appointment?”
Add an appointment: “Add bank appointment to 
Monday at 11 am.” or “Schedule meeting with Dave 
tomorrow at 10 am.”
Move an appointment: “Move my bank 
appointment to Friday at 1pm.”
Set a reminder based on time, contact, or 
location: “Remind me to call Dad at 2 pm.” or 
“Remind me to check groceries when I get home.” 
Set an alarm: “Set an alarm for 9 am.” or “Wake me 
up in an hour.”
See all alarms: “Show me my alarms.”
Ask about national holidays: “What day is Christmas 
this year?” or “When is the next public holiday?”

Cortana is very good at understanding conversational commands, so try to remember to talk to 
her as if you are requesting something from a human. 

Scheduling/Reminders

Launch a program or app: “Launch Dropbox” or 
“Open Mail”.
Open a website: “Open bdmpublications.com.” or 
“Show me microsoft.com”.
Make a phone call: “Call John” or “Call Paul on 
speakerphone” (Windows Phone only)
Take a note in OneNote: “Take a note” or “Note it 
down.” (followed by note content).
Compose an email: “Write an email to [contact] 
saying [message].”
Compose a text message: “Write a text to 
[contact] saying [message]” (Windows Phone only)
View messages from a specific contact: “Show 
me emails from Jim.” or “Show me messages from 
Paula.”
Control settings: “Turn on/off Wi-Fi”, “Turn on/off 
Bluetooth”, “Turn on/off Airplane Mode” etc.
Control the Groove Music app: “Play [artist/song/
genre/playlist/album]” or “Shuffle the music”

PERFORM FUNCTIONS

The more you use Cortana and the more you get used to the ways in which it can help you, the more 
impressive it becomes. Cortana can help you with everything, like checking events, setting reminders, 
composing emails and launching apps. All this and without having to even touch the keyboard. 

Essential Cortana 
Commands List
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Cortana

Check Calendar Events: “How’s my schedule looking?” or 
“What appointments do I have next week?” or “What day is my 
doctors appointment?”
Add an appointment: “Add bank appointment to Monday at 
11 am.” or “Schedule meeting with Dave tomorrow at 10 am.”
Move an appointment: “Move my bank appointment to 
Friday at 1pm.”
Set a reminder based on time, contact, or location: “Remind me to call 
Dad at 2 pm.” or “Remind me to check groceries when I get home.” 
Set an alarm: “Set an alarm for 9 am.” or “Wake me up in 
an hour.”
See all alarms: “Show me my alarms.”
Ask about national holidays: “What day is Christmas this year?” or 
“When is the next public holiday?”

Just as with other well known personal assistants, the 
developers of Cortana have made it capable of answering less 
sensibly and even cracking a few jokes. This is not a complete 
list, so why not try out a few of your own! 

Have Fun with Cortana

Check current location: “Where am I?”
Get directions: “Show me driving/public transit/walking 
directions to [location].”
Check travel time: “How long will it take me to get to 
[location]?”
Traffic updates: “What is traffic like on the way to [location]?”
Show a map of a specific location: “Show me a map of North 
London” or “Show me a map of Florida”
Track flight status: “Is my flight on time?” (must be synced 
with an email account)
Check weather for any location: “What is the weather like in 
Madrid?”
Translate a word or phrase: “How do you say ‘thanks’ in 
Swedish?” or “How do you say ‘airport’ in Japanese?”
Convert currency: “What is 900 US dollars in Euros?” or “How 
much is 1,000 yen in Euros?”

Ask about the weather: “What is the weather like?” or 
“What will the weather be like tomorrow?” or “Is it going to rain 
on Monday?”
Perform simple calculations: “What is 15 times 13?” or 
“What is 126 divided by three?”
Perform conversions: “What is five miles in kilometres” or 
“How many ounces in a kilogramme?”
Word definitions: “What is the definition of ‘supreme’?” or 
“What does ‘abstain’ mean?”
Hear news headlines: “Show me the top headlines.”
Search for date-specific pictures, videos, documents etc.: “Find 
pictures from last week” or “Find documents from April 2016” 
or “Find videos from yesterday.”
See basic search results in Cortana’s window: “How old is 
Leonardo DiCaprio?” or “Who is the Manchester United’s 
manager?” or “When was Big Ben built?”
Search files by name: “Find a document called ‘Expenses’” or 
“Can you find a picture called ‘kittens fighting’?”
Track packages: “Where are my packages?” (requires a synced 
email account)
Check a sports score: “What was the score of the last 
Redsox game?”
Identify a song that’s playing: “What is this song?”

MAPS AND TRAVEL

GENERAL QUERIES
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Time Based Reminders
Time based reminders are perfect if you want to set an alert at the same time each week or if you want 
to avoid missing an important appointment. 

The easiest way to wake Cortana up and get her 
listening is to click the microphone icon in the search 

box or press Windows + C shortcut on the keyboard. You will hear 
an audio signature to let you know that the personal assistant is 
ready and waiting to assist.

You can now set your reminder in a variety of 
different ways. Cortana is pretty good at 

understanding inexact terms. For example you can say “remind 
me to pick my wife up in half an hour” or “Remind me to go to the 
post office tomorrow morning”.

If Cortana doesn’t hear or understand your request, 
she will ask you for confirmation or to repeat the 

request. She might also ask for further details, depending on how 
you have set her up; you can add details to Cortana to make her 
more useful, such as your home address. 

To add a reminder manually, click inn the Cortana 
search box, and then click the light bulb icon (the 

Reminders icon). To add a new reminder, click the + button at the 
bottom, complete the “Remember to” and “Time” boxes and then 
click “Remind”. 

Step 1

Step 2

Step 3

Step 4

There are several different reminder types you can set with Cortana, some time based others photo reminders. 
Almost all can be set using either your voice or manually by entering them into the main reminders screen. If 
using a Windows phone, you can also sync your reminders so that they show on both devices.

Setting Cortana 
Reminders
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Cortana

You can tell Cortana to remind you of certain things when you 
leave or arrive at specific locations. 

Set to be improved and expanded in future updates, this feature 
is nonetheless available to Windows 10 users right now. 

Location and 
Contact-Based Reminders Photo Reminders

Wake Cortana up and get her listening by clicking the 
microphone icon in the search box or pressing the 

Windows + C shortcut on the keyboard. You will hear an audio 
signature to let you know that the personal assistant is ready and 
waiting to assist.

Image or photo reminders probably won’t be 
appropriate for every situation but they could 

definitely come in handy at times. To set one up, open Cortana by 
clicking her icon on the taskbar. Open Reminders by clicking the 
light bulb icon and then the + icon in the bottom right corner.

You can then say something like “Remind me to ring 
mum when I get home” or “Remind me to buy milk 

when I leave the office”. Again this works better if specific 
locations are known to Cortana, which we cover in other tutorials 
in this section. 

Type your reminder word or phrase, and then click the 
camera icon to the right of the box. You will be able to 

choose Library, which lets you choose a photo on your computer or 
Camera, which lets you snap a photo using your webcam (make 
sure your camera is enabled).

You can also tell Cortana to remind you anything 
next time you talk to certain people in your contacts 

book. An alert pops up when you send or open an email from that 
person. For example “Remind me to ask for the discount next time 
I talk to Kim”. 

It may be that you want to capture a picture of an item 
to buy later but might forget exactly what it is,or you 

had a certain window up on your computer that you want to take a 
screenshot of and recall later. Adding a picture to reminders really 
helps them be even more vivid. 

Step 1 Step 1

Step 2 Step 2

Step 3 Step 3
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Click on the Notebook icon in the left sidebar. It’s the 
one that looks like a rectangular box with a circle in it.

Click on the white circle icon next to the Start button 
to activate Search and bring up the Cortana app 

panel. You’ll see Cortana’s usual selection of web news, calendar 
events and weather forecast.

Step 2Step 1

Windows has had a built-in search function for some time but 
like many other Windows features it’s seen some changes that 
haven’t always been an improvement. In Windows 7, the search 
function would prioritise results from documents found on your 
PC’s hard drive, which made it a great way to locate documents 
and files that you might have mislaid, or if you couldn’t 
remember the title of the document but could remember a 
snippet of the text. Since it would search all the drives attached 
to your PC, including cloud resources such as OneDrive and 
Dropbox, you could use it to locate multiple instances of the 
same document, or even find lines of text within documents.

In Windows 10 you’ll find the search tool at the bottom left of the 
task bar, next to the Start button. In the default setup it will be a 
white circle, which indicates that Cortana is active. To begin 
searching simply click on that circle and type your search terms 
into the text box at the bottom of the panel. Unfortunately that’s 
where the problem with the Windows 10 search function begins. 
By default the Cortana intelligent assistant will pre-empt your 
search and show you results from the Internet rather than from 
your own PC, and since by default Cortana uses Microsoft’s own 

Bing search engine the results are frequently not what you’re 
actually looking for. While this Cortana assisted search may 
possibly be helpful if you’re searching for information rather 
than a locally stored file, it can get annoying if you’re looking for 
a particular document and don’t really care what Cortana or 
Bing have to say about it. What might be really useful would be a 
way to make Cortana search only for things stored on your PC 
but unfortunately she can be a temperamental assistant and her 
settings sadly don’t include that option. Maybe a future update 
of Windows 10 will give her that functionality, but for now if you 
want to use local search only, I’m afraid you’ll have to do it 
without Cortana’s help.

Fortunately it’s a fairly simple process to set up the Windows 
Search system to only look for locally stored files and equally 
simple to set it back to the default settings afterwards, so if you 
find that you can’t live without Cortana’s sassy tones 
punctuating your working day you don’t have to say goodbye to 
her permanently. Here’s how to get Cortana to take a rest for a 
while and let you search for your lost files in peace.

Searching using Cortana is quick and easy to use but if you’re looking for a file on your computer, those web 
search results can get annoying. Here’s the solution: turn Cortana off. This may sound counterintuitive but it 
can really help, and it is easily reversible if you change your mind later. 

Set Search to Use 
Local Search Only

Searching Inside
Not only can restricting the search parameters help to improve the search results but it will also greatly speed up your searches. If 
you want to search online for something, you can still do so easily with Google. 
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Local Search

Now when you use Search you’ll have to type in what 
you’re looking for but it will only search for files and 

apps on your local hard drive rather than using Bing.

Flip the switch labelled “Search online and include 
web results” to off.

In the sidebar of the Search panel the notebook icon 
has now been replaced with a cog wheel icon for 

settings. Click on this to open the settings panel.

The Cortana panel will close as soon as you flip the 
switch and the circle icon in the Task Bar will be 

replaced with the more traditional magnifying glass of the Search 
function. Click on this now.

Flip the switch at the top of the panel labelled 
“Cortana can give you suggestions…” to off. This 

temporarily disables Cortana and clears what she’s learned on 
your computer, although things she’s stashed on the cloud will 
remain there.

In the Notebook panel click on Settings. You’ll see the 
rather limited settings panel for both Cortana and the 

Search function.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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Open Firefox and look at the main tool bar at the top 
of the screen. To the right of the address bar you’ll see 

a smaller window containing a magnifying glass icon and the word 
“Search”. Click on the icon.

If you’re not already using Firefox as your default 
web browser, visit www.mozilla.org, download and 

install it.

Step 2Step 1

One has to feel slightly sorry for Internet Explorer. Despite being 
the world’s most popular web browser for many years, it has 
always had a terrible reputation for being slow, unreliable,  
prone to virus infestation and riddled with more security leaks 
than a John Le Carré novel. Many Windows users routinely 
scrapped it in favour of third-party browsers such as Google 
Chrome or the popular Mozilla Firefox.

Bowing to popular pressure, Microsoft has finally sidelined the 
much reviled Internet Explorer and replaced it in Windows 10 
with a brand new web browser called Edge. It is unquestionably 
a massive improvement over its predecessor, featuring all the 
latest must have features such as multiple tabbed browsing, 
sandboxed tabs, better security and privacy controls and much 
faster page loading. Unfortunately old prejudices are slow to 
fade and a great many people still prefer the free and extremely 
popular Mozilla Firefox, mostly due to its speed, versatility, 
security and superior privacy controls. 

Similarly Microsoft’s proprietary search engine Bing is a pretty 
good way to find stuff on the Internet but the search results can 

sometimes be inaccurate or not entirely relevant and you 		
may not find what you’re looking for on the first try. There’s a 
reason why Google is the world’s most popular search engine. 
It’s faster, produces more accurate and relevant results and 
people are simply familiar with it and don’t like being forced 	
to change.

Unfortunately the Cortana intelligent assistant included with 
Windows 10 is a loyal acolyte of Bill Gates; she’ll even claim he’s 
her father if you ask her, which raises some worrying questions 
about his private life! It’s no surprise therefore that when you 	
ask Cortana a question that involves searching the Internet for 
information, by default she’ll open up an Edge browser window 
and show you search results provided by Bing in order to answer 
your query. If you’re used to browsing in Firefox and searching 
with Google it can be jarring and annoying to suddenly be 
presented with an unfamiliar environment, especially if the 
results aren’t what you were actually searching for. Most people 
would prefer to have their search results presented in a familiar 
environment and provided by a search engine that they know 
and trust.

By default the Cortana intelligent assistant will use Microsoft’s own Bing search engine to find search 
results on the Internet. This is fine if you use Edge but if you use Firefox or Chrome as your main browser, 
you may find it easier to make Cortana use their search engines instead.  

Make Cortana Use 
Firefox and Google

Change Search Engines
With a few simple tweaks you can get Cortana to use Firefox as her default web browser and use the Google search engine instead of 
the Microsoft approved alternatives. This is how it’s done.
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Cortana

Now when you use Cortana she’ll automatically use 
Google to search and if she wants to open a browser 

to display the results she’ll open Firefox to do it.

Towards the bottom of the screen you’ll see an 
entry for Web Browser. Click on it, and you’ll see a 

list of your available web browser apps. Click on Firefox to set it 
as the default.

Next we need to make Firefox the default web 
browser. Click on the Start button, open the Settings 

menu and click on System.

Under “Default search engine”, click to bring up the 
drop-down menu and select Google from the list of 

alternatives. Also check the box labelled “Use this search engine 
from Windows”.

In the sidebar menu on the left, click on the link for 
Default Apps. This is where you can select what apps 

Windows uses for particular tasks.

In the drop-down menu, click on the link at the 
bottom, “Change search settings”. This opens a new 

tab and takes you to a Firefox settings page.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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On the left side of the app’s panel you’ll see a row of 
oddly shaped icons. If you click on the three lines at the 

top left corner the sidebar will open revealing that they represent 
Home, Notebook, Reminders and Feedback. Click on Notebook.

Next to the Start button on the left of the Task Bar 
you’ll see an icon of a white circle. Click on this to 

open the Cortana search app. 

Step 2Step 1

If you’ve seen the 2013 science fiction movie Her, in which 
Scarlett Johansson provides the seductive voice and personality 
of Joaquin Phoenix’s amazing artificially intelligent operating 
system, you’ll have a pretty clear idea of the way that computer 
interaction is going. While we may be some years, or more likely 
decades, away from the advanced AI depicted in that film, we 
already have artificial intelligence (AI) systems that can learn 
from you, reliably recognise your speech patterns and respond 
to your questions with appropriate spoken replies that sound 
human. As a Windows 10 user you already have an AI personality 
at your disposal in the form of Cortana, the Windows Intelligent 
Personal Assistant. 

Intelligent Personal Assistants are very much the wave of the 
future and are becoming more powerful all the time. The best 
known is probably Siri, the digital voice of Apple’s iPhone but 
there are plenty of other examples, including Google Now on 
Android devices, Blackberry’s Assistant, Samsung’s S Voice and 
the open source Mycroft app. Naturally Microsoft had to have 
one of its own and so Windows 10 features Cortana, an 
Intelligent Personal Assistant that can help you to search for  

files or apps on your system, as well as finding information on 
the Internet. 

Cortana takes her name from the Artificial Intelligence character 
in the popular Halo combat game series, made by Bungie Inc., 
that has been a massive hit on the Xbox games console, and she 
is even voiced by Jen Taylor, the same actress who provides the 
voice of Cortana in the game. If you have a microphone attached 
to your system, you can ask Cortana questions in a normal 
speaking voice and she will attempt to find the answer for you. 
She will reply to your queries in a pleasant mid Atlantic voice 
that seems to have real personality behind it and while a love 
affair is probably asking a bit much she does make for an 
entertaining companion.

The more you use Cortana, the better she becomes at 
understanding your speech and the more she learns about you 
and your personal preferences; this includes your web browsing 
history and personal calendar and contacts, which are uploaded 
into cloud storage. This has led some people to object, citing 
worrying issues about privacy and personal data security. 

Cortana will provide some services straight after you initially set up your Windows 10 computer. If, however, 
you want to take full advantage of everything she has to offer, you will need to do a bit of additional 
tinkering. Cortana can be a powerful tool, so why not make the best use of her.

Set Up Cortana 
Voice Search

Talk to Cortana
There are some concerns about Microsoft listening to you all the time but if you’re happy to have Cortana hanging on your every 
word, this is how to set up voice searching on your PC. 
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Cortana

To set up voice search, scroll down a little and flip the 
switch labelled “Hey Cortana”. This sets Cortana to 

continually listen for your voice and respond when you say “Hey 
Cortana” into your microphone.

To set up voice search, click on Settings. If Cortana is 
currently turned off, toggle the topmost switch to turn 

her back on.

In order to respond accurately to your voice, Cortana 
will first have to learn to recognise how you say certain 

words. Scroll down a little further and you’ll see a button labelled 
“Learn my voice”. Click on this.

Once you’ve let Cortana listen to you she should be 
able to understand simple questions and provide 

useful answers. The more that you use her, the better she should 
get at recognising your voice.

Cortana will now ask you so say six phrases, which 
contain common words used in searches. Make sure 

there’s no background noise and speak clearly into your 
microphone using your normal speaking voice.

Try Cortana on a few simple questions, such as “What 
is tomorrow’s weather forecast?” For more amusing 

answers try “How intelligent are you?”, “How did you get your 
name?” or even “Who is Siri?” Just don’t ask her to tell you a joke, 
they’re all pretty terrible!

Step 4

Step 3

Step 5

Step 7

Step 6

Step 8
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On the Settings screen, under the heading “Cortana 
can give you suggestions, ideas, reminders alerts and 

more”, flip the slider switch to turn Cortana off.

Open Cortana by clicking on the Task Bar icon and 
then click on the notebook icon in the left-hand 

sidebar of the Cortana screen.

Step 2Step 1

Cortana is one of the flagship features of Windows 10 and can 
certainly be a useful assistant, helping you with Internet 
searches, finding routes, setting reminders and even telling 
terrible jokes. However she does store a lot of information about 
you both on your local PC and more importantly on the cloud 
and some of that data is shared with Microsoft for data analysis 
purposes. Among the personal information stored is your 
Internet search history and locations that you’ve saved and 
obviously that’s a cause for concern. Given the recent history of 
data security breaches at major companies, including a data 
leak from Microsoft’s own cloud services, a lot of people are 

wary of the way that Cortana collects, stores and shares 
information, citing very justifiable concerns about privacy and 
the security of their personal data. If you’re not happy to share 
your life with Cortana and don’t want her listening to your every 
word, by far the easiest way to opt out is to never activate 
Cortana in the first place, by clicking on the “Not interested” 
button during the Windows 10 installation process. However if 
you’ve installed Cortana and have interacted with her, you can 
still shut her down and delete the stored online information that 
she’s collected about you. Here’s how you do that:

The privacy of your personal information is a major issue, so if you’re not happy with the idea of Cortana 
constantly monitoring your everyday activities, this is how to put a stop to it. Be aware that some of these 
tips will reduce the number of ways you can use Cortana with Windows 10. 

Disable the 
Cortana Assistant
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Cortana

That’s it, you’ve now disabled Cortana and your 
personal information is a bit more secure. You can still 

use the built-in Windows Search function but Cortana will no longer 
be listening. If you miss her and want her back, you can re-activate 
her at any time.

Go back to the main settings page and scroll down to 
the bottom, where you’ll find a button labelled Clear. 

This will delete all the information that Cortana has saved about 
you. Click it and then confirm your choice on the pop-up window.

Here you’ll see all the questions that you’ve asked 
Cortana. You can delete individual entries by clicking 

the X next to each one or delete everything by clicking on the Clear 
All link in the upper right of the page.

Under the Search History category, click on the link to 
go to your Search History page.

You default web browser will open and display the 
Bing Personalisation settings page. Here you’ll find 

links to your saved places and more importantly your internet 
search history, which stores all the questions you’ve put to Cortana.

To delete everything Cortana has learned about you, 
click on the link “Manage what Cortana knows about 

me in the cloud”.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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The Action Centre sidebar will open, showing all 
your recent Notifications, as well as a panel of 

buttons at the bottom of the screen. Click on All Settings to open 
the Settings screen.

To view your recent Notifications, click on the Action 
Centre icon in the System Tray area of the Task Bar, at 

the bottom right of the screen. It’s the one that looks like a 
rectangular speech bubble.

Step 2Step 1

It’s a feature of modern life in the digital age that we don’t have 
to remember things anymore. Just a decade or so ago we used 
to have to remember dozens of phone numbers but with mobile 
phones now storing all our contacts we’re lucky if we can 
remember our own number. We used to have to remember facts 
but today we have Wikipedia constantly at our fingertips. We 
used to have to remember appointments and tie a knot in a 
hanky to remember to buy a pint of milk but these days we have 
Notifications to remind us of everything. These changes in the 
ways that we find and use knowledge is actually changing the 
ways that our brains work; as we rely more on machines to store 
and recall everyday information, our memories are becoming 
less efficient, although our critical faculties may be improving to 
help us weed out false information. Whether this is a good thing 
or not, only time will tell.

Notifications have become an everyday fact of life for anyone 
who uses a smartphone, tablet or personal computer. All 
through the day you’ll hear that insistent little “ping” that lets 

you know that you’ve received an email, or one of your friends 
has posted another cat picture on Facebook and that you’ve 
only got 15 minutes to get to the dentist. While they can certainly 
be useful for anyone trying to juggle a job, family and busy social 
life, if you don’t manage your notifications you’ll never get a 
moment’s peace. The same is true of Windows Notifications; if 
you don’t set them up properly you’ll be constantly notified 
about things that you just don’t need to know about.

First introduced with Windows 8, Notifications are the messages 
that pop up in the bottom right-hand corner of your screen, 
reminding you of calendar events, letting you know that you’ve 
got emails and generally keeping you informed about what’s 
going on with your life and your computer. There’s no doubt that 
Notifications are useful, especially when they remind you of a 
forgotten appointment or signal the arrival of an important 
email. However if you don’t take a firm hand with them you can 
be overwhelmed with pop-up messages about trivial Twitter 
posts or friends’ Facebook status updates.

If you’ve used a modern smartphone, you’ll be all too familiar with Notifications, those urgent little 
messages that tell you something has just happened. Windows 10 seems to have embraced notifications in 
a much bigger way than older versions. This is how to manage those popups. 

Managing Your 
Notifications

Notification Settings
In Windows 10 you can choose what sort of Notifications you receive and even decide which apps can post Notifications and what 
type of Notifications each app can use. Read on to find out how you can manage your notifications.



115BDM’s: Advanced Guide to Windows 10

Notifications

If you just want to see important Notifications, try 
setting everything except Mail, Calendar, News and 

Windows Explorer to off.

Scroll down further and you’ll find a list of installed 
apps that can send Notifications, each one with a 

switch. To disable Notifications from individual apps, flip that app’s 
switch to off.

If you don’t want any of your installed apps to be 
able to send you Notifications, set the switch for 

“Show app notifications” to off. You can also turn off “Show me 
tips about Windows”.

Under the Notifications header you’ll see a row of 
five switches controlling general Notifications 

options. By default they’re all set to on except “Hide notifications 
while presenting”. 

On the Settings screen, click on System and then in 
the sidebar menu on the left of the System screen, 

click on Notifications & Actions.

If you click on the list entry for a particular app you see 
further options, allowing you to turn off Notifications 

for that app, just turn off the on screen banner notifications and 
also toggle whether the notification plays a sound.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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Click on the Start button and open the Settings menu. 
Click on System and then select Notifications & Actions. 

At the top of the page you’ll see a row of four icons. These are the 
four actions that appear in the top row of the Quick Actions panel.

Step 2Press Windows + A, or click on the Notifications icon in 
the system tray to open the Notifications & Actions 

panel. You’ll see a row of four Quick Actions buttons at the bottom. 
If you click on the Expand link, you’ll see several more.

Step 1

The Quick Actions panel is one of the many hidden little features 
of Windows 10 that would probably get a lot more use if only 
more people knew about it. You’ll find in at the bottom of the 
Notifications & Actions panel, which you can open by clicking 
the icon that looks like a rectangular speech bubble in your 
system tray, in the bottom right corner of your desktop screen. 
Alternatively you can open the Notifications & Actions panel 
using a keyboard shortcut, Windows key + A.

At the bottom of the panel you’ll see a row of four buttons. 
Depending on whether you’re using a laptop, a tablet or a 
deskbound PC, these buttons may include wireless connection, 
battery saver mode, screen brightness, airplane mode, notes, 
quiet hours or tablet mode, the settings menu, as well as several 
other options. As the name suggests these Quick Action buttons 
provide instant access to these features and once you start using 
regularly them you’ll find they’re actually a very useful feature.

If you’re using a desktop machine you’ll probably be thinking 
that this is just another way of accessing things you can already 
find easily by using the Settings menu or control panel, and 

you’d be correct but the format is a lot more accessible if you’re 
using a tablet or a laptop with a touchscreen. On touch enabled 
systems you can access the Notifications & Actions panel by 
simply swiping in from the right-hand edge of the screen and the 
Quick Actions buttons are ideally sized to be easy to hit with a 
finger. If you’re a tablet user, once you get used to using them 
you’ll wonder how you ever managed without them. You can  
use them to quickly access settings, Wi-Fi connections, set up 
your locations options, jot down quick notes, set up Quiet   
Hours times and even log on to your company’s VPN if you have 
one. For touchscreen users, especially in a professional 
environment, there’s no doubt that Quick Actions are a 
potentially useful feature.

The most useful part about it is that you can configure which 
buttons appear in the top row of the Quick Actions panel and in 
which order they appear, yet another way that Windows 10 lets 
you set things up your way. If you think this might be something 
that you’d use more often, if only it was set up correctly, we’ll 
show you how to configure the Quick Actions buttons to 
streamline your Windows experience.

Although it can also be used on a standard PC, if you’re using Windows 10 on a device with a touchscreen, 
you’ll find that the Quick Actions panel is a particularly useful additional feature. It makes your Windows 10 
touchscreen device feel much more like a smartphone or tablet. 

Set Up the            
Quick Actions Panel

Quick Actions Panel
The Quick Actions Panel is one of those tools that you will begin to use more and more over time; and the more you use it, the more 
you will realise how useful it really is. Let’s take a look at getting it set up correctly. 
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Quick Actions

Choose the first quick action from the list, then move 
on to the second, third and fourth. The remaining 

icons will be relegated to the lower rows of the Quick Actions panel, 
invisible in collapsed mode.

Step 4Click on the first icon and you’ll see a pop-up menu 
with the list of available Quick Action icons. Desktop 

users with LAN connections will only see six or seven, laptop and 
tablet users will see up to a dozen.

Step 3

Go through the list, and select which ones you’d like to 
see appearing in the bottom right of your Task Bar. 

We’d suggest that safely remove hardware, your anti-virus app and 
your cloud storage service are all useful, as well as the default 
network connection and volume icons.

Step 2Click on the link “Select which icons appear on the 
taskbar”. It will show you a list of the apps that can 

present System Tray icons for quick access. 

Step 1

Whilst we have this settings page open, we can quickly take a look at the system tray taskbar icons option. As the name suggests, 
here you can choose the icons that are shown in the Windows 10 taskbar.

Select Your System Tray Icons

The System Tray is an area on the right-hand end of the task bar, in the 
bottom right of your computer screen. It has been part of the Windows 
desktop interface since Windows 95 and makes a welcome return in Windows 
10. It is an often overlooked area and many users won’t even know it’s there, 
since by default it only displays the system clock, your connection status, the 
volume control and the Notifications & Actions panel icon. However it can be 

used to display a lot of useful extra system information, such as the status of 
your anti-virus software, USB quick eject options, links to cloud storage, 
graphics card and audio equipment drivers, location information, keyboard 
input and language options, email notifications and more; depending on 
what apps you have installed. Let’s take a look at this often neglected area 
and show you how to get more out of it.
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Using the Touchpad
Depending on the device that you are using, and whether all of the gestures have been enabled, you might not have access to all of 
these gestures. Some might also need to be configured before use.

Place two fingers on the touchpad and 
slide horizontally. This gesture will 

work in any app that allows horizontal scrolling, such as the 
Internet browser.

Place two fingers on the touchpad and 
slide vertically. This gesture is useful for 

scrolling down through web pages or when reading long text 
documents such as Word docs.

Horizontal Scroll

Vertical ScrollTap the touchpad with one finger when over the 
item you want to select. You can also tap twice 

to select items that need a double-click. 

Select Item

TOUCHPAD SETTINGS
Windows 10 contains some basic touchpad settings when used 
on a laptop but you may also need to get into the hardware 
settings for your particular laptop. You can usually find this in 
the taskbar menu. If not, use the universal search to find 
“Touch Pad Settings” and click on “Additional Settings”. 

Even if you are used to controlling your laptop with the touchpad, it can be some time before it feels as 
familiar as using a traditional mouse. Luckily Windows 10 allows for several very useful touchpad 
gestures that, when combined with hotkeys, make using a laptop much easier. 

Touchpad Gestures 
and Hotkeys
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Touchpad

Place three fingers on the touchpad and 
swipe right or left. Requires precision 

touchpad. You can also switch between open windows easily by 
holding Alt and tapping Tab.

Switch Windows

Place three fingers on the touchpad and 
swipe them towards yourself. Again, this 

requires a precision touchpad to work. This can also be achieved by 
pressing Windows Key + D.

Show Desktop

Place three fingers on the touchpad and swipe 
them away from you. This is one of the new 

gestures that may not work on your device if it does not have a 
precision touchpad.

Task View

Tap the touchpad with two fingers or press 
in the bottom right corner. This gesture 

results in the same as right-clicking with a traditional mouse, 
usually opening a contextual menu.

Context Menu 

Place two fingers on the touchpad and spread 
out diagonally. When you change zoom in a 

browser, a pop-up will usually appear as you zoom, showing you 
the change from the default 100%. 

Zoom Out

Place two fingers on the touchpad and pinch in 
diagonally. This gesture will be familiar to anyone 

who uses a smartphone or tablet. Can be used in several core apps, 
including Photos. 

Zoom In 
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NEW WINDOWS HOTKEYS

Windows key + A: Open Action centre
Windows key‌ + S: Open search
Windows key‌ + C: Open Cortana in listening mode
Windows key + I: Opens the new Windows 10 Settings menu.
Windows key + X: Opens a system context menu.
Windows key + H: Open the Share charm
Windows key + T: Cycle through apps on the taskbar 
Windows logo key + comma: Peek at the desktop 
Windows key‌ + Tab: Open Task view
Windows key + Ctrl + D: Add a virtual desktop
Windows key + Ctrl + Right Arrow: Switch to virtual desktop on 
the right
Windows key + Ctrl + Left Arrow: Switch to virtual desktop on 
the left
Windows key + Ctrl + F4: Close the virtual desktop 
you’re using

Basic Hotkeys

Typing Hotkeys

Snap Hotkeys

Ctrl+C : Copy the selected item
Ctrl+X : Cut the selected item
Ctrl+V : Paste the selected item
Ctrl+Z : Undo an action
Alt+Tab : Switch between open apps
Alt+F4 : Close an active item, or exit an app
Windows key + L : Lock your PC or switch accounts
Windows key + D : Display and hide the desktop
Shift+Delete : Delete item without moving to Recycle Bin

Ctrl + C : Copy the selected item
Ctrl + D : Delete the selected item and move it to the Recycle Bin
Ctrl + R : Refresh the active window
Ctrl + V : Paste the selected item
Ctrl + Y : Redo an action
Ctrl + Z : Undo an action
Ctrl + Right arrow : Move the cursor to the beginning of the 		
next word
Ctrl + Left arrow : Move the cursor to the beginning of the 		
previous word
Ctrl + Down arrow : Move the cursor to the beginning of the		
next paragraph
Ctrl + Up arrow : Move the cursor to the beginning of the 	
previous paragraph
Ctrl + Shift with an arrow key : Select a block of text

Windows key + Up Arrow : Maximize current window
Windows key + Down Arrow : Restores window size
Windows key + Left Arrow : Snaps current window to the left
Windows key + Right Arrow : Snaps current window to the right
Windows key + 2 Arrow Keys : Snaps current window into 
one corner 

Many users know basic Hotkey combinations, such as Ctrl + C and Alt + Tab but there are literally 
hundreds more to learn. These let you do everything from Snap windows left or right, to switching 
between Virtual Desktops. Here are some of the most useful Hotkeys for everyday use.

Windows 10 
Hotkeys
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Hotkeys

DESKTOP HOTKEYS
Windows key + Home: Minimise all but the active 
desktop window
Windows key + Shift+Up arrow: Stretch the desktop window 
to the top and bottom of the screen
Windows key + Shift+Down arrow: Restore desktop windows 
vertically, maintaining width
Windows key + Shift + L arrow or R arrow: Move window 
from one monitor to another
Windows key + Spacebar: Switch input language and 
keyboard layout
Windows key + Ctrl + Spacebar: Change to a previously 
selected input
Windows key + Enter: Open Narrator
Windows key + forward slash: Initiate IME reconversion
Windows key + plus or minus: Zoom in or out using Magnifier
Windows key + Esc: Exit Magnifier

File Explorer Shortcuts

Taskbar Hotkeys

Dialog Box Shortcuts 

File Explorer is your main interface for organising the files 
you store on your PC. Here are some useful shortcuts to speed 
up operations.

Alt + D : Selects the address bar 
Ctrl + E and Ctrl + F : Select the search box 
Ctrl + N : Open a new window 
Ctrl + W : Close the current window 
Ctrl + mouse scroll wheel : Toggles through folder size and 
layout options 
Ctrl + Shift + E : Display all the folders above the selected folder 
Ctrl + Shift + N : Create a new folder 
Num Lock + asterisk (*) : Display all sub-folders under the 	
selected folder 
Num Lock + plus (+) : Display the contents of the selected folder 
Num Lock + minus (-) : Collapse the selected folder 
Alt + P : Display the preview pane 
Alt + Enter : Opens the Properties dialogue box 
Alt + Right arrow : View the next folder 
Alt + Up arrow : View the folder in which the current folder 
is contained 
Alt + Left arrow or Backspace : View the previous folder 
Right arrow : Display the current or select the first sub-folder 
Left arrow : Collapse the current selection or select the folder it 
was in 
End key : Display the bottom of the active window 
Home key : Display the top of the active window 
F11 : Maximise or minimise the active window 

Shift + click a taskbar button : Open an app or quickly open another 
instance of an app
Ctrl + Shift + click a taskbar button : Open an app as an administrator
Shift + right-click a taskbar button : Show the window menu for the 
app
Shift + right-click a grouped taskbar button : Show the window menu 
for the group
Ctrl + click a grouped taskbar button : Cycle through the windows of 
the group

Sometimes you may need to open and use a Windows dialog 
box when you don’t have access to the mouse or trackpad. For 
these times there are keyboard shortcuts to help.

Ctrl + Tab : Move to the right through tabs 
Ctrl + Shift + Tab : Move to the left through tabs 
Ctrl + number (1-9) : Move to the corresponding tab 
Tab : Move forward through the dialogue options 
Shift + Tab : Move backwards through the options 
Alt + underlined letter : Perform the command corresponding to 
that letter 
Spacebar : Select or clear a checkbox Arrow keys: Select a button
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Click on the folder name and highlight it. You need 
to replace the name of the folder to activate the 

special mode.

Go to your desktop and right-click anywhere on the 
screen. In the pop-up menu, mouse over New and 

from the sub-menu select Folder.

Step 2Step 1

While the availability of plentiful customisation options is one of 
the many ways in which Windows 10 improves over its 
predecessors, it is nevertheless rather annoying that those 
options, as well as the many settings used to optimise the 
performance of your system, are divided arbitrarily between the 
new Settings menu and the more familiar Control Panel. Some 
settings such as personalisation settings and Windows Update 
can be found only in the Settings menu, while others such as the 
Device Manager and advanced power options are still mostly 
accessed through the Control Panel. Some settings, such as 
Windows Defender and the language and localisation options, 
are inexplicably spilt between the two locations. It can all be a 
bit confusing to say the least.

The only reasonable explanation is that the Settings menu was 
designed, like Windows 8, to be more accessible for users with 
touch-screen systems. However one would have thought that 
the hugely negative response to Windows 8 and the subsequent 
rethink that has led to the more keyboard friendly Windows 10, 
would mean that Microsoft’s interface design team would make 
the settings more adaptable too. Apparently that department 
didn’t get the memo though, so for now at least we’re stuck with 
this bizarre two tier system.

If you’re tired of switching back and forth between the Settings 
menu and the Control Panel searching for a particular setting, 
you’ll be happy to learn that there is a way to access all settings 
and controls in one place. It’s a secret hidden control panel 
known as GodMode, a dedicated folder that lets you access all 
the vital settings, obscure sub-menus and hidden control panels 
that Windows has to offers, all in one handy list. Using the 
GodMode menu you can do everything from adding clocks for 
different time zones to defragmenting your drives without ever 
having to search through the Settings page or Control Panel. Like 
us you’ll probably be wondering why something so useful isn’t a 
standard feature; don’t worry because it’s surprisingly easy to 
set up.

Some users with deeply held religious beliefs have expressed 
concern over the name “GodMode”. Far be it from us to comment 
on the Almighty’s choice of operating system (probably Unix) but 
if the name is a problem for you, please note that in step 3 you 
can replace the phrase “GodMode” in the text string with 
anything you like as long as it has no spaces and you follow it 
with a full stop. The new phrase you choose will become the 
name of the folder.

For some strange reason, Windows 10 has split the system settings and options controls over two different 
locations. Wouldn’t it be great if you could access all of Windows 10’s controls all in one place? Well, you can, 
by activating this secret hidden control panel.

Enable the 
GodMode Folder

Easier Windows 10 Settings
Although it isn’t really that difficult to remember how to access the two different sides of the Windows 10 settings, it can sometimes 
make simple tasks take longer than needed. Having everything in one place makes sense. 
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GodMode

If you don’t want to use the GodMode panel any 
more, simply delete the folder. You can re-create it at 

any time by following steps 1-3.

To use a GodMode setting or option, double-click on it 
in the GodMode list. Most of the settings can be 

accessed normally via the Control Panel or settings but here you 
have every sub-option in one list.

Double click on the new icon to see the GodMode 
control panel. It’s a huge list of settings and options 

divided into categories such as Administrative tools, Colour 
management, User Accounts and more, letting you customise every 
aspect of Windows.

As soon as you replace the folder’s name, you’ll see 
the folder icon change to a blue Control Panel icon.

Note the full-stop between the word GodMode and 
the first bracket. You can replace the word GodMode 

with any other text you like, as long as the full-stop remains.

Type this exact string of characters, including the 
full-stop and brackets, in place of the folder name: 

GodMode.{ED7BA470-8E54-465E-825C-99712043E01C}

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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Step 1

Step 2

Step 3

Step 4 Right-click on the shortcut and select Properties; click 
on the shortcut tab and then click on the Change Icon 

button. In the icon palette that appears, select the icon shown 
below. Also in the right-click menu, click on Pin to taskbar and then 
drag it into position next to the Start button.

Click Next and type the name “Show Desktop” into the 
text box in the second dialogue window. Click Finish.

A dialogue window will appear, asking you to type in 
the location that the shortcut will point to. Type this 

exact string of characters, including the three colons, into the text 
box: explorer.exe shell:::{3080F90D-D7AD-11D9-BD98-0000947B0257}

Right-click anywhere on the Desktop and from the 
pop-up menu select New, and then Shortcut.

The Windows Taskbar
Older versions of Windows had a button on the taskbar that would instantly minimise or hide all open windows and show you the 
full desktop. Here’s how to add just such a button to Windows 10. 

Windows 10 is one of the most customisable versions of the OS, if you know the ins and outs. Do you miss 
that old Show Desktop button from Windows XP? Luckily for you there’s a way to add a button with exactly 
the same functionality and even the same icon to Windows 10.

Put a Desktop Link 
on the Taskbar
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Step 1

Step 2

Step 3

Step 4 Now when you type a search term or web address into 
this new text window, your default browser will 

automatically open to the website or search results.

Click in the check box next to Address and then click 
on Apply. You’ll see the web search bar appear on the 

right-hand side of the taskbar.

In the Properties window click on the Toolbars tab. 
You’ll see a list of options for toolbars that can be 

added to the taskbar.

Right-click anywhere on the taskbar and then select 
Properties from the pop-up menu. 

Adding a Search Bar
Luckily for you there is a simple method to put a web search bar right on the taskbar. It’s a Bing search bar and there’s no easy way to 
change that but it’s still a useful feature. Here’s how to do it.

If you’ve disabled Cortana and restricted the Windows search function to local results only, you may want 
to put a web search bar on the taskbar to replace it. This is a fairly simple task, as long as you understand 
how the taskbar works, and how Windows 10 interacts with it. 

Put a Web Search Bar 
on the Taskbar
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If there’s an entire category of settings that you go to 
frequently, you can pin them to the Start menu en 

masse. Right-click on the category button on the Settings screen 
and you’ll see the option “Pin to Start”. Click this to pin the entire 
category to the Start menu.

Click on the Start button and then click on Settings to 
open the Settings screen.

Step 2Step 1

While many users apparently considered the Windows 8 Start 
screen to be the worst thing since the Star Wars prequels, even 
the harshest critics would have to admit that it did have one or 
two extremely useful features. One that was particularly handy 
was the ability to pin apps and settings to the Start screen, move 
them around and sort them into labelled groups, which meant 
that the Start screen could serve as the launch pad for your 
entire Windows experience, just as it was intended to be.

When Windows 10 was first announced in late 2014, the “new” 
feature that attracted the most publicity, at least among that 
section of the computer press that likes to believe that their 
opinions carry some weight, was the welcome return of the Start 
button and the Start menu. It was immediately hailed as a major 
improvement over the reviled Windows 8 Start screen and a 
triumph of people power over the corporate domination of 
Microsoft. However in reality this was just a bit of marketing 
hype to try to appease the critics because the Windows 10 Start 
menu is essentially just the same as the Windows 8 Start screen, 
cosmetically redesigned and with a few extra features attached 
to make it look a bit like the Start menu from Windows 7. It still 

retains most of that Start screen functionality from Windows 8, 
specifically its role in customising your desktop experience. It 
still uses the same tiles and you can still customise it to suit your 
own needs.
The Windows 10 Start menu features the ability to resize and 
organise tiles to suit your needs; it has live tiles that can keep 
you informed about breaking news, weather forecasts, emails 
and social media updates and of course you can pin shortcuts to 
apps, web pages and system settings to it for fast and 
convenient access. Just as Windows 8 did, Windows 10 makes 
the Start menu the centre of the system. Whatever your opinion 
of the tile based interface of the Start menu, there’s no     
denying that it’s an effective way to use, store and organise   
such shortcuts.

Of course if you really hate the whole tile interface concept and 
don’t want be reminded of Windows 8 ever again, you can 
always just un-pin all the tiles, leaving you with just the basic 
sidebar links but that sounds a lot like cutting off your nose to 
spite your face. You’d probably be better off reverting to 
Windows 7.

One of the best and most useful features of the new Windows 10 Start menu is the ability to pin shortcuts to 
your most frequently used settings to it as tiles. This seemingly very simple trick can really make using your 
PC easier and faster on a daily basis, which can only be a good thing. 

Pin Settings to 
the Start Menu

Pinning and Unpinning
Following this guide, you can build what is effectively your own customised settings panel, made up of items that are usually 
scattered between the Settings screen and the Control Panel. This is how you do it.
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Pin Settings

Now open your Start menu and rearrange the new 
tiles to make them easy to find and access and if 

necessary label the group.

Right-click on the icon of the setting you’re looking 
for and select “Pin to Start” from the pop-up menu. 

Note however that not all Control Panel settings can be pinned in 
this way.

In the upper right corner of the Control Panel you’ll see 
a drop-down menu labelled “View by:” Click on this 

and select either of the icon views.

To pin Control Panel settings to the Start meu, first 
right-click on the Start button and select Control Panel 

from the power menu.

Right-click on the sidebar menu option of the setting 
you’re looking for. Again you’ll see the option “Pin to 

Start”, so click on this and pin that setting to the Start menu.

To pin individual settings options to the Start menu, 
click on a settings category to go to the settings menu. 

Choose the individual setting from the sidebar menu on the left of 
the screen.

Step 8

Step 7

Step 6

Step 5

Step 4

Step 3
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As well as Edge’s main controls on the top 
left there are other items on the top right 

including the main menu to access more options. This is the 
ellipsis (…) icon in the top right. From the main menu you can 
open a new window or a new InPrivate window as well as zoom 
into the current page.

Into the Menu

Although it’s planning to, 
Microsoft hasn’t yet 

added Extensions to Microsoft Edge. Extensions are third-party 
applications you can add to your browser to perform extra 
functions. If you’ve used Google Chrome or Mozilla Firefox, you’ll be 
familiar with Extensions from those browsers. Internet Explorer 
never had the ability to add Extensions, sometimes known as 
add-ons. 

Not Everything is There Yet

If you’re familiar with almost any modern 
browser then you’ll be instantly at home. 

The forward/back/refresh panel is almost identical to other 
browsers. The security padlock also resides in the same place. The 
default new tab page shows you your most visited sites, but you can 
have news from MSN appear instead. This is actually quite 
compelling, as you get an instant snapshot of what’s going on. 

Basic Controls

Microsoft Edge carries on Internet Explorer’s use of 
a stylised ‘e’ as its logo. This is to make things 

simple for users who are familiar with Internet Explorer. As with 
Windows 8, Windows 10 uses ‘flat’ design and Edge is no different, 
with a minimalistic appearance designed to make controls stand out. 

New Logo

Edge is fast and fluid and we think you’ll like it. It may not have the capability of Chrome or Firefox as yet but for basic web browsing 
it’s almost perfect. Before you choose an alternative, why not see what Edge can offer?

Meet Your New Browser

There’s a brand new browser in Windows 10 – Microsoft Edge. It’s focused on modern web standards and 
is fast. It also boasts several innovative features, such as the ability to highlight parts of web pages and 
share them. 

Mastering 
Microsoft Edge
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Microsoft Edge

In the top right of the sidebar there’s a 
pin to keep the sidebar open, rather 

than just temporarily. You can move easily between your Reading 
List, Favourites, Downloads and History; just use the icons at the top 
of the bar to select the one you need.

Cycling Through

Again in the top right, the ≡ icon 
launches the sidebar featuring your 

Reading List, Favourites, Downloads and History. If you’ve used 
Internet Explorer recently at all, this sidebar will be familiar to you as 
it’s basically the same interface element. There is, however, a new 
Reading List. 

The Main Sidebar

Microsoft Edge is set to use Bing as its 
default search engine, but you can 

change search provider in the Advanced Settings menu. As you 
type into Edge’s search box, the browser will recommend search 
suggestions; you can turn this off here should you want to (we find 
it quite useful).

Change Search

The basic Settings menu is 
pretty lean on options. An 

Advanced Settings button at the bottom takes you into another 
menu with further options. This part of Edge is for more advanced 
users and it covers privacy, such as enabling browser cookies and 
other security settings.

Going Beyond the Basics

As well as the ‘light’ default theme of 
Microsoft Edge, there’s an option in 

Settings to display a black theme. It’s becoming a lot more common 
for applications to have ‘dark’ themes, and the Windows 10 taskbar 
is dark too. It’s a good alternative to having super bright apps. 

Change the Theme

From this menu you’re also able to 
access Settings too, as well as Print 

and Find to locate a word or phrase in the open web page. Another 
option enables you to pin a particular web page to the Start menu 
as a tile should you wish to. 

Accessing Settings
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Microsoft Edge

Microsoft Edge also includes a Reading View 
– this enables you to remove the clutter on 

web pages to just display the main text. When you’re reading longer 
web pages, Reading mode ensures you don’t see any of the adverts 
or anything else that may distract you. Images are still shown. 

Reading View

Within the History view, you can select any 
historical page or clear your History 

completely. If you don’t want pages to be recorded into your 
History, you need to select InPrivate browsing from the main menu. 
This will then open a new window and no data is preserved from 
that session. 

Your History

One of the folders is called Favourites Bar. 
This is a bar you can toggle on and off to 

permanently display certain Favourites (included in the Favourites 
bar folder) in a strip underneath the address bar. To enable this 
feature, go to Settings via the main menu and switch the Favourites 
bar on using the toggle.

Favourites Bar

You can also drag and rearrange 
Favourites within the main sidebar. 

You can right-click on any entry in Favourites to bring up extra 
options, including opening the page in question in a new tab, 
creating a new folder that you can then drag Favourites into or 
renaming or removing the item.

Add and Rearrange

When you add a new Favourite or 
Reading List item, you can change the 

information you store about that particular item. You can edit the 
entry in the pop-up that appears after you click the star icon. You’re 
able to give it a new name as well as add it to a folder.  To finish, 
click Add. 

Renaming Items

As in Internet Explorer, you click the 
star next to the address bar to 

Favourite a page. In Edge, the difference is that you’re now also 
offered the ability to add to your Reading List. Your Reading List is a 
great place to store more in-depth articles that you wish to return to 
later. 

Adding to Your Lists
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Microsoft Edge

As Edge is intended for 
use with new web 

technologies, Microsoft has still bundled Internet Explorer with 
Windows 10 in case you need it (a lot of businesses will for use with 
old applications). If you hit a page which Edge doesn’t like, it offers 
you Internet Explorer instead.  

Internet Explorer Isn’t Gone

Microsoft’s virtual assistant Cortana is 
also incorporated within Microsoft Edge. 

If you highlight some text and right-click, you can select Ask 
Cortana. This launches a sidebar and gives you an instant web 
search. You can then click through to other results, such as a 
Wikipedia page. 

Cortana in Edge

You can save, share or exit from the options 
shown in the top right of this mode. Your 

annotations can easily be shared to OneNote, which has a newly 
redesigned app in Windows 10 – just click the Share button. You can 
always share via email with a colleague or friend and there’s always 
the fallback option of a screenshot.

Sharing Pages

Making notes on web pages and 
sharing the results is one of Edge’s 

best new features. Launch this mode using the Edit-style button 
next to the sidebar control in the top right of the main window. The 
editing controls include a pen, a highlighter, an erase function, an 
annotation feature and a copy tool that enables you to copy an area 
of a web page.

Annotating Pages

To enter Reading mode, you 
need to be looking at an 

article online – so not a home page such as msn.co.uk or Microsoft.
com. The book icon next to the address bar will turn black (rather 
than being greyed out). Click it and the article will be put into 
Reading mode. The icon turns blue when Reading mode is active. 

Selecting Reading Mode

You can fine-tune how the 
Reading mode looks in Settings 

– here we’ve selected dark for the background, but you can opt for 
several different shades. You’re also able to change the size of the 
text. Reading mode may not be for everybody, but it will be 
especially useful for those using Windows 10 on a tablet. 

Change How You Read
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Step 2 Step 4At the top of the Hub sidebar you’ll see four more 
buttons. Click on the third from left, which looks like a 

clock face with an arrow around it. This will give you access to your 
browsing history on this computer. 

If you want to delete your entire history, click on the 
“Clear all history” link at the top of the screen. You’ll 

get the option to delete your browsing history, as well as cookies, 
saved website data, any cached data; and also downloads, form 
data and saved passwords.

Your browsing history shows all webpages visited over a set period. There are many reasons why you might want to delete your 
browsing history and some of them aren’t even all that embarrassing.

Delete Your Browsing History

Step 1 Step 3In the upper right corner of the main Edge screen you’ll 
see a row of buttons. The one which looks like three 

horizontal lines is the Hub button. Click on this to see your favourites, 
reading list, downloads and browsing history.

You’ll see your complete web browsing history listed, 
divided into different time periods, such as last hour, 

yesterday and more. You can delete an entire period by clicking the 
X next to it, or mouse over any individual entry to delete them one 
by one.

Microsoft’s old web browser Internet Explorer had a terrible reputation, suffering from multiple security holes and poor privacy 
protection, leading many people to replace it with either Google Chrome or Mozilla Firefox. Its reputation was so tarnished that with 
the launch of Windows 10 last year the company introduced an entirely new web browser with a new look and a new name, 
Microsoft Edge.

Edge has many advantages over its unlamented predecessor. It is a lot more secure – so far – and offers a much wider range of 
features and customisation options. Now you have much greater control over privacy and how much of a footprint you leave online 
while browsing. In this section we’ll take a look at some of the advanced options available in Microsoft Edge and how you can use 
them to improve your web browsing experience.

Bowing to popular opinion, Microsoft has finally retired the unpopular Internet Explorer and replaced it with 
a brand new web browser offering more custom options to control your privacy. Edge can seem simple to 
use but it actually offers some advanced tools and settings if you need them. 

Advanced Options 
in Microsoft Edge
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Microsoft Edge

Step 2 Step 4The main tools for Web Note are in the upper left 
corner. You have a pen to underline and circle things 

and marker to highlight them; there’s a button to attach notes to the 
page and another to snip a clipping from the page. The middle 
button deletes the pen or highlighter marks.

When you’ve finished annotating the page you can 
save it for later reference or share it. Click on the icons 

in the upper right corner to save or share. You can save an image of 
the page to OneNote, Favourites or Reading list and share using 
Dropbox, Facebook, OneNote, Mail or Twitter.

Edge lets you annotate websites, copy and paste text and images and save the results for later reference. Let’s take a look at how to 
take full advantage of the new Microsoft Web Notes tools.

Making Web Notes

Step 1 Step 3Open a web page in Edge that you wish to annotate. In 
the upper right corner of the screen you’ll see a row of 

buttons; click on the one that looks like a pen on a sheet of paper to 
enter the Web Note mode.

Note that Web Note doesn’t save clippings or indeed 
web pages as editable text but as an image that can 

be pasted into another document. If you want to copy and paste 
text you’ll have to do that the old fashioned way; highlight then Ctrl 
+ C and Ctrl + V.

PRIVATE BROWSING PIN WEB PAGES TO 
THE START MENUIf you don’t want Edge to record your web browsing history you can 

use the InPrivate option. Click on the menu icon, the three dots in 
the upper right corner, and select New InPrivate window. While 
using InPrivate, your browsing history, cookies and other temporary 
files are not saved on your PC and will be deleted as soon as you 
close the InPrivate window.

If there’s a particular website that you visit regularly you can pin it to 
the Start menu for quick access. While you’re on the page that you 
want to pin, open the menu, the three dots in the upper right corner, 
and select Pin to Start. Now you’ll have a tile in the Start menu and 
when you click it the Edge browser will open immediately to the 
saved page.
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Essential tips and tricks for keeping your PC running smoothly and for 
keeping Windows 10 working exactly the way you want it to. Learn 
how to improve overall performance, how to keep your drives free of 
clutter and how to troubleshoot common problems with the current 
version of Windows 10. 
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RECORD YOUR SCREEN
Traditionally with Windows, if you wanted to record videos of on 
screen apps or software, you would need to rely on a third-party 
solution. Windows 10 changes this by adding a recording feature to 
the Xbox One app, the Game Bar. Although this is designed to let you 
record your achievements and gameplay, you can also use it to 
other apps open on your computer. Accessing the Game bar is 
straightforward. Simply press and hold the Windows and G keys. 
The Game bar, which is essentially a toolbar, will then pop up on 
screen. You can then use it to record whichever app you wish. 

Enable Dark Mode
The new Edge browser allows users to choose a nice looking 
dark colour mode but it seemed as if that feature was only ever 
going to be available in Edge and no other apps or menus. 
Luckily a workaround has been found which will apply the dark 
mode to most (not all unfortunately) apps and menus in 
Windows 10. It involves editing the Registry, so be sure you are 
comfortable with that before you start. 

To open the Registry Editor, type “regedit” (without the 
quotation marks) in the Windows 10 search bar. Click 

on the cube icon to launch the Windows 10 Registry Editor. User 
Account Control might prompt you for permission, depending on 
your security settings. If so, click on “Yes.” 

You now need to find the correct directory. On the left 
you will see the directory structure. The directory path 

you are looking for is: HKEY_CURRENT_USER > SOFTWARE > 
Microsoft > Windows > CurrentVersion > Themes > 
Personalize. So click HKEY_CURRENT_USER first, then from the 
menu that opens, click SOFTWARE. Followed by Microsoft and on 
down the path. 

On the right, in an empty area, right-click and choose 
“New,” then “DWORD (32-bit) Value.” You should now 

see a new entry on the right pane called “New Value #1” highlighted 
in blue. Rename the highlighted field to “AppsUseLightTheme,” and 
you’ll now see a new entry in the right pane called 
“AppsUseLightTheme” with a default value set to 0. Now just log out 
and then log back in. 

Step 1

Step 2

Step 3

Even long time users of Windows will have plenty to learn when switching to Windows 10; from simple 
switches in the way you use your PC, to more fundamental things like the new Edge browser and 
Cortana. Here are a few advanced tips and tricks to further enhance your Windows 10 experience.

Windows 10 Expert 
Tips and Tricks
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Tips and Tricks

Not surprisingly in 
Windows 10, Bing 

is Edge’s default search engine. However, if you prefer to have a 
different search engine as the default, you can certainly change it. 
The surprisingly simple way to do this is to navigate to the homepage 
of your chosen search engine, Google, for example and, if it is 
supported, you will see an option to add it to Edge. 

As long as Cortana has been set 
up through the taskbar, you 

can use the personal assistant inside the Edge browser. Start using it 
by typing something you would typically ask Cortana into the search 
bar at the top of Edge. After your request is completely typed in, a 
Cortana window with your results will appear underneath it in blue.

Change the Default Search Engine Use Cortana Inside Edge

Cortana should, if set up correctly, 
seek out information it thinks you 

may need, before you actually ask for it. Therefore as soon as you click 
in the Cortana search field, even before you start to type your search, 
you should see a series of cards that display information relevant to 
the activity you are currently performing. 

Cortana works much better 
when it has some basic 

information about you. Adding common locations for example, 
allows Cortana to provide better directions and traffic information. 
To add addresses such as home, work and your other favourite 
places, head to the Notebook menu and click “About Me”. From here 
select “Edit favourites”.

At a Glance Information Save Locations for Cortana

ACTIVATE GODMODEDISABLE SCROLLABLE 
BACKGROUND APPS

Although this has been covered in more detail elsewhere in this book, 
activating GodMode is certainly still worthy of appearing in our list of 
expert tips here. For the first time, Microsoft has split the system 
settings in Windows 10, meaning options are now scattered across 
two separate menus, Control Panel and Settings. This can lead to a bit 
of confusion when it comes to finding the option you’re looking for 
but enabling the hidden “GodMode” menu will put all of Windows 10’s 
options back in one place. 

To try it out, just create a new folder anywhere, then give it the 
following name:
GodMode.{ED7BA470-8E54-465E-825C-99712043E01C}
From now on, just open this folder to find quick links to every single 
option Windows 10 has to offer.

A simple but useful feature that has been missing from Windows for 
some time now is the ability to scroll in background apps without 
bringing them to the front. This useful feature, especially whilst 
multitasking, has been available in OS X for a while and now it is 
available in Windows 10. The scrollable background apps feature 
works like this: if you have two windows open, you can hover the 
pointer over the background window and use your mouse wheel to 
scroll the page without having to bring it to the foreground. 

If you’d like to disable this option, head to the main Settings menu 
and choose “Devices.” From here select “Mouse & touchpad”, then the 
relevant option will be towards the bottom of the page. 
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Tips and Tricks

The Snipping tool, has been a longtime 
Windows feature, first appearing in 

Windows Vista. It was initially introduced as a built-in screen grab tool 
and up until Windows 10, it had changed little. The Windows 10 
snipping tool however, has seen the introduction of a very useful new 
feature (useful for some at least). In this latest version of the Snipping 
tool, users can set up timed screenshots. You can start a timer and 
take your screenshots with a 1 to 5 second delay, which can help you 
get the screen situated properly. Useful if you are trying to grab an 
image of something that isn’t static. 

You can now install Universal Windows 
apps from anywhere. Before, 

inWindows 8.x, the Store was the only way to get apps. Of course 
you could always install desktop apps as you pleased but for 
“Metro/Modern” apps, you were basically trapped into using the 
Windows Store. Now you can sideload apps from anywhere. Go to 
Settings -> Update & Security -> For developers, then toggle 
“Sideload apps” on. 

If you are using a 
computer that has a 

trackpad instead of a mouse, such as a laptop or a 2-in-1 device, 
you can use some useful trackpad gestures to navigate Windows 10 
more easily. There are several to try, including pinch-to-zoom, 
two-finger scroll, three-finger multitasking and more. More than 
that, you can even customise some of the gestures. Head to 
Settings > Devices > Mouse & Touchpad. You can then change the 
actions of three and four-finger taps, adjust scrolling and more. 

The search function of Windows 
10 is pretty good, and usually 

very reliable; but that doesn’t mean you can’t use a few tricks to 
improve it even more, especially if you want to search amongst 
specific file types. You just need to add a file specifier to the search 
term. For example, let’s assume you want to search for all HTML files 
on your computer. In Windows 10, you can simply type in files:html 
in the Start menu. This works for more than just files, including 
apps, settings, folders, etc. Just follow the syntax of “type:specifier.”

In case you haven’t used this one 
before, Windows 10 has some handy 

shake gestures that allow you to clear the clutter in no time. If you 
have a lot of windows open and you want to focus on one in 
particular, just grab the title bar of that window with your mouse 
pointer, then shake back and forth to minimise all other windows. If 
you want to bring the other windows back, just shake the first 
window again and all will be right back to normal.

Inside the Start menu, under the 
All apps section, you have a 

listing of all apps categorized under their alphabet letter. When you 
have a lot of apps, navigation can become a bit frustrating, so to 
help make this easier, you can simply click on any of the heading 
letters and you will be greeted with an animation that displays the 
alphabet for quick access. Click on whichever letter you want and 
the list will jump to those specific apps. 

Timed Screenshots Sideloading Apps

Customise Trackpad Gestures Specify Search Results

Use Shake Gestures Start Menu Navigation
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Tips and Tricks

Windows 10 is very much about customisation. You can customise almost everything, from the colour of Edge to the Start menu 
layout. The Command Prompt is no different. You can completely customise it, from the basic functions to its look. 

Customise the Command Prompt

The first thing you need to do is launch the Command 
Prompt. If you are unsure how to do this, here’s a 

quick reminder. Press the Windows button on your keyboard and 
when the Start menu opens, type “cmd” (without the quotation 
marks) and then press Enter. 

You now need to access the Command Prompt 
settings menu. To do that, simply click the logo in the 

upper left corner of the Command Prompt window, then choose 
“Properties” from the context menu. From here, you will be taken to 
the main Options tab. 

There isn’t much worth messing around with here. 
Most of the useful features such as copy and paste are 

already enabled but if you’d like to be able to highlight command 
text with your mouse pointer, you can tick the box next to 
“QuickEdit Mode” at the very least.

Next, head over to the Font tab if you’d like to change 
the way text appears in your command prompt. There 

are a few fonts to choose from and you can of course change their 
sizes but one of the more interesting features here is an option to 
make fonts bold.

Then, the Layout tab gives you options for adjusting 
the boundaries of the command prompt window 

itself. For instance, you can change the “Window Size” values to 
make the command prompt a bit bigger when it first launches, 
which should come in handy on today’s larger monitors. 

The Colours tab is where you can make the biggest 
visual changes to the Windows 10 Command Prompt. 

Choose one of the four options in the upper left quadrant of this 
menu, then select a colour from the options. You can even enter 
RGB values in the upper right corner. 

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
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Microsoft normally releases important updates on the second 
Tuesday of every month, although important updates will be 
released immediately. You should check for and install available 
Windows Updates, which could include: bug fixes, security patches, 
Windows Defender malware definitions etc. that could help keep 
your system stable and improve the performance of Windows.

You’ll find this in the Power Options section of the Control Panel; just 
click on “Show additional plans”. By default your PC is set to use the 
Balanced power option, which will reduce power to non-essential 
components when they’re not being used. By selecting the High 
Performance plan your PC will use more power but will be running at 
peak performance all the time. Note however that some laptops and 
tablets may run very hot under this power setting. If you notice this 
happening, immediately switch back to the Balanced power plan.

Most ISPs will boast 
about how much 

bandwidth they are giving you but the speed of your connection 
isn’t the only thing that makes for a fast web browsing experience. If 
your ISP doesn’t maintain its Domain Name Server (DNS) properly it 
will slow down your web searches and make connecting to 
websites slow and unreliable. In fact slow and poorly maintained 
DNS servers are one of the main causes of problems connecting to 
websites. You might consider adding or using a fast DNS server like 
Google Public DNS as your primary DNS server in your TCP/IP 
settings to see how it compares to your ISP.

If you don’t mind 
mucking about 

in the system registry, you can set and adjust the AutoEndTasks, 
HungAppTimeout, WaitToKillAppTimeout, and 
WaitToKillServiceTimeout values, which control how long Windows 
waits for hung programs to close and other programs to save data 
and close, before shutting down. Do note however that the registry is 
very complex and making changes can have a catastrophic effect on 
your PC. Only try this if you know what you’re doing. We will look at 
registry editing in more detail in a future issue of this book.

Make Sure You Install the Latest Windows Updates

Use the High Performance Power Plan

Switch to a Faster DNS Server

Speed Up Windows Shut Down Time

Performance Tweaks
There are many ways to improve the performance of your PC. Some will produce only slight improvements and some will only apply 
to single operations, but when combined they add up to a significant boost.

By now your Windows 10 computer should be running along like an express train at full tilt, and if not you 
should really go back and read through our performance enhancing guides again, but here are some 
more handy tips to boost the performance of your system even further.

Further Tips to  
Improve Performance
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Performance

Although this is really not recommended for any PC to which others 
may have access, if you’re definitely the only person that will use 
your PC you might want to set it so that you don’t have to sign in 
whenever your computer wakes from sleep mode. You can do this 
in the Accounts > Sign-in options section of the Settings page. Note 
however that this will allow anyone who gets access to your PC to 
access your personal account. Do so at your own risk.

You can speed 
up the 

performance of your storage devices by enabling write caching, 
which temporarily stores data in high speed RAM. It’s enabled by 
default for internal drives but you can also turn it on for removable 
drives. Right-click on the Start button and open Device Manager. 
Expand the Disk drives list and double-click on the drive that you 
want to enable. Click on the Policies tab and you’ll see “Enable write 
caching on the device” as a check box option. Check that it’s 
enabled for all your drives.

If you’ve got apps or 
games installed on 

your system that you just don’t use anymore, it’s a good idea to 
uninstall them. This is particularly true of off the shelf PCs that will 
often come pre-installed with a lot of useless software. Fortunately 
Windows 10 makes this easy, since you can uninstall apps from the 
Start menu by right-clicking on them and choosing Uninstall from 
the pop-up menu.

Windows 10 
includes an 

option to start up faster by storing an image of the Windows kernel 
to your hard drive when it shuts down. This saves a lot of time by 
bypassing a lot of initialisation and driver loading. Open the Control 
Panel and select Power Options. In the left sidebar of the window 
click on “Choose what power buttons do” and then click on the link 
at the top of the page: “Change settings that are currently 
unavailable”. The greyed out settings at the bottom of the page will 
become active, including “Turn on fast start-up”.

 While having your HDDs turn off after a set amount of idle minutes 
will help save energy, it can also cause your PC to slow down 
significantly while it waits for the HDD to spin back up when it’s 
needed again. If you go to the Power Options section of the Control 
Panel you can adjust the idle time to never, or just increase the 
amount of minutes. Alternatively you could install an SSD, which is 
always at full readiness.

Over time ordinary household dust 
can build up inside your machine 

forming an insulating layer over vital cooling components and 
reducing their efficiency, which can have an impact on the 
performance of your system. Once every few months it’s a good 
idea to open up the case and give it a good clean. Obviously 
disconnect it from the mains first, and be careful not to damage 
anything. Use a soft brush to dust the motherboard, and a 
compressed air can to blow dust off the cooling fins.

Automatically Sign in to Your User Account at Startup Enable Write Caching for Your Drives

Uninstall Unneeded Programs Ensure that Fast Startup is Activated

Set “Turn Off Hard Disk After” to Never Keep Your PC Clean
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If you have a problem with your Windows 10 machine, your PC will need to go to the Advanced Startup 
Options menu, sometimes called the Boot Options menu. You may also need to boot into what’s called 
Safe Mode. Hopefully this isn’t something you will need regularly but we’ll run you through it anyway.

Troubleshooting 
Windows 10

How to Use Advanced Startup Options
Modern computers are complicated things and there’s a lot that can go wrong. If your PC really isn’t working correctly or seems slow, 
these helpful options will help you get it back on track.

Step 1

Step 2

Step 3

Step 4 If you selected Troubleshoot, you get the option to 
Reset this PC. This is a little confusing in name, 

because it doesn’t mean restart! It means resetting Windows to its 
factory settings (it reinstalls Windows, effectively). You can choose 
whether or not to keep your files, but we think this is a risky option. 
You have got your files backed up, haven’t you?

You’ll then see this menu, which is a little transitional 
for our liking – we’re not sure why these options aren’t 

on the screen you get after this in Step 4 (by clicking Troubleshoot). 
From here, you can also continue to boot up Windows 10 or you 
can decide to turn off your PC if you are going to take it to a repair 
shop, for example.

If your PC didn’t start correctly, you’ll see this screen. It 
gives you the option of restarting and trying again, or 

clicking on Advanced Options. We’re going to run you through what 
happens if you click on this second button – various options are 
available to you.

You may be taken to the Advanced Startup Options 
menu. It will appear automatically if you have two 

consecutive startup errors on your PC. But you can get to it 
manually from inside Windows 10 by going to the Settings app > 
Update & Security, clicking on Recovery and selecting Restart Now 
underneath Advanced Startup.
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Troubleshooting

Step 6

Step 5

Step 7

Step 9

Step 8

Step 10 This is what Safe Mode looks like. As you can see, it’s 
very much like the standard version of Windows 10, 

but it is lacking a little in its graphical finish. It’s designed for you to 
troubleshoot what is wrong with your system – perhaps you need to 
roll back to an earlier System Restore point, for example.

When your PC boots after going to Startup Settings in 
Step 6, you’ll see this menu. You need to press a 

number to boot your PC in a particular way. We’d always 
recommend seeing if your PC will boot into Safe Mode with 
Networking. If it starts up there without issue, it’s probably a 
third-party software or driver problem rather than something with 
Windows itself.

If you need to boot from a particular drive, such as 
USB, you can do so by starting from it using the boot 

options in the Advanced Options menu. You can also access the 
command prompt should you need to do any diagnostic checks of 
your files, though this isn’t a common thing to have to do.

If you have a system image handy (a complete backup 
of your PC in a system image file) you can also restore 

it at this point. Anything you’ve created since the system image was 
made will be lost, so again it’s a reason why you should back up 
your files. 

If you select Startup Settings, you’ll be shown this 
screen to ensure it is actually what you want (you can 

always go back using the Back button of course). From this you can 
instigate Safe Mode with or without networking access, as well as a 
low resolution video mode if you’re having display problems.

Advanced Options is actually the menu that we want, 
and you probably will do, too, if there’s something 

seriously wrong with your PC. It’s almost like the previous steps 
were tests to see if you really did want to get here. You can try and 
repair the startup, or roll back using System Restore.
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Windows 10 includes some useful tools for checking on and solving problems but sometimes you need to 
look a bit further and deeper. Occasionally you just need to go back to basics. These tips will help you solve 
some common problems encountered in Windows 10, particularly after installing the Anniversary update.

Windows 10 
Troubleshooting Tips

First Things to Check
If you’re having problems with Windows Update, the Windows Update Troubleshooter might be able to automatically fix the 
problem. Go to Microsoft.com and search for Update Troubleshooter. 

Windows Update Troubleshooter

Check for Updates 

Checking System Spec

App Updates If an app or program isn’t working with 
Windows 10, particularly after the Anniversary 

update, try looking in the Windows Store for an update and if that 
doesn’t work, delete and reinstall it. To check for available app 
updates on the store, click the user icon next to the search bar and 
select Downloads and Updates. 

If you’re having trouble installing 
or running a particular app or 

game, it may be that your PC hardware is not up to scratch. All 
commercial software will provide details of required and 
(sometimes) recommended specification needed to run it. You can 
check system spec at any time, just go to Control Panel and select 
System and Security, then System. 

Keeping your copy of Windows 10 up 
to date with the latest releases can 

really help to avoid problems before they happen. Press the 
Windows logo key and click Settings. Then choose Update & 
security > Windows Update  and then select Check for updates. 
Install any available updates and restart your PC if required.

Microsoft knows 
that things don’t 

always go smoothly when updating and have provided a dedicated 
troubleshooting tool for use during this key task. If you’re having 
problems with Windows Update, the Windows Update 
Troubleshooter might be able to automatically fix the problem. Go 
to Microsoft.com and search for Update Troubleshooter. 
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Troubleshooting

First make sure you have the following: an internet 
connection to download the tool and the Windows 10 

image and sufficient available data storage on the computer you 
are installing on. You need at least 3GB free for the download and 
the clean Windows 10 image file.

Like Windows 8 before it, Windows 10 uses a 
hybrid boot to enable fast boot times. It 

sounds great but can actually slow down boot for some users. 
Disable it by searching for Power Options in the Start menu and 
running the matching Control Panel applet, then in the left-hand 
pane click Choose what the power buttons do. 

Download the tool https://www.microsoft.com/en-gb/
software-download/windows10startfresh. There is 

some advice on the download page about retrieving and 
reinstalling Microsoft software such as Office. It is worth checking 
this out if you are heavily reliant on that software. 

BACK UP EVERYTHING you want to keep! Launch the 
tool and review and accept the licence terms. Choose 

what you want to keep. If you want to keep your personal files, 
choose the Keep personal files only option. Select the OK button to 
start the installation.

Windows 10 has a completely 
different shell than previous versions. 

The Explorer.exe process is still at its core but there are a few 
additional components as well. If you click the Start button and 
nothing happens or if the entire taskbar refuses to respond to an 
interaction, open Task Manager (press Ctrl+Shift+Escape), find 
Windows Explorer in the task list and click the Restart button. 

By using the tool, you may lose your digital licences, 
digital content associated with applications or other 

digital entitlements. Drivers may also be missing. If you experience 
any missing drivers after the clean installation has finished, go to 
Settings > Update & security >Windows Update. 

Step 1

Slow Boot Fix

Step 2

Step 3

Non-responsive PC

Step 4

If Windows 10 is really giving you problems and you have tried everything else to fix the issue, you can try using the Fresh Install tool. 
You will lose any installed apps but will keep your files. 

Fresh Installation Tool



Do More with Windows 10  
Windows has never been more powerful, 
more useful or more usable. So why not take 
advantage of all it can offer? Learn how to 
improve security and boost performance, 
discover how to completely customise the 
desktop and menus, and get more from the 
best Microsoft OS released for several years. 

Windows 10 Advanced Guides
Learn how to master the tools that make 
Windows 10 powerful. From removing 
bloatware and enabling the God Mode folder, 
to learning how to troubleshoot a problem 
and run Ubuntu on a Windows PC, there is 
something here for every user, whether you 
are just getting started or have been using 
the operating system for months. 

Essential Tips and Tricks
Just about every page of the The Advanced 
Guide to Windows 10 contains useful tips and 
helpful hints. From ways to stay safe on the 
Internet and how to use hotkey, to sharing a 
photo with friends and customising your Start 
menu. So if you have never used Windows for 
anything more than browsing online, there is 
lots to discover. 

Hardware Customisation
Learn the best way to add more power to 
your PC with a RAM upgrade, discover how to 
add a Solid State Drive to your machine and 
see the best way to keep the OS up to date 
without causing problems. The Advanced 
Guide to Windows 10 is about much more 
than making sure you are software savvy. 

The Advanced Guide to Windows 10 is 
all about giving you the tools to take full 
advantage of everything Windows has to 
offer! From maintaining and optimising your 
key hardware, to delving under the hood of 
the operating system with tweaks and mods. 
There is something here for anyone who wants 
to go beyond being able to send an email and 

browse the Internet. 

Filled to bursting with expert advice and 
invaluable time saving shortcuts, the Advanced 
Guide to Windows 10 is the guide for helping 
you get more from the OS. Whether you have 
been using Windows 10 since its release or you 
have just bought your first PC, every page is full 
of useful advice, essential tips and all you need 
to take your computing knowledge to the 

next level.

This Manual can be used with Windows 10:
Home Pro

Enterprise Education

Mobile Mobile Enterprise

IoT Core
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